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Vorwort 

Das Manuskript entstand als Begleitlektüre zum Amos-Einführungskurs am Rechenzentrum der Universi-

tät Trier, was bei gelegentlichen Hinweisen zur Arbeitsumgebung auf den vom Rechenzentrum betreuten 

Pool-PCs deutlich wird. 

Es können nur elementare Aspekte der Strukturgleichungsmethodologie angesprochen werden. Eine aus-

führliche Behandlung finden Sie z.B. in Bollen (1989), Kline (2005), Loehlin (2004) oder Schumacker & 

Lomax (2004). Im Internet sind weitere (meist kürzer gehaltene) Darstellungen der Strukturgleichungs-

technologie zu finden, z.B. die ZIMK-Dokumentation zum Strukturgleichungsanalyseprogramm LISREL 

7 (Baltes-Götz 1994). 

Das Manuskript orientiert sich teilweise am sehr empfehlenswerten Handbuch zu Amos 18 (Arbuckle 

2009a), das mit dem Programm ausgeliefert wird. 

Von den zahlreichen Themen, die in diesem Manuskript überhaupt nicht oder zu knapp behandelt werden, 

sind besonders zu erwähnen: 

 FIML-Schätzung (Full Information Maximum Likelihood) bei fehlenden Werten (siehe z.B. Bal-
tes-Götz 2008a) 

 Modellierung von Mittelwerten 

 Modelle mit Interaktionen (siehe z.B. Baltes-Götz 2008b) 

 Analyse latenter Klassen 

 Behandlung zensierter und ordinaler Indikatoren über Bayes-Schätzverfahren 

Die aktuelle Version des Manuskripts ist als PDF-Dokument zusammen mit allen im Kurs benutzen Da-

teien auf dem Webserver der Universität Trier von der Startseite (http://www.uni-trier.de/) ausgehend fol-

gendermaßen zu finden: 

Rechenzentrum > Studierende > EDV-Dokumentationen > 

Statistik > Analyse von Strukturgleichungsmodellen mit Amos 

 

Leider sind in diesem Manuskript einige Teile mit heißer Nadel gestrickt, so dass Unzulänglichkeiten zu 

befürchten und entsprechende Hinweise der Leser(innen) zu erhoffen sind (z.B. an die Mail-Adresse bal-

tes@uni-trier.de). 

 

 

 

 

 

 

 

 

 

Trier, im Oktober 2010 Bernhard Baltes-Götz 

 

http://www.uni-trier.de/
http://www.uni-trier.de/index.php?id=22640
http://www.uni-trier.de/index.php?id=22640
mailto:baltes@uni-trier.de
mailto:baltes@uni-trier.de
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1 Einleitung 

1.1 Strukturgleichungsmodelle mit latenten Variablen 

Amos (Analysis of MOment Structures) ist ein modernes Werkzeug zur Analyse von Strukturglei-

chungsmodellen mit latenten Variablen. Diesen sehr flexiblen Analyseansatz, häufig auch als Kovarianz-

strukturanalyse bezeichnet, kann man in erster Näherung als Kombination von Regressions- und Fakto-

renanalyse begreifen. Viele bekannte statistische Auswertungsverfahren können als Spezialfall der Struk-

turgleichungsanalyse aufgefasst werden (z.B. Regressions-, Varianz-, und Kovarianzanalyse). Darüber 

hinaus stellt die Möglichkeit zur Formulierung von Struktur- bzw. Regressionsgleichungen auf der Ebene 

latenter Variablen eine sehr attraktive Modellierungsoption dar, die ursprünglich vor allem von Karl Jö-

reskog entwickelt wurde (siehe z.B. Jöreskog & Sörbom 1989). 

Das folgende Beispiel mit einer reziproken Abhängigkeitsbeziehung auf der Ebene latenter Variablen 

demonstriert, welche Flexibilität Amos bei der Formulierung von Strukturgleichungsmodellen bietet: 

 

Im Vergleich zur linearen Regressionsanalyse (z.B. mit der SPSS-Prozedur REGRESSION realisierbar) 

bietet Amos vor allem die folgenden methodologischen Vorteile: 

 Keine Beschränkung auf rekursive Modelle 

Ein aus mehreren Gleichungen bestehendes Modell heißt rekursiv, eine die folgenden Bedingun-

gen erfüllt sind: 

o Die endogenen Variablen können so nummeriert werden, dass endogene Variablen keine 

kausalen Effekte auf andere endogene Variablen mit niedrigeren Nummern ausüben. 

Ist diese Bedingung verletzt, treten kausale Sequenzen auftreten, welche direkt (z.B.: Y1 be-

einflusst Y2 und Y2 beeinflusst Y1, siehe obiges Pfaddiagram) oder indirekt (z.B. Y1 beein-

flusst Y2, Y2 beeinflusst Y3 und Y3 beeinflusst Y1) zum Ausgangsort zurückführen.
 1

 

                                                 
1
 Der Begriff rekursiv verursacht gelegentlich Missverständnisse, weil ein Zurücklaufen (lateinisch: recurrere) doch ausge-

rechnet bei den als nonrekursiv bezeichneten Modellen auftritt. Man denke jedoch daran, dass in der Logik und in der Ma-

thematik eine rekursive Definition vorschreibt, wie spätere Ausdrücke aus unmittelbar vorausgehenden bestimmt werden 

können. Ist jedoch in einem Strukturgleichungsmodell eine Variable Y2 nur unter Verwendung der Variablen Y1 zu ermitteln, 
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o Die exogenen Variablen sind unkorreliert mit den Residuen. 

o Die Residuen zu den Kriteriumsvariablen aus verschiedenen Gleichungen sind unkorre-

liert, sofern direkte Effekte zwischen den Kriteriumsvariablen bestehen. 

Ist eine Bedingung verletzt, spricht man von einem nonrekursiven Modell. In diesem Fall ist eine 

simultane Analyse der Gleichungen erforderlich. Traditionelle Regressionsprozeduren mit einer 

separaten OLS-Schätzung (Ordinary Least Squares) für jede einzelne Gleichung liefern verzerrte 

Parameterschätzungen. 

 Latente Variablen 

Sind für theoretische Konzepte nur fehlerbehaftete Indikatoren vorhanden, erhält man geminderte 

bzw. verzerrte Effektschätzungen, wenn bei einer Analyse jedes Konstrukt durch einen einzelnen 

Indikator operationalisiert wird. Oft sind jedoch pro Konstrukt mehrere Indikatoren verfügbar. 

Amos kann diese nutzen, um die Konstrukte in der Beobachtungsbasis zu verankern und in das 

Gleichungssystem einzubeziehen. So lassen sich auf der Ebene latenter Variablen Effekte ohne 

messfehlerbedingte Verzerrungen schätzen. 

 

1.2 Analyseoptionen in Amos 18 

Die in diesem Kurs behandelte Amos-Version 18 bietet ein umfangreiches Spektrum von Analysetechni-

ken, z.B. die Schätzmethoden 

 Maximum Likelihood (ML), auch bei fehlenden Daten (FIML) 

 generalisierte (GLS), ungewichtete (ULS) und skalenfreie (SLS) kleinste Quadrate 

 asymptotisch verteilungsfreie Schätzer (ADF) 

 Bootstrapping 

 Bayes-Schätzung mit dem MCMC-Verfahren (Markoff Chain Monte Carlo) 

Über die simultane Analyse von Daten aus mehreren Populationen lassen sich z.B. Interaktionseffekte mit 

kategorialen Moderatoren untersuchen. 

Amos bietet etliche Hilfsmittel zur Modellsuche, so dass die traditionell eher für konfirmatorische For-

schungsbemühungen konzipierte Strukturgleichungsmethodologie auch in explorativer Manier zu nutzen 

ist (z.B. für eine explorative Faktorenanalyse). 

Bei aller Methodenvielfalt bemüht sich Amos um Bedienungsfreundlichkeit, wozu nicht zuletzt die Mo-

dellspezifikation durch den Aufbau eines Pfaddiagramms beiträgt. Dank exzellenter Gestaltungsmöglich-

keiten taugen Amos-Pfaddiagramme nicht nur zur Modellspezifikation, sondern machen auch in Publika-

tionen eine gute Figur. 

Amos wird zwar von der Firma SPSS vertrieben, ist aber ein eigenständig (Windows-) Programm, das 

selbstverständlich SPSS-Datendateien (Extension: .sav) problemlos verarbeiten kann. 

Das Programm bietet neben seiner grafikorientierten Benutzeroberfläche auch eine perfekte Unterstützung 

der .NET - Plattform, so dass Arbeitsabläufe mit .NET - Programmiersprachen wie VB.NET oder C# au-

tomatisiert werden können. 

 

 

                                                                                                                                                                            
andererseits aber Y1 nur bei Bekanntheit von Y2 bestimmbar, dann ist offenbar ein systematischer Aufbau im Sinne der rekur-

siven Definition nicht möglich. Ein solches System wird daher zu Recht als nonrekursiv bezeichnet. 
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2 Aller Anfang ist leicht 

Auf den vom Rechenzentrum betreuten Pool-PCs startet man mit 

Start > Alle Programme > Wissenschaftliche Programme > 

SPSS > Amos > Amos 18 Graphics 

die grafikorientierte Amos-Oberfläche. Diese bietet u.a. eine Zeichenfläche zur Aufnahme des Pfaddia-

gramms und (am linken Rand) drei nebeneinander gepackte streifenförmige Werkzeugpaletten: 

 

Mit dem hier abgebildeten, recht komplexen, Modell werden wir uns erst später beschäftigen, wenn die 

technischen Aspekte der Amos-Bedienung geklärt sind. 

Bei den ersten Übungsbeispielen kommen Daten aus einer Studie von Attig (1983) zum Einsatz.
1
 Hier 

wurden vor und nach einem Gedächtnistraining bei 40 jungen Probanden drei Leistungsmaße erhoben: 

 Erinnerungsleistung (recall1 bzw. recall2) 

 Erinnerungsleistung nach unterstützenden Hinweisen (cued1 bzw. cued2) 

 Erinnerung der richtigen Präsentationsreihenfolge (place1 bzw. place2) 

Außerdem wurden noch weitere Merkmale erfasst: Leistung in einem Vokabeltest, Alter, Geschlecht, 

Ausbildungsniveau. Zunächst sollen die Varianzen und Kovarianzen der Variablen recall1, recall2, 

place1 und place2 geschätzt werden. 

 

                                                 
1
 Wo die mit Amos ausgelieferten Beispieldaten zu finden sind, ist gleich zu erfahren. In Abschnitt 8 kommen bei einem 

Gruppenvergleich auch noch analoge Daten einer älteren Stichprobe ins Spiel. 
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2.1 Pfaddiagramm zeichnen 

Wir wollen das folgende Pfaddiagramm zeichnen: 

 

Erstellen Sie zunächst vier Rechtecke für die zu untersuchenden manifesten Variablen auf der Amos-

Zeichenfläche. Das erforderliche Werkzeug erhalten Sie mit 

  oder  Diagram > Draw Observed  oder  F3 

Am besten erzeugen Sie das erste Rechteck, korrigieren dann nötigenfalls dessen Position mit 

  oder  Edit > Move  oder  Strg+M 

und optimieren die Form (Seitenlängen) mit 

  oder  Edit > Shape of Object 

Nun können Sie nach 

  oder  Edit > Duplicate 

mit Klicken & Ziehen drei Kopien des Rechtecks anfertigen. Wenn Sie dabei die  -Taste gedrückt hal-

ten, wird (in Abhängigkeit von der anfänglichen Bewegungsrichtung) die horizontale oder die vertikale 

Koordinate beibehalten. So lassen sich z.B. leicht vier identische Rechtecke erzeugen, die exakt auf glei-

cher Höhe liegen. 

Kehren Sie in Denk- und Ruhephasen zur Vermeidung unerwünschter Mauseffekte mit 

  oder  Edit > Select  oder  F2 

zum neutralen Markierungswerkzeug zurück. Selbstverständlich können Sie Missgriffe mit 

  oder  Edit > Undo  oder  Strg+Z 

rückgängig machen (auch mehrstufig). 

Wir verknüpfen nun jedes Rechteck mit einer manifesten Variablen, indem wir deren Namen in der Ob-

ject Properties - Dialogbox eintragen, die via Kontextmenü-Eintrag geöffnet wird, z.B.: 
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Bei den Variablennamen in Amos sollte man sich an die SPSS-Namensregeln halten (max. 64 Zeichen, 

Buchstabe am Anfang, keine Leer- und Sonderzeichen, keine Schlüsselwörter der SPSS-Syntax). Momen-

tan vereinbaren wir Namen für beobachtete Variablen, die aus einer Datei importiert werden, so dass die 

dort vorhandenen Variablennamen zu verwenden sind. Wenn dabei ein unschöner Name akzeptiert wer-

den muss, kann dieser in Amos durch ein Variable label ergänzt werden, das im Pfaddiagramm an Stel-

le des Namens angezeigt wird. 

Markieren Sie bei geöffneter Object Properties - Dialogbox nacheinander die übrigen Rechtecke, um 

auch diese mit Variablennamen (und bei Bedarf auch mit Variable labels) zu versorgen. Beenden Sie 

schließlich die Object Properties - Dialogbox über deren Schließfeld  am rechten Rand der Titelzei-

le. 

Momentan beschreibt unser Pfaddiagramm unkorrelierte Variablen: 

 

Weil unser Modell aber Kovarianzen erlaubt, müssen wir diese als Doppelpfeile in das Pfaddiagramm 

eintragen. Das erforderliche Werkzeug erhalten Sie mit 

  oder  Diagram > Draw Covariance  oder  F6 

Tipps: 

 Um einen unteren Bogen zu erhalten, müssen Sie von rechts nach links zeichnen. 

 Mit dem -Werkzeug können Sie die Biegung der Pfeile beeinflussen. 

 Mit dem -Werkzeug können Sie die Pfeilspitzen verschieben. 

 Wenn Sie mit dem Zauberstab  auf das Rechteck einer Variablen klicken, werden alle Ver-

bindungspunkte normiert, was in der Regel zu einem attraktiven Ergebnis führt. 

Nun sollte Ihr Pfaddiagramm ungefähr die eingangs abgebildete Gestalt haben. 
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2.2 Allgemeine Bedienungsmerkmale 

2.2.1 Format der Zeichenfläche ändern und Pfaddiagramm neu einpassen 

Amos startet mit dem Seitenformat Letter in der Orientierung Portrait und einem allseitigen Rand von 1 

Zoll (2,54 cm). Nach dem Menübefehl 

View > Interface Properties 

sind auf dem Registerblatt Page Layout der Dialogbox Interface Properties 

 

alternative Einstellungen möglich: 

 Frei wählbare Randbreiten 

 Landscape-Orientierung statt Portrait 

 Alternative bzw. individuelle Seitengröße 

Man kann ein Standardformat wählen oder ein individuelles Format festlegen. Bei Height und 

Width akzeptiert Amos Werte von 0 bis 14 Zoll bzw. von 0 bis 35,56 cm. 

Vorgenommene Änderungen werden mit Apply übernommen oder mit Cancel verworfen. Zum Beenden 

der Dialogbox dient das Schließkreuz  in der Titelzeile. 

Nach einer Änderung des Seitenformats, der Seitenorientierung oder der Ränder kann man das Pfaddia-

gramm mit 

  oder  Edit >Fit to Page  oder  Strg+F 

neu einpassen lassen. 
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2.2.2 Objekte markieren 

Sie haben folgende Möglichkeiten, Objekte auf der Zeichenfläche für die weitere Bearbeitung zu markie-

ren: 

 Einzelne Objekte kumulierend markieren 

Schalten Sie mit 

  oder  Edit > Select  oder  F2 

den Markierungsmodus ein, und klicken Sie nacheinander auf die gewünschten Objekte. Eine vor-

handene Markierung wird durch einen erneuten Mausklick aufgehoben. 

 Alle Objekte markieren 

  oder  Edit > Select All 

 Alle Markierungen aufheben 

  oder  Edit > Deselect All 

Sind in unserem Beispiel alle vier Rechtecke markiert, kann man mit dem Menübefehl 

Edit > Space Horizontally 

für horizontal gleiche Abstände sorgen und bei Bedarf anschließend mit dem Zauberstab   die An-

satzpunkte der Kovarianz-Doppelpfeile wieder optimieren. 

 

2.2.3 Objekte löschen 

Mit 

 oder  Edit > Erase  oder  Entf 

wird der Mauszeiger zum Stornierungswerkzeug, das jedes angeklickte Objekt entfernt. 

 

2.2.4 Objekte gestalten 

Speziell für Rechtecke und Ellipsen bietet Amos einige Gestaltungsmöglichkeiten über die Registerkarte 

Colors der Dialogbox Object Properties: 

 

Hier lässt sich z.B. der voreingestellte Farbverlauf für den Hintergrund (siehe obige Beispiele) ändern 

oder abschalten: 
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 Mausklick auf die Zelle Fill color 

 Im folgenden Dialog die beiden Farben (identisch) festlegen: 

 

Über den Schalter Set Default in der Dialogbox Object Properties lässt sich die Voreinstellung für 

zukünftige Objekte im selben Projekt festlegen: 

 

Eine Festlegung mit Gültigkeit für alle neuen Projekte (Normal Template) setzt Schreibrechte für die 

allgemeine Vorlagendatei voraus, bei einer typischen Amos-Installation also für 

C:\Program Files (x86)\SPSSInc\Amos18\Templates\English\Normal.amt 

 

2.2.5 Bearbeitungsschritte rückgängig machen oder wiederherstellen 

Mit 

  oder  Edit > Undo  oder  Strg+Z 

können Sie bis zu vier Bearbeitungsschritte rückgängig machen. Mit 

  oder  Edit > Redo  oder  Strg+Y 

können Sie die zuletzt zurückgenommenen Bearbeitungsschritte wiederherstellen. 
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2.2.6 Speichern, Sicherheitskopien 

Beim Speichern eines Projekts mit 

File > Save (As)  oder  Strg+S 

wird eine Projektdatei mit der Extension .amw angelegt bzw. aktualisiert, z.B.: 

 

Während der Arbeit an einem Projekt entstehen noch weitere Dateien, die bei Gelegenheit vorgestellt 

werden. Alle Dateien zu einem Pfaddiagramm bzw. Modell haben denselben Namensstamm, in unserem 

Beispiel also CovEst. Diese Bezeichnung eignet sich auch für den Ordner, den man der Übersichtlichkeit 

halber für jedes Projekt anlegen sollte. 

Wenn Sie später den Amos-Grafikmodus erneut starten, wird die zuletzt bearbeitete Projektdatei automa-

tisch geöffnet. Natürlich kann man ein vorhandenes Projekt mit File > Open auch explizit öffnen. 

Amos pflegt Sicherheitskopien mit älteren Versionen der Projektdatei, wobei deren Anzahl (Voreinstel-

lung = 2) über den Menübefehl 

View > Interface Properties > Misc 

eingestellt werden kann, z.B.: 
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In unserem Beispiel heißen die Sicherheitskopien CovEst.bk1, CovEst.bk2, usw. 

 

2.2.7 Pfaddiagramm in andere Anwendungen übertragen 

Sie können ein Amos-Pfaddiagramm ganz einfach über die Windows-Zwischenablage in andere Anwen-

dungen übertragen, z.B. in Microsoft Word  

in Amos: Edit > Copy (to clipboard)  oder  Strg+C 

in Word:  Bearbeiten > Einfügen  oder  Strg+V 

Auf diese Weise sind die obigen Pfaddiagramme in das vorliegende Manuskript gelangt. 

Da Amos stets ein komplettes und oft nur mäßig gefülltes „Blatt“ überträgt, müssen Sie im Zielprogramm 

die eingefügte Grafik eventuell beschneiden, in Word 2003 z.B. mit Hilfe der Dialogbox Grafik forma-

tieren (zu öffnen über den Menübefehl Format > Grafik oder per Kontextmenü zur Grafik): 

 

 

2.3 Daten einlesen 

Um unser Modell schätzen zu können, benötigt Amos noch Daten. Es werden zahlreiche Dateiformate 

unterstützt: 

 dBase 

 Microsoft Excel 

 Microsoft Foxpro 

 Lotus 

 Microsoft Access 

 SPSS 

 Textdateien 

Wir wollen die zum ersten Beispiel gehörigen Daten aus der SPSS-Datei Attg_yng.sav laden, die sich im 

Examples-Unterverzeichnis zum Amos – Programmordner befindet. Nach 

  oder  File > Data Files  oder  Strg+D 

erscheint die Dialogbox Data Files: 
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Deren Schalter File Name öffnet schließlich den Standarddialog zur Dateiauswahl (hier unter Windows 

XP): 

 

Nach erfolgreicher Dateizuordnung erlaubt die Data Files - Dialogbox mit dem Schalter View Data 

eine Blick auf die Daten, wobei in unserem Fall die Anzeige von SPSS selbst übernommen wird (, falls 

das Programm auf dem aktuellen Rechner installiert ist). 

Wir schließen die Data Files – Dialogbox mit OK und besorgen uns dann mit 

  oder  View > Variables in Dataset  oder  Strg+ +D 

eine Liste mit den Variablen der geöffneten Datendatei: 
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Jetzt ist es möglich, im Pfaddiagramm ein Rechteck zu benennen, indem man aus der Liste einen Variab-

lennamen per Maus packt und auf dieses Rechteck zieht. Wir hätten also durch frühzeitiges Zuordnen der 

Datendatei lästige Tipparbeit vermeiden können (siehe Abschnitt 2.1). 

 

2.4 Modellparameter schätzen 

Lassen Sie mit 

  oder  Analyze > Calculate Estimates  oder  Strg+F9 

die Modellparameter schätzen. 

Falls bislang noch keine Projektdatei (mit der Namenserweiterung .amw) angelegt worden ist (siehe Ab-

schnitt 2.2.6), fordert Amos nun dazu auf. 

Während Amos (in unserem Beispiel nur sehr kurz) mit der Parameterschätzung beschäftigt ist, werden 

wir über den Bearbeitungsfortschritt informiert. 

 

 

2.4.1 Textergebnisse 

Amos erzeugt eine Ergebnisdatei mit der Namenserweiterung AmosOutput, die nach 

  oder  View > Text Output  oder  F10 

von einem Hilfsprogramm angezeigt wird: 
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Sie besteht aus mehreren Tabellen, die bequem per Navigationszone zu erreichen sind. Zu vielen Tabel-

lenbestandteilen können per Mausklick ausführliche Erläuterungen abgerufen werden (siehe Beispiel). 

Eine per Mausklick markierte und daraufhin mit einem dünnen Extrarahmen versehene Tabelle 

 

kann über den Symbolschalter  oder die Tastenkombination Strg+C in die Windows-Zwischenablage 

befördert und anschließend von dort in eine andere Anwendung übernommen werden, z.B.: 

   Estimate S.E. C.R. P Label 

recall1 <--> recall2 2,556 1,160 2,203 ,028  

recall2 <--> place1 2,014 2,635 ,764 ,445  

place1 <--> place2 17,905 5,225 3,427 ***  

recall2 <--> place2 ,427 2,126 ,201 ,841  

recall1 <--> place1 4,337 2,338 1,855 ,064  

recall1 <--> place2 3,575 1,902 1,880 ,060  

In der Zielanwendung Microsoft Word lässt sich die Tabelle beliebig formatieren bzw. modifizieren. 

Das Anzeigeprogramm für Textausgaben bietet noch weitere Bedienungsmöglichkeiten: 

  Anzahl der Dezimalstellen wählen 

  Breite der Spalten einstellen 

  Gitterlinien aus- bzw. einschalten 

  Rahmen aus- bzw. einschalten 

  Hintergrundfarbe für die Tabelle wählen 

  Hintergrundfarbe für die Kopfzeile der Tabelle wählen 
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Man kann das Anzeigeprogramm auch per Amos-Programmgruppe (Verknüpfung Text Output) oder 

per Doppelklick auf eine AmosOutput-Datei starten. 

 

2.4.2 Erste Ergebnisinterpretationen 

Im Abschnitt Notes for Model > Result der Ergebnisdatei wird mit dem Eintrag 

Minimum was achieved 

signalisiert, dass die iterative Parameterschätzung gelungen ist. 

Dem Abschnitt Estimates ist u.a. zu entnehmen, dass Amos per Voreinstellung bei der Schätzung nach 

dem Maximum Likelihood (ML) - Prinzip arbeitet. Wie oben erwähnt, unterstützt Amos auch einige 

alternative Schätzmethoden (wählbar über View > Analysis Properties > Estimation), doch erweist 

sich die voreingestellte ML-Methode als recht leistungsfähig, auch bei einer mäßigen Verletzung ihrer 

Voraussetzungen, mit denen wir uns in Abschnitt 2.7.2 beschäftigen werden. 

In der Tabelle mit den Kovarianz-Schätzergebnissen (siehe oben) wird zu jedem Schätzwert in der Spalte 

S.E. sein approximativer Standardfehler angegeben, der unter gewissen Voraussetzungen (siehe Abschnitt 

2.7.2) die Konstruktion eines approximativen Vertrauensintervalls erlaubt. Für die Kovarianz von re-

call1 und recall2 erhalten wir z.B. unter Verwendung des 97,5%-Fraktils der Standardnormalverteilung 

( 1,96) das folgende approximative 95%-Vertrauensintervall: 

274,2556,216,196,1556,2   

Die mit C.R. (für Critical Ratio) überschriebene Spalte enthält für jeden Schätzwert den folgenden Quo-

tienten: 

hlerStandardfe

Schätzwert
 

Mit Hilfe dieses Quotienten lässt sich unter den in Abschnitt 2.7.2 beschriebenen Verteilungsvorausset-

zungen z.B. das folgende (zweiseitige) Testproblem lösen: 

H0: Cov(recall1, recall2) = 0   versus   H1: Cov(recall1, recall2)  0 

Bei Gültigkeit der H0 ist der angegebene Quotient eine approximativ, d.h. für N  , standardnormalver-

teilte Zufallsvariable, so dass man bei folgender Entscheidungsregel approximativ einen Test zum Niveau 

 = 0,05 erhält: 









 verwerfen H96,1

nbeibehalteH96,1

hlerStandardfe

Schätzwert

0

0
 

In unserem Beispiel wird also die Nullhypothese verworfen (C.R. = 2,203). 

Um die Testentscheidung durchzuführen, muss man nicht unbedingt den kritischen Wert für die CR-

Statistik kennen, da Amos unter dem Spaltentitel P auch die empirischen Überschreitungswahrscheinlich-

keiten für den zweiseitigen Test mitteilt. Die zugehörige Variante der Entscheidungsregel des Tests zum 

Niveau  = 0,05 lautet: 









 verwerfen H05,0

nbeibehalteH05,0

0

0
p  

Im Beispiel erhalten wir p = 0,028 und kommen zur selben Entscheidung wie beim Vergleich der CR-

Statistik mit dem kritischen Wert 1,96. 
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Amos bietet bei erhöhtem Aufwand ein alternatives Verfahren zum selben Testproblem (Parameterrestrik-

tion und Modellgültigkeitstest), das meist exaktere Ergebnisse liefert (siehe Abschnitt 2.10). 

Beide Amos-Testverfahren sind nur approximativ gültig, d.h. bei ausreichend großen Stichproben. Für das 

eben behandelte simple Problem existiert mit dem t-Test für Korrelationen eine bei beliebigen Stichpro-

benumfängen (jedenfalls ab N  3) gültige Alternative, die im Beispiel eine Überschreitungswahrschein-

lichkeit von p = 0,016 liefert und zur selben Entscheidung kommt wie der CR-Test. 

Beginnend mit Abschnitt 2.7 werden wir flexible Optionen zum Testen von Modellen und zusammenge-

setzten Hypothesen behandeln, zu denen keine exakte Alternative existiert. 

 

2.4.3 Das Ausgabe-Pfaddiagramm 

Amos kann seine Schätzergebnisse nicht nur in Tabellenform präsentieren, sondern auch in das Pfaddia-

gramm eintragen. Dazu ist nach erfolgreicher Modellschätzung der Schalter  einzurasten. 

Im Beispiel sieht das komplettierte Pfaddiagramm so aus: 

 

Wer im selbst erstellten Pfaddiagramm die Varianzschätzer ebenso zentriert sehen möchte wie die 

Exemplare in obiger Abbildung, muss nach 

  oder  Edit > Move Parameter 

das zuständige Werkzeug verwenden: 

 Bei hinreichender Nähe zum Mauszeiger wird eine Variable rot angezeigt. 

 Dann kann die Parameterposition durch Mausbewegungen bei gedrückter linker Maustaste verän-

dert werden. 

 Analog lassen sich auch die übrigen Parameter in einem Amos-Pfaddiagramm verschieben. 

 Sind mehrere Variablen (oder auch sonstige „Parameterträger“) markiert, gelingt die synchrone 

Veränderung der Parameterpositionen. 
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Bei Anzeige eines Ausgabe-Pfaddiagramms (mit Parameterschätzungen) sind einige Werkzeuge zur Mo-

difikation des Pfaddiagramms nicht verfügbar (z.B. ). Um diese Werkzeuge wieder nutzen zu kön-

nen, muss man erst den Schalter  für den Modellspezifikationsmodus einrasten. 

 

2.5 Optionale Ausgaben 

Nach 

  oder  View > Analysis Properties > Output 

können in der folgenden Dialogbox 

 

noch zahlreiche weitere Ergebnisse angefordert werden, z.B.: 

Standardized estimates  

War diese Option bei der Modellschätzung aktiv, zeigt das Ausgabe-Pfaddiagramm nach dem Markieren 

der zugehörigen Option: 

 

standardisierte Ergebnisse (z.B. Korrelationen statt Kovarianzen): 
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Sample moments 

Man erhält in der Textausgabe die Kovarianzmatrix und die Korrelationsmatrix der manifesten Variablen. 

Nach entsprechender Anforderung über das Kontrollkästchen Means and intercepts auf der Register-

karte Estimates der Dialogbox Analysis Properties liefert Amos auch die Mittelwerte der manifesten 

Variablen. Im Beispiel resultiert u.a. die folgende Tabelle mit den schon aus dem Pfaddiagramm bekann-

ten Kovarianzen: 

 place2 place1 recall2 recall1 

place2 22,160    

place1 17,905 33,578   

recall2 ,427 2,014 7,944  

recall1 3,575 4,338 2,556 5,788 

Implied moments 

Man erhält eine Matrix mit den vom Modell implizierten Momenten, im Standardfall also mit implizier-

ten Varianzen und Kovarianzen. Diese implizierten Varianzen und Kovarianzen unterscheiden sich von 

den beobachteten, sobald ein Modell Restriktionen enthält (siehe unten). In unserem trivialen Beispiel 

ohne Restriktionen gibt es allerdings (von Rundungsfehlern abgesehen) keine Unterschiede. Weitere Aus-

gabeoptionen werden bei Gelegenheit besprochen. 

 

2.6 Amos in .NET - Programmen verwenden 

Amos stellt sein gesamtes Leistungsspektrum über ein Objektmodell zur Verfügung, das in Programmier-

sprachen für das .NET - Framework (z.B. C#, VB.NET) genutzt werden kann. Es ist wohl im Wesentli-

chen an die beiden folgenden Einsatzzwecke gedacht: 

 Modellierung über Gleichungen an Stelle der graphischen Elemente (Rechtecke, Pfeile etc.) 

Dazu dient die Klasse AmosEngine, die wir gleich benutzen werden. Programme mit wesentlicher 

Beteiligung dieser Klasse werden wir später als AmosEngine-Programme bezeichnen. 

 Automatisierung von Routinearbeiten mit der graphikorientierten Benutzerschnittstelle 

Dazu dient z.B. die Klasse PathDiagrammer, die in vielen vorgefertigten Plugins verwendet 

wird. So steht z.B. in Amos Graphics über 

Plugins > Draw Covariances 
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eine Erweiterung bereit, die zu allen markierten exogenen Variablen die möglichen Kovarianzpfei-

le zeichnet und anschließend gleich das -Werkzeug für die meist erforderlichen Nachbesse-

rungen aktiviert. Wir werden uns in diesem Kurs nicht damit beschäftigen, Plugins zum Automati-

sieren von Amos Graphics zu entwickeln. 

Das Potential der Amos-Klassen ist im ca. 800 Seiten starken PDF-Dokument Amos 18 Programming 

Reference Guide beschrieben, das im Documentation-Unterordner einer Amos-Installation zu finden 

ist. Wer noch keine Erfahrung mit objektorientierter Programmierung hat, muss mit einigem Lernaufwand 

rechnen (siehe z.B. Baltes-Götz 2010) und sollte vielleicht besser bei der intuitiv bedienbaren Oberfläche 

von Amos Graphics bleiben. 

Amos 18 enthält eine kleine Programmentwicklungsumgebung, die über den Eintrag Program Editor in 

der Amos-Programmgruppe zu starten ist: 

 

Alternativ kann man auch ein Standardwerkzeug wie Microsofts Visual Studio verwenden. 

Wir wollen ein Programm in VB.NET (Visual Basic .NET) erstellen, das die Parameterschätzung in Cov-

Est – Projekt automatisch ausführt. Nach dem Start der Entwicklungsumgebung ist bereits ein Programm-

rumpf vorhanden (siehe oben). Wir ersetzen in der Methode Main() den Kommentar 

 'Your code goes here 

durch die folgende Dim-Anweisung, welche die Objektvariable Sem aus der Klasse AmosEngine dekla-

riert: 

Dim Sem As New AmosEngine 

Das Objekt Sem steht für ein Strukturgleichungsmodel und besitzt zahlreiche Methoden, um seine Eigen-

schaften zu spezifizieren oder seine Leistungen abzurufen. Aufgrund günstig gewählter Voreinstellungen 

sind für unser Beispiel nur die in folgender Tabelle erläuterten Methodenaufrufe erforderlich: 
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Sem.TextOutput() Ein erfolgreicher Programmlauf erzeugt die Ergebnisdatei 
AmosScratch.AmosOutput in einem Ordner für temporäre Datei-
en (z.B. C:\Dokumente und Einstellungen\baltes\Lokale Ein-
stellungen\Temp\AmosTemp). Durch Aufrufen seiner Methode 
TextOutput() teilen wir dem Objekt Sem mit, dass die Ausgabe 
automatisch vom zuständigen Hilfsprogramm geöffnet werden 
soll. 

Sem.BeginGroup("attg_yng.sav") Die Methode BeginGroup() leitet die Modellspezifikation für die 
erste (und hier auch einzige Gruppe) ein und nimmt den Namen 
der Eingabedatei entgegen. Dem Dateinamen müssen Sie eventuell 
noch eine Pfadangabe voranstellen. 

Sem.AStructure("recall1") 
Sem.AStructure("recall2") 
Sem.AStructure("place1") 
Sem.AStructure("place2") 

Mit der Methode AStructure() wird das Modell spezifiziert. Im 
Beispiel kann man sich auf die Deklaration der vier Variablen be-
schränken, weil die zugehörigen Kovarianzen auch ohne explizite 
Angabe in das Modell einbezogen werden. Einträge nach dem 
Muster 

Sem.AStructure("recall1 <--> recall1") 

sind also überflüssig. Hier besteht ein Unterschied zu Amos Gra-
phics, das bei einem fehlenden Doppelpfeil davon ausgeht, dass 
Sie die zugehörige Kovarianz auf Null fixieren wollen. 
Alternativ zur AmosEngine-Methode AStructure kann man auch 
die Methoden Var und Cov verwenden. 

Sem.FitModel() Mit der Methode FitModel() wird Amos aufgefordert, die Modell-
parameter zu schätzen und die Ausgaben zu erstellen. 

Aus programmiertechnischen Gründen sollten noch die beiden folgenden Bestandteile ergänzt werden: 

Sem.Dispose() Die Methode Dispose() gibt alle mit dem Sem-Objekt verbundenen 
Ressourcen frei, beseitigt es also restlos. Dies ist wichtig, weil im 
Rahmen der Amos-Entwicklungsumgebung nur ein AmosEngine-
Objekt existieren kann. Ohne die Aufräumaktion am Ende des Pro-
gramms wäre kein zweiter Aufruf innerhalb derselben Instanz der Ent-
wicklungsumgebung möglich. 

Try 
 . . . 
Finally 
 Sem.Dispose() 
End Try 

Diese Konstruktion sorgt dafür, dass die wichtige Methode Dispose() 
auch dann noch ausgeführt wird, wenn das Programm wegen eines 
Ausnahmefehlers bei einem Methodenaufruf zwischen Try und Final-
ly abgebrochen werden muss. 

Wenn das fertige Programm 
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mit der Schaltfläche 

Run 

gestartet wird, informiert Amos im folgenden Fenster über den Bearbeitungsfortschritt: 

 

Wir erhalten dieselben Ergebnisbestandteile wie mit Amos Graphics: 
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Beim Speichern eines VB.NET - Programms entsteht eine einfache Textdatei mit der voreingestellten 

Namenserweiterung .vb. 

Es ist übrigens nicht möglich, zu einer Modellspezifikation über einen simplen Methodenaufruf ein Pfad-

diagramm erstellen zu lassen. Zwar kann man die vielfältigen Gestaltungsmöglichkeiten von Amos Gra-

phics auch per Programm nutzen, doch erwartet die zuständige Klasse PathDiagrammer dazu präzise 

Einzelanweisungen. 

Wer kein neues AmosEngine-Programm erstellen, sondern das zu einem vorhandenen Pfaddiagramm 

äquivalente Programm von Amos produzieren lassen möchte, wählt den Menübefehl 

Tools > Write a Program 

Dabei entsteht z.B. zur Projektdatei CovEst.amw die Programmdatei CovEst_converted.vb. 

 

2.7 Modellgültigkeitstest 

Unter Verwendung der in Abschnitt 2 vorgestellten Daten zu zwei Gedächtnistests, die jeweils vor und 

nach einem Training erhoben wurden, wollen wir den 
2
-Modellgültigkeitstest kennen lernen. Wir ver-

wenden ihn zunächst anwendungsorientiert und verschieben die Behandlung seiner statistischen Grundla-

gen auf den Abschnitt 5. 

Damit die Dateien zum ersten Beispiel im aktuellen Zustand erhalten bleiben, sichern wir das geöffnete 

Projekt mit File > Save as in die neue Projektdatei Restrict.amw. 

Im bisherigen „Modell“ 

 

sind die vier Varianzen und die sechs Kovarianzen frei schätzbar, so dass keine prüfbare Behauptung vor-

liegt. Es liegt aber nahe, für die beiden Variablen recall und place zu beiden Messzeitpunkte (vor und 

nach dem Training) identische Kovarianzmatrizen anzunehmen: 

i) Var(recall1) = Var(recall2) 

ii) Var(place1) = Var(place2) 

iii) Cov(recall1, place1) = Cov(recall2, place2) 

Durch diese Restriktionen resultiert ein Modell, das sich als falsch heraus stellen kann, z.B. weil die in 

einer Studie für recall1 und recall2 festgestellten Varianzunterschiede das durch zufällige Stichproben-

schwankungen erklärbare Maß überschreiten. 

Der von Amos bei Verwendung der Schätzmethoden ML, GLS oder ADF angebotene 
2
-Modellgültig-

keitstest beurteilt folgendes Hypothesenpaar: 
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 Nullhypothese 

Die Populationskovarianzmatrix hat die vom Modell behauptete bzw. implizierte Form. 

 Alternativhypothese 

Die Populationskovarianzmatrix genügt nicht den vom Modell auferlegten Restriktionen. 

Obwohl ein Modellgültigkeitstest methodologisch schon recht anspruchvoll ist, verzichten wir vorläufig 

getreu dem Motto „Aller Anfang ist leicht“ aus der Abschnittsüberschrift noch auf eine Herleitung mit 

Hintergrundinformationen, die später in Abschnitt 5 nachgeliefert wird. Mit den Voraussetzungen der 

Strukturgleichungsanalyse (Stichprobengröße, Verteilung der manifesten Variablen) muss man sich aber 

auch bei ausgeprägter Anwendungsorientierung beschäftigen, was daher in den nächsten Abschnitten ge-

schehen soll. 

 

2.7.1 Erforderliche Stichprobengröße 

Ein wichtiges Thema bei Verfahren, die auf asymptotischer Statistik beruhen, ist die minimal erforderli-

che Stichprobengröße. In der Literatur (z.B. Kline 2005, S. 111, Loehlin 2004, S. 55, Schumacker & 

Lomax 2004, S. 48ff) werden folgende Empfehlungen genannt: 

 Mindestens N  100, besser N  200 

 Mindestens N  5  t, wobei t die Anzahl der zu schätzenden Parameter ist. 

 Beim ADF-Schätzverfahren sind noch größere Stichproben erforderlich (m: Anzahl der manifesten 

Variablen): 

min(200; 1,5  m  (m + 1)) 

Im dem seit Abschnitt 2 betrachteten Gedächtnisprojekt, das aus der Amos-Beispielsammlung stammt, 

sind leider nur 40 Fälle vorhanden. 

Eben wurde der erforderliche Stichprobenumfang für ein korrektes Verhalten der Signifikanztests bei gül-

tiger Nullhypothese betrachtet, wobei vor allem eine erhöhte Fehlerrate erster Art zu vermeiden ist (fal-

sche Entscheidung gegen eine gültige Nullhypothese). Das Planungsziel, die Wahrscheinlichkeit für einen 

Fehler zweiter Art (falsche Entscheidung gegen eine gültige Alternativhypothese) zu begrenzen, kann je 

nach angenommener Effektstärke eine erheblich größere Stichprobe erfordern (siehe z.B. Kline 2005, S. 

156ff; Loehlin 2004, S. 70ff). Bei Tests zu einem einzelnen Parameter in einem Modell für manifeste Va-

riablen) kann man sich an der Power-Analyse für die Korrelations- und Regressionsanalyse orientieren 

(siehe z.B. Cohen 1988). Mit der Power des Gültigkeitstests zu einem kompletten Modell werden wir uns in 

Abschnitt 5 kurz beschäftigen. 

 

2.7.2 Verteilungsannahmen bei Strukturgleichungsanalysen 

Hypothesentests, Vertrauensintervalle und Effizienzaussagen zu den ML- oder GLS-Schätzmethoden in 

Amos basieren auf folgenden Verteilungsvoraussetzungen: 

 Die Beobachtungen (Fälle) sind stochastisch unabhängig voneinander. 

 Die Kovarianzmatrix der manifesten Variablen hat vollen Rang, d.h. keine manifeste Variable ist 

von den anderen linear abhängig. 

 Die manifesten Variablen sind gemeinsam multivariat normalverteilt. 

Während die beiden ersten Voraussetzungen technischer Natur und meist erfüllt sind, stellt die Normali-

tätsannahme eine strenge Behauptung über die Population dar. 

Wenn manifeste exogene Variablen als fixiert betrachtet werden können, genügen schwächere Vertei-

lungsvoraussetzungen: Fixierte Variablen dürfen keinen Messfehler enthalten (siehe Abschnitt 6.1), was 
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z.B. bei der von einem Experimentator kontrollierten Gruppenzugehörigkeit erfüllt ist. Die Verteilung der 

fixierten Variablen ist irrelevant, und für die übrigen Variablen muss bei Verwendung der ML- oder GLS-

Schätzmethode gelten (Arbuckle 2009a, S. 35f): 

 Für jede Wertekombination der fixierten Variablen ist die bedingte gemeinsame Verteilung der zu-

fälligen Variablen multivariat normal. 

 Die bedingten Varianz-Kovarianzmatrizen der Zufallsvariablen sind identisch für alle Wertekom-

binationen der fixierten Variablen. 

 Die bedingten Erwartungswerte der Zufallsvariablen hängen linear von den Werten der fixierten 

Variablen ab. 

Diese schwächeren Voraussetzungen sind identisch mit denjenigen der linearen Regressionsanalyse. 

 

2.7.3 Normalverteilungs- und Ausreißerdiagnostik in Amos 

Nach Abschnitt 2.7.2 setzt der geplante 
2
-Modellgültigkeitstest für das restriktive Modell zu den Ge-

dächtnisdaten voraus, dass die vier Variablen (recall1, recall2, place1, place2) gemeinsam multivariat 

normalverteilt sind. Wir fordern (über  oder View > Analysis Properties > Output) in der fol-

genden Dialogbox entsprechende Tests an 

 

und erhalten nach Anforderung der Schätzung (mit  oder Analyze > Calculate Estimates oder 

Strg+F9) in der Textausgabe (zu öffnen mit  oder View > Text Output oder F10) folgende Er-

gebnisse: 
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Assessment of normality (Group number 1) 

Variable min max skew c.r. kurtosis c.r. 

place1 20,000 47,000 -,395 -1,021 ,041 ,053 

recall1 5,000 16,000 ,082 ,212 -,139 -,179 

recall2 4,000 16,000 -,481 -1,242 -,175 -,226 

place2 30,000 48,000 ,108 ,278 -,750 -,968 

Multivariate      -1,287 -,588 

Bei den univariaten Ergebnissen zeigen sich beim Vergleich den CR - Statistiken mit dem kritischen Wert 

1,96 (= 97,5%-Fraktil der Standardnormalverteilung) keine signifikanten Schiefe- bzw. Wölbungswerte 

(skew bzw. kurtosis). Auch die multivariate Wölbungsbeurteilung nach Mardia (1974) ist unauffällig. 

Allerdings sind die Testverfahren in der sehr kleinen Stichprobe (N = 40) wenig sensibel gegenüber Ab-

weichungen von der Normalitätsannahme. 

Bei größeren Stichproben werden die (praktisch immer vorhandenen) Abweichungen von der (multivaria-

ten) Normalität in der Regel aufgedeckt. Wie Arbuckle (2009b, S. 538) zu Recht feststellt, sind Signifi-

kanztests wenig nützlich als Maße für den Abstand zur Normalverteilung und als Kriterien zur Unter-

scheidung zwischen harmlosen und ernsthaften Verletzungen der Verteilungsvoraussetzung. Aufgrund 

seiner Literaturdurchsicht empfiehlt Kline (2005, S. 50) Grenzwerte für die univariaten Verteilungsstatis-

tiken: Die Beträge der Schiefe- bzw. Wölbungsstatistik sollten den Wert 3 bzw. 7 nicht überschreiben. 

Weil Amos wie viele andere Programme (z.B. SPSS) von der Wölbungsstatistik den Wert 3 subtrahiert, 

den eine Normalverteilung erreicht, wurde der von Kline angegebene Grenzwert 10 entsprechend korri-

giert. 

Zur Suche nach Ausreißern kann die folgendermaßen definierte Mahalanobis-Distanz dienen: 

)()( 1T
μxμx    

Sie quantifiziert die multivariate Distanz eines Falls mit den im Vektor x gesammelten manifesten Vari-

ablenausprägungen vom korrespondierenden Vektor  mit den Populationserwartungswerten, wobei die 

Elemente der invertierten Populationskovarianzmatrix  zur Gewichtung verwendet werden. Amos be-

richtet in der Textausgabe die Schätzwerte und Signifikanzbeurteilungen: 

Observation number Mahalanobis d-squared p1 p2 

20 8,784 ,067 ,937 

32 8,501 ,075 ,811 

15 8,210 ,084 ,666 

16 8,030 ,090 ,495 

. . . . 

Für den Fall Nummer 20 mit der größten Mahalanobis-Distanz (8,784) erhalten wir folgende Überschrei-

tungswahrscheinlichkeiten: 

 Spalte p1 

Bei einer zufällig aus einer multivariat normalverteilten Population gezogenen Beobachtung erhält 

man eine Mahalanobis-Distanz  8,784 mit einer Wahrscheinlichkeit von 0,067. In der Spalte p1 

sind Werte < 0,05 speziell bei größeren Stichproben zu erwarten (eben mit der Wahrscheinlichkeit 

0,05) und daher unkritisch. 
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 Spalte p2 

Bei einer zufällig aus einer multivariat normalverteilten Population gezogenen Stichprobe mit 

demselben Umfang wie bei der aktuell analysierten erhält man eine maximale Mahalanobis-

Distanz  8,784 mit einer Wahrscheinlichkeit von 0,937. In der Spalte p2 sprechen Werte < 0,05 

für einen ernst zu nehmenden Ausreißer. 

Während die Werte in der Spalte p1 für alle Fälle identisch zu interpretieren sind, ändert sich die Bedeu-

tung des p2-Werts in Abhängigkeit vom zugehörigen Rangplatz. Für den Fall Nummer 32 mit dem zweit-

größten Abstandswert erhalten wir in der p2-Spalte die Wahrscheinlichkeit dafür, dass in einer umfangs-

gleichen Stichprobe die zweitgrößte Mahalanobis-Distanz diesen Wert übersteigt. 

Im Beispielprojekt gibt es keine Hinweise auf Ausreißer. 

Die Normalitätsbeurteilungen erfordern einen kompletten Datensatz, stehen also fehlenden Werten nicht 

zur Verfügung. 

 

2.7.4 Parameterrestriktionen formulieren 

Amos und vergleichbare Programme erlauben eine flexible Modellformulierung mit Hilfe von Parameter-

restriktionen: 

 Parameter können auf feste Werte fixiert werden. 

Eine Fixierung auf den Wert Null lässt sich in Amos Graphics für viele Parameter durch Verzicht 

auf entsprechende Bestandteile im Modellspezifikations-Pfaddiagramm ausdrücken. Um z.B. eine 

Kovarianz auf Null zu setzen, lässt man den zugehörigen Doppelpfeil einfach weg. 

 Zwei oder mehrere Parameter können auf einen identischen (schätzbaren) Wert gesetzt werden. 

Wir werden in Abschnitt 2.7.5 mit dem 
2
-Modellgültigkeitstest eine Möglichkeit kennen lernen, ein 

komplettes Modell mit allen darin enthaltenen Parameterrestriktionen zu prüfen. Durch den Vergleich von 

geschachtelten Modellen lässt sich eine einzelne Restriktion oder ein Bündel von Restriktionen prüfen 

(siehe Abschnitt 5.5). 

Um in Amos Parameterrestriktionen zu formulieren, wechselt man nötigenfalls mit den Schalter  in 

den Modellspezifikationsmodus und öffnet die Dialogbox Object Properties über das Kontextmenü 

zum betroffenen Objekt. Nun können auf der Parameters-Registerkarte die gewünschten Restriktionen 

eingetragen werden. Im folgenden Beispiel wird die Varianz der Variablen recall1 auf den Wert 6 fixiert: 

 

Amos zeigt die Werte der fixierten Parameter im Modellspezifikations-Pfaddiagramm an, z.B.: 
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Um eine Gleichheitsrestriktion zu formulieren, trägt man für alle betroffenen Parameter eine gemeinsame 

symbolische Wertbezeichnung ein, z.B.: 

 

Die Bezeichnung ist weitgehend frei wählbar, sollte aber keine „syntaktisch bedeutsame“ Zeichen (z.B. 

Klammern) enthalten. Nachdem auf diese Weise in unserem Beispiel die Varianzen der beiden recall-

Variablen sowie die Varianzen der beiden place-Variablen gleich gesetzt wurden, sieht das Modellspezi-

fikations-Pfaddiagramm folgendermaßen aus: 

 

Auch für Kovarianzen können auf analoge Weise Restriktionen formuliert werden. Im folgenden Modell 

wurde die recall1-place1 - Kovarianz mit der recall2-place2 - Kovarianz gleich gesetzt, indem beide 

Parameter über die Dialogbox Object Properties denselben symbolischen Namen 
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erhalten haben: 

 

Außerdem wurde das Pfaddiagramm mit den Shape- und Move-Werkzeugen umgestaltet (vgl. Abschnitt 

2.1). 

 

2.7.5 2
-Gültigkeitstest zum Modell mit den Parameterrestriktionen 

Das Modell aus Abschnitt 2.7.4 mit den drei Gleichheitsrestriktionen: 

i) Var(recall1) = Var(recall2) 

ii) Var(place1) = Var(place2) 

iii) Cov(recall1, place1) = Cov(recall2, place2) 

ist überidentifiziert (siehe Abschnitt 5.3), weil … 

 es identifiziert ist, also für jeden Parameter eine eindeutige Schätzung erlaubt, 

 und außerdem die Anzahl der Stichprobenmomente (im Beispiel: Varianzen und Kovarianzen) 

größer ist als die Anzahl der frei schätzbaren Parameter. 

Auch bei perfekter Modellgültigkeit in der Population werden in einer Stichprobe die Varianzen und 

Kovarianzen im Allgemeinen nicht den Modellrestriktionen genügen. Für unser Beispiel liefert Amos bei 

Verwendung der voreingestellten Maximum Likelihood - Methode die folgenden modellgemäßen Para-

meterschätzer: 
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Covariances 

   Estimate S.E. C.R. P Label 

place2 <--> recall2 2,712 1,821 1,489 ,136 c_rp 

recall1 <--> place1 2,712 1,821 1,489 ,136 c_rp 

place2 <--> place1 17,149 5,155 3,327 ***  

recall2 <--> place1 2,220 2,216 1,002 ,316  

place2 <--> recall1 4,608 2,166 2,127 ,033  

recall2 <--> recall1 2,872 1,208 2,377 ,017  

Variances 

 Estimate S.E. C.R. P Label 

recall1 7,055 1,217 5,798 *** v_r 

recall2 7,055 1,217 5,798 *** v_r 

place1 27,525 5,177 5,317 *** v_p 

place2 27,525 5,177 5,317 *** v_p 
 

Wir fordern nach 

  oder  View > Analysis Properties > Output 

in der folgenden Dialogbox 

 

zusätzlich die Sample moments und die Residual moments an. Auf die Implied moments kön-

nen wir verzichten, weil unser sehr elementares Modell die fraglichen (Ko)varianzen als Parameter enthält 

und deren Schätzwerte zur Standardausgabe gehören (siehe oben). Nach einer erneuten Modellschätzung 

enthält die Textausgabe auch die Stichprobenkovarianzmatrix: 
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Sample Covariances (Group number 1) 

 place1 recall1 recall2 place2 

place1 33,578    

recall1 4,338 5,788   

recall2 2,014 2,556 7,944  

place2 17,905 3,575 ,427 22,160 

und die Matrix mit den Abweichungen der Stichprobenkovarianzen von den Modellimplikationen: 

Residual Covariances (Group number 1 - Default model) 

 place1 recall1 recall2 place2 

place1 6,052    

recall1 1,625 -1,267   

recall2 -,207 -,316 ,890  

place2 ,756 -1,033 -2,285 -5,365 

Der 
2
-Modellgültigkeitstest basiert auf der Wahrscheinlichkeit, solche oder stärkerer Abweichungen 

aufgrund von zufälligen Stichprobeneffekten bei einer Population mit gültigem Modell anzutreffen. Amos 

protokolliert das Ergebnis in der Textausgabe im Abschnitt Notes for Model: 

 

Amos ermittelt für die 
2
-Prüfgröße den Wert 6,276, zu dem bei 3 Freiheitsgraden die Überschreitungs-

wahrscheinlichkeit 0,099 gehört. Damit wird bei  = 0,05 die Nullhypothese, also unser Modell mit den 

drei Parameterrestriktionen, nicht abgelehnt. 

Speziell bei größeren Stichproben neigt der 
2
-Modellgültigkeitstest dazu, taugliche Modelle wegen ver-

nachlässigbarer Schwächen zu verwerfen. Es sind zahlreiche weitere Kriterien zur Modellbeurteilung 

vorgeschlagen worden, die sich teilweise auch für größere Stichproben eignen (siehe Abschnitt 5.6). 

 

2.8 Beschriftungen und andere Möglichkeiten zur Gestaltung des Pfaddiagramms 

Das eben erfolgreich getestete Model sieht (nach einigen gleich zu besprechenden Nachbearbeitungen) im 

Ausgabe-Pfaddiagramm folgendermaßen aus: 
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2.8.1 Diagrammbeschriftungen 

Gehen Sie folgendermaßen vor, um die in obigem Pfaddiagramm enthaltenen Beschriftungen einzufügen: 

 Bei Anzeige eines Ausgabe-Pfaddiagramms (mit Parameterschätzungen) ist das Beschriftungs-

Werkzeug nicht verfügbar. Wechseln Sie also nötigenfalls mit dem Schalter  in den Modellspezi-

fikationsmodus. 

 Aktivieren Sie das Beschriftungswerkzeug mit: 

   oder  Diagram > Figure Caption 

 Klicken Sie auf eine freie Stelle der Zeichenfläche während der Mauszeiger mit  title  beschriftet ist. 

Daraufhin erscheint die Dialogbox Figure Caption. 

 Tragen Sie hier den gewünschten Text ein, wobei u.a. die folgenden Textmakros zur Verfügung ste-

hen, die von Amos beim Zeichnen des Pfaddiagramms durch aktuell gültige Inhalte ersetzt werden: 

Textmakro Es erscheint 

\format

  

„Model Specification“ im Modellspezifikations-Pfaddiagram, 

„Unstandardized estimates“ oder 

„Standardized estimates“ im Ausgabe-Pfaddiagramm 

\cmin 
2
-Statistik zum Modellgültigkeitstest 

\df Anzahl der Freiheitsgrade zum Modellgültigkeitstest 

\p Überschreitungswahrscheinlichkeit zum Modellgültigkeitstest 

Eine vollständige Liste der Amos-Textmakros finden Sie im Hilfesystem über den Indexeintrag Text 

macros. 

Die obige Beschriftung wurde mit folgender Dialogbox erzeugt: 
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 Beschriftungen lassen sich wie beliebige andere Elemente eines Pfaddiagramms mit dem –

Werkzeug verschieben und mit dem –Werkzeug entfernen. 

 Per –Mausklick kann man im Modellspezifikationsmodus die Dialogbox Figure Caption zur 

Modifikation einer vorhandenen Beschriftung öffnen. Auch die per Standardwerkzeug  via Kon-

textmenü erreichbare Dialogbox Object Properties erlaubt eine Änderung der Beschriftung: 

 

In den beiden genannten Dialogboxen steht die Positionierungsoption Center on page zur Verfü-

gung, die für ein horizontales Zentrieren auf der Seite sorgt und das freie Bewegen auf die vertikale 

Richtung beschränkt. 

 

2.8.2 Formatierungsoptionen 

Die Dialogbox Interface Properties, die nach 

View > Interface Properties  oder  Strg+I 

erscheint, bietet etliche Optionen zur Formatierung einzelner Ausgabebestandteile, z.B.: 

 Auf dem Registerblatt Typefaces legt man fest, welche Schriftarten in Pfaddiagrammen für Va-

riablennamen, Parameterwerte und Beschriftungen verwendet werden sollen: 
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 Auf dem Registerblatt Pen Width kann man Linienstärken und Pfeilspitzen verändern. 

 Auf dem Registerblatt Formats kann man die beiden unveränderlichen Formatfamilien Unstan-

dardized estimates und Standardized estimates einsehen sowie zusätzliche Familien defi-

nieren oder ändern. Diese stehen dann als Anzeigevarianten für das Pfaddiagramm zur Verfügung, 

z.B.: 

 

 Die von Textmakros verwendete Anzahl an Dezimalstellen lässt sich auf der Registerkarte Misc 

einstellen. 

 Über die Optionen der Registerkarte Page Layout wurde schon in Abschnitt 2.2.1 berichtet. 

 

2.9 Parameterrestriktionen in AmosEngine-Programmen formulieren 

Mit Hilfe der folgenden Syntaxregeln lassen sich die in Abschnitt 2.7.4 behandelten Parameterrestriktio-

nen in AmosEngine-Programmen (vgl. Abschnitt 2.6) formulieren: 

 Für jede an einer Restriktion beteiligte Kovarianz ist ein AStructure-Methodenaufruf erforder-

lich. Dort setzt man zwischen die beiden Variablen einen Kovarianzpfeil, dargestellt durch die 

Zeichenfolgen "<>" oder "<-->" (mit beliebig vielen Bindestrichen). 

 Eine Restriktion wird durch einen in Klammern hinter die Parameterrepräsentation gesetzten Wert 

ausgedrückt. Dabei kann es sich um eine Konstante (bei der Fixierung auf einen festen Wert) oder 

um eine symbolische Wertbezeichnung handeln (bei der Gleichheitsrestriktion). 

Diese etwas abstrakt formulierten Regeln werden in folgendem Beispielprogramm veranschaulicht, das 

die in Abschnitt 2.7.5 besprochene Textausgabe erzeugt: 
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Alternativ zur AmosEngine-Methode AStructure kann man auch die Methoden Cov und Var verwen-

den. 

 

2.10 Parameter per C.R. - oder Modellgültigkeitstest auf Signifikanz prüfen 

In Abschnitt 2.4.2 haben wir Parametertests über das C.R. (für Critical Ratio) 

hlerStandardfe

Schätzwert
 

kennen gelernt und als Beispiel folgendes Testproblem behandelt: 

H0: Cov(recall1, recall2) = 0   versus   H1: Cov(recall1, recall2)  0 

Es resultierte die Prüfgröße 2,203 und eine Überschreitungswahrscheinlichkeit von p = 0,028, so dass die 

Nullhypothese verworfen werden konnte. 

Eine alternative Signifikanzprüfung zu einem Parameter lässt sich über einen Modellgültigkeitstest (vgl. 

Abschnitt 2.7.5) realisieren, indem der fragliche Parameter aus einem saturierten Modell (vgl. Abschnitt 

5.3) gestrichen wird, das jede Stichprobenkovarianzmatrix exakt reproduzieren kann und ebenso viele 

freie Parameter enthält, wie Stichprobenmomente vorhanden sind. Das simple „Modell“ aus Abschnitt 2.1 

besitzt diese Eigenschaft: 
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Wir setzen nun die Kovarianz von RECALL1 und RECALL2 auf Null (z.B. durch Streichen des Kovari-

anzpfeils),  

 

und fordern Amos mit  zur Schätzung der Modelparameter auf. Das Programm fragt vorsichtshalber 

nach, ob wir die Fixierung auf Null ernst meinen oder vielleicht nur einen Pfeil vergessen haben: 

 

Daher ist es vielleicht sinnvoller, die Fixierung mit den Methoden aus 2.7.4 explizit zu formulieren. 

Im approximativen 
2
-Test wird die Nullhypothese mit p = 0,014 verworfen, wie der Textausgabe zu ent-

nehmen ist (im Abschnitt Notes for Model > Result): 
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Result (Default model) 

Minimum was achieved 

Chi-square = 5,978 

Degrees of freedom = 1 

Probability level = ,014 

Diese Überschreitungswahrscheinlichkeit liegt trotz der relativ kleinen Stichprobe (N = 40) relativ nahe 

beim Ergebnis des exakten t-Tests, der p = 0,016 liefert. 

Asymptotisch werden die beiden Amos-Testverfahren miteinander und mit dem exakten t-Test überein-

stimmen. Bei einer kleinen Stichprobe wie der unsrigen ist mit Abweichungen zu rechnen, die durchaus 

auch zu unterschiedlichen Testentscheidungen führen können. Unter den beiden von Amos angebotenen 

Testverfahren ist im Zweifelsfall das Verfahren per Parameterrestriktion und Modellgültigkeitstest zu 

bevorzugen. Dabei muss allerdings für jeden zu beurteilenden Parameter ein spezielles eingeschränktes 

Modell analysiert werden. 

In Abschnitt 5.5 wird sich zeigen, dass ein Signifikanztest mit dem saturierten Modell als Referenz ein 

Spezialfall für das generelle Prinzip der Testkonstruktion durch Vergleich von zwei geschachtelten Mo-

dellen ist. 

Wie Sie bereits wissen, besteht eine Stärke der Testkonstruktion über Parameterrestriktionen darin, dass 

sehr flexibel zusammengesetzte Hypothesen (über mehrere Parameter) formuliert und beurteilt werden 

können. 
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3 Modelle für manifeste Variablen 

Nachdem wir schon einige Erfahrung bei der Bedienung des Computer–Programms Amos erworben ha-

ben, konzentrieren wir uns im Kurs nun zunehmend auf methodische Themen. Dabei bleiben wir zunächst 

anwendungsorientiert und vertagen die Beschäftigung mit den statistischen Grundlagen der Strukturglei-

chungsanalyse auf den Abschnitt 5. Vorher betrachten wir zwei wichtige Anwendungen, die man auch mit 

den beiden Bestandteilen eines „kompletten“ Strukturgleichungsmodells für latente Variablen assoziieren 

kann (Strukturmodell und Messmodell): 

 Modelle für manifeste Variablen 

 Konfirmatorische Faktorenanalyse 

 

3.1 Beispiel 

In einer Untersuchung zu den Bedingungen der beruflichen Ambitionen von Jugendlichen (Kerchoff 1974) 

wurden bei 767 Jungen im Alter von 12 Jahren folgende Variablen erhoben:
1
 

 INTELLNZ Intelligenz des Jungen 

 BLDNGVAT Bildungsgrad des Vaters 

 BERUFVAT Beruf des Vaters 

 SCHULLST Schulleistung des Jungen 

 AMBITION Berufliche Ambitionen des Jungen 

Über das Zusammenwirken der Variablen wird angenommen: 

 SCHULLST = γ11 INTELLNZ + γ12 BLDNGVAT + RS 

 AMBITION = γ21 BERUFVAT + γ22 SCHULLST + RA 

In der ersten Gleichung wird u.a. behauptet, dass eine Erhöhung der Intelligenz um eine Maßeinheit bei 

Konstanthaltung des väterlichen Bildungsgrads im Mittel zu einer Veränderung der Schulleistung um γ11 

Maßeinheiten führt. Analog sind die übrigen Strukturkoeffizienten zu interpretieren. 

Das mit Amos bequem zu erstellende Pfaddiagramm zeigt das Modell anschaulich und präzise: 

 

Wir beschränken uns zunächst auf die erste Gleichung, erproben Amos also bei einer Aufgabenstellung, 

die auch mit traditioneller Regressionstechnologie zu lösen ist. 

                                                 
1
 Die völlige Fixierung auf väterliche Karrieremerkmale ist wohl der im letzten Jahrtausend noch mangelhaften Emanzipation 

anzulasten. 
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Interessierte finden die Kerchoff-Daten in der SPSS-Matrix-Datendatei Ambition.sav (Bezugsquelle: sie-

he Vorwort). 

 

3.2 Einlesen von Momentmatrizen 

Die eben genannte Datei Ambition.sav enthält keine Fälle  Variablen - Datenmatrix, sondern eine Korre-

lationsmatrix mit einigen Zusatzinformationen, wie das folgende SPSS-Datenfenster zeigt: 

 

Amos benötigt für die meisten Analysen keine Rohdaten, sondern lediglich die Stichprobenmomente (d.h. 

Mittelwerte, Varianzen und Kovarianzen). Es genügt also, die Stichprobenmomente (z.B. in einer SPSS-

Matrixdatendatei) anzubieten. 

In der Regel sind jedoch Rohdaten vorhanden, und diesen können selbstverständlich direkt verwendet 

werden. Im aktuellen Abschnitt wird eine Lösung für spezielle Eingabedaten beschrieben und keinesfalls 

empfohlen, Rohdaten aufwändig auf dieses Format zu bringen. 

Die Verwendung der (gelegentlich ausschließlich publizierten) Korrelationsmatrix an Stelle der von A-

mos (und vergleichbaren Strukturgleichungsprogrammen) in der Regel verlangten Kovarianzmatrix ist 

allerdings nur unter folgenden Bedingungen erlaubt: 

 Das Strukturgleichungsmodell ist skaleninvariant. 

Ein skaleninvariantes Modell ist nicht abhängig von den Maßeinheiten der manifesten Variablen 

und kann Änderungen der Maßeinheiten durch analoge Änderungen seiner Parameterwerte kom-

pensieren (siehe Abschnitt 5.4.1).  

 Das Modell kann die Varianzen der manifesten Variablen perfekt reproduzieren. 

 Es wird eine skaleninvariante Schätzmethode (z.B. ML, GLS, ADF) verwendet. 

Sofern das untersuchte Modell seinerseits skaleninvariant ist, bleiben die Ergebnisse einer skalenin-

varianten Schätzmethode im Wesentlichen invariant bei Veränderung der Maßeinheiten von mani-

festen Variablen (siehe Abschnitt 5.4.1).  

Bei einem Regressionsmodell und der in Amos voreingestellten ML-Schätzmethode sind diese Bedingun-

gen erfüllt. Weitere Informationen zur nicht ganz trivialen Frage der Äquivalenz von Kovarianz- und Kor-

relationsmatrizen bei der Analyse von Strukturgleichungsmodellen finden Sie z.B. bei Baltes-Götz (1994, 

S. 4-9), Jöreskog & Sörbom (1989, Abschnitt 1.21) und Lee (1985). 
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3.3 Pfaddiagramme mit gerichteten Pfeilen und latenten Variablen 

Wir wollen die lineare Regression von Schulleistung auf die Intelligenz des Schülers und die Bildung des 

Vaters untersuchen und erstellen zunächst das Pfaddiagramm. 

 

Beim Zeichnen der drei Rechtecke empfiehlt sich folgende Vorgehensweise: 

 Malen Sie mit -Werkzeug ein Rechteck für die erste Variable, und korrigieren Sie seine 

Form bei Bedarf mit dem -Werkzeug. 

 Erzeugen Sie mit -Werkzeug für die restlichen Variablen Kopien dieses Rechtecks. Halten 

Sie beim Verschieben der Kopie für BLDNGVAT die  -Taste fest, damit das Rechteck seine 

horizontale Position behält. 

 Mit  

Edit > Space Vertically 

können Sie dafür sorgen, dass die drei (zuvor markierten) Rechtecke vertikal gleiche Abstände ha-

ben. 

Zeichnen Sie nun mit 

  oder  Diagram > Draw Unobserved  oder  F4 

eine Ellipse für die latente (!) Fehlervariable zum Kriterium. 

Um die Y-(Höhen)Koordinate des Kriteriums-Rechtecks auf die zugehörige Fehler-Ellipse zu übertragen, 

aktivieren Sie am besten mit: 

  oder  Edit > Drag Properties  oder  Strg+G 

den Eigenschaftstransfer, dessen Umfang in folgender Dialogbox festgelegt wird: 
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Klicken Sie dann auf das Rechteck und ziehen Sie mit gedrückter Maustaste die festgelegten Eigenschaf-

ten auf die Ellipse. 

Ergänzen Sie den gerichteten Pfeil für den Effekt der Residualvariablen auf das Kriterium nach 

  oder  Diagram > Draw Path  oder  F5 

ausnahmsweise nachlässig, 

 

und lassen Sie ihn nach 

  oder  Edit > Touch Up  oder  Strg+H 

mit Mausklicks auf Rechteck und Ellipse von Amos in die richtige Position bringen. Auf analoge Weise 

lassen sich die gerichteten Pfeile von den Regressoren auf das Kriterium und der Kovarianz-Doppelpfeil 

zwischen den beiden Regressoren bei geringem Aufwand optimal platzieren, so dass folgendes Zwischen-

ergebnis resultiert: 

 

Zum bequemen Benennen der manifesten Variablen ordnen wir spätestens jetzt über 

  oder  File > Data Files  oder  Strg+D 

dem Projekt seine Eingabedatei zu. Dann öffnen wir mit 

  oder  View > Variables in Dataset  oder  Strg+ +D 

die folgende Variablenliste 
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und ziehen die benötigten Variablennamen per Maus auf das jeweils zugehörige Rechteck. Für die latente 

Residualvariable müssen wir per Eigenschaftsdialogbox einen Namen festlegen. So ergibt sich der nächs-

te Entwicklungsstand des Pfaddiagramms: 

 

Wir verwenden die übliche, im Abschnitt 3.8 detailliert diskutierte Annahme, dass die Regressoren mit 

dem Residuum unkorreliert sind, so dass keine entsprechenden Doppelpfeile einzutragen sind. Kovarianz 

en zwischen den Regressoren und dem Kriterium sind natürlich erlaubt und erwartet, werden aber im 

Pfaddiagramm nicht dargestellt. Es sind keine Parameter, sondern Implikationen des Modells. Die Kova-

rianz zwischen den beiden Prädiktoren ist hingegen ein Modellparameter und muss durch einen Doppel-

pfeil repräsentiert werden, wenn sie nicht explizit auf den Wert Null fixiert werden soll. 

 

3.4 Ein technisches Identifikationsproblem 

Wenn wir Amos nach obigen Vorarbeiten mit  zur Schätzung der Modellparameter auffordern, bleibt 

anschließend der  - Schalter zur Anzeige des Ausgabe-Pfaddiagramms passiv, und wir erhalten in der 

Textausgabe im Abschnitt Notes for Model die folgende Informationen über ein Identifikationsprob-

lem: 

 

Amos informiert im Abschnitt Estimates über die Problemstelle: 
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Mit der in Amos per Voreinstellung frei schätzbaren Varianz der Fehlervariablen enthält das Modell sie-

ben freie Parameter: 

3 Varianzen: 

INTELLNZ 

BLDNGVAT 

RS 

1 Kovarianz: 

INTELLNZ <--> BLDNGVAT 

3 Strukturkoeffizienten (Pfadgewichte): 

SCHULLST <--- INTELLNZ 

SCHULLST <--- BLDNGVAT 

SCHULLST <--- RS 

Diesen stehen nur sechs Stichprobenmomente gegenüber (drei Varianzen und drei Kovarianzen), so dass 

keine Identifikation vorliegen kann.
1
 

Insbesondere enthält das Modell mit dem Regressionsgewicht der Residualvariablen RS und mit deren 

Varianz zwei Parameter, die aufgrund der vorhandenen Information nicht simultan geschätzt werden kön-

nen. Arbuckle (2009a, S. 70) illustriert die Situation mit folgender Analogie: Aus der Mitteilung „Ich ha-

be Eintrittskarten im Wert von 50 € gekauft“ können wir nicht simultan die Anzahl der erworbenen Ein-

trittskarten und den Preis einer einzelnen Karte erschließen. Wenn wir aber Anzahl oder Preis kennen, ist 

der jeweils fehlende Wert leicht zu ermitteln. Bei unserem Identifikationsproblem ist allerdings nicht da-

mit zu rechnen, dass wir einen der beiden unbekannten Werte irgendwie in Erfahrung bringen. Wir müs-

sen daher einen Parameter fixieren, z.B. das Regressionsgewicht auf den Wert Eins. Damit wird keine 

empirische Behauptung aufgestellt, sondern lediglich eine Unbestimmtheit aus dem Modell beseitigt. 

Zur Beseitigung dieser Unbestimmtheit kann man oft zwischen zwei Methoden wählen, die (abgesehen von 

Modellen mit einer so genannten constraint interaction, siehe unten) äquivalent sind: 

 Unit Loading Identification (ULI)) 

Das Regressionsgewicht wird auf den Wert Eins fixiert. 

 Unit Variance Identification (UVI)) 

Die Varianz der latenten Fehlervariablen wird auf den Wert Eins fixiert. 

                                                 
1
  Die Tatsache, dass wir an Stelle der Kovarianzmatrix eine Korrelationsmatrix verwenden mussten, ändert nichts an dieser 

Kalkulation. 
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Das eben beschriebene Identifikationsproblem ist leicht zu verstehen, und eine Lösung ergibt sich prak-

tisch von selbst. In komplexeren Modellen treten aber Identifikationsprobleme mit weniger trivialen Ur-

sachen und Lösungen auf, so dass wir uns später noch mehrfach mit dem Thema beschäftigen müssen 

(siehe vor allem Abschnitt 5.3). 

Weil es häufig nötig ist, eine endogene (abhängige) Variable mit einem Fehlerterm zu versorgen, bietet 

Amos über 

  oder  Diagram > Draw Unique Variable 

dazu ein spezielles Werkzeug an. Dabei wird das oben besprochene Identifikationsproblem automatisch 

per  ULI-Technik behoben, d.h. das Regressionsgewicht der Fehlervariablen wird auf den Wert Eins fi-

xiert. Um das Fehlerterm-Werkzeug ausprobieren zu können, müssen Sie die bereits vorhandene Fehler-

variable mit dem  - Werkzeug wieder entfernen. Das  - Werkzeug produziert nach einem Klick auf 

das Kriterium ein kreisförmiges Fehlervariablensymbol und lässt dieses Symbol bei weiteren Mausklicks 

um das Kriterium wandern. Nachdem Sie eine gute Position gefunden haben, können Sie den Kreis bei 

Bedarf mit dem  - Werkzeug zu einer Ellipse verformen. 

Nachdem die Residualvariable per Eigenschaftsdialog einen Namen erhalten hat, ist die Modellspezifikti-

on komplett: 

 

 

3.5 Standardisierte Schätzwerte und Determinationskoeffizienten 

Nun steht einer erfolgreichen Schätzung nichts mehr im Weg. Beim Ausgabe-Pfaddiagramm wählen wir 

die standardisierte Variante, weil Amos in diesem Fall den Determinationskoeffizienten der Regressi-

onsgleichung über dem Kriterium notiert: 

 

Ansonsten zeigen die beiden Varianten des Ausgabe-Pfaddiagramms keine relevanten Unterschiede, weil 

wir eine Korrelationsmatrix als Datenbasis verwendet haben. 

Wenn Sie in Ihrer Amos-Ausgabe die standardisierten Schätzer und/oder die quadrierte Multiple Korrela-

tion des Kriteriums mit den Regressoren nicht finden, dann müssen Sie deren Ausgabe nach  oder 

View > Analysis Properties > Output anordnen (vgl. Abschnitt 2.5): 
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3.6 Textausgaben zum Regressionsmodell 

Das eben formulierte Regressionsmodell ist identifiziert, erlaubt also für jeden Parameter eine eindeutige 

Schätzung (siehe Abschnitt 5.3). Weil das Modell gerade so viele freie Parameter besitzt, wie Stichpro-

benmomente vorhanden sind, nennt man es genau identifiziert oder saturiert. In dieser Situation liefert 

Amos im Wesentlichen dieselben Ergebnisse wie Programme zur multiplen linearen Regression, die mit 

dem OLS-Schätzverfahren (Ordinary Least Squares) arbeiten. In der Textausgabe finden sich u.a. die 

folgenden Tabellen: 

Scalar Estimates (Group number 1 - Default model) 

Maximum Likelihood Estimates 

Regression Weights: (Group number 1 - Default model) 

   Estimate S.E. C.R. P Label 

schullst <--- intellnz ,531 ,030 17,487 ***  

schullst <--- bldngvat ,147 ,030 4,832 ***  

Covariances: (Group number 1 - Default model) 

   Estimate S.E. C.R. P Label 

intellnz <--> bldngvat ,277 ,037 7,388 ***  

Squared Multiple Correlations: (Group number 1 - Default model) 

   Estimate 

schullst   ,347 
 

 

Ein saturiertes Modell impliziert keine Restriktionen für die Kovarianzmatrix der manifesten Variablen, 

so dass auch kein Modellgültigkeitstest möglich ist. 
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Mit der Regressionsprozedur von SPSS 18 erhalten wir nahezu identische Ergebnisse:
1
 

 

 

Wir beobachten insbesondere, dass in der sehr großen Kerchoff-Stichprobe (N = 767) die von Amos be-

rechneten Critical Ratios annähernd mit den t-Werten der SPSS-Ausgabe übereinstimmen. 

 

3.7 Pfad- bzw. Strukturgleichungsanalyse mit Amos 

Das am Anfang von Abschnitt 3 formulierte Modell zu den beruflichen Ambitionen von Jugendlichen 

besteht aus zwei Regressionsgleichungen und behauptet (weniger auffällig), dass die Residualvariablen zu 

den beiden Kriterien unkorreliert sind. Damit liegt ein rekursives Modell vor (siehe Seite 6). Für die Mo-

dellierung empirischer Systeme durch rekursive Strukturgleichungsmodelle hat sich der Ausdruck Pfada-

nalyse eingebürgert. Unter diesen Voraussetzungen können alle Parameter mit zwei unabhängig vonei-

nander durchgeführten Regressionsanalysen geschätzt und getestet werden, so dass scheinbar keine Struk-

turgleichungstechnologie benötigt wird. 

Bei der klassischen Regressionsanalyse haben wir aber keine Möglichkeit, die Annahme unabhängiger 

Residuen RS und RA zu überprüfen und ggf. eine vorhandene Residualkorrelation zu berücksichtigen. 

Dabei handelt es sich keinesfalls um eine nebensächliche Vereinbarung, sondern um die empirische Be-

hauptung, dass für die Korrelation von SCHULLST und AMBITION ausschließlich der Effekt von 

SCHULLST auf AMBITION verantwortlich ist. Wir negieren damit z.B. die Existenz von exogenen 

Variablen mit Einfluss auf SCHULLST und AMBITION, die im Modell weggelassen wurden, und ris-

kieren verzerrte Schätzungen für den Strukturkoeffizienten γ22, falls wir uns irren. 

In einem Strukturgleichungsmodell kann die Kovarianz von Residuen aus verschiedenen Gleichungen 

explizit berücksichtigt, d.h. geschätzt und getestet werden. Allerdings setzt die Berücksichtigung einer 

Fehlerkovarianz voraus, dass alle Parameter des Strukturgleichungsmodells identifiziert sind, also eindeu-

tig geschätzt werden können (siehe Abschnitt 5.3). Im aktuellen Beispiel ist die Identifikation gegeben. 

Wir vervollständigen das Pfaddiagramm, tragen den kritischen Kovarianzpfeil ein und vergeben (im Hin-

blick auf eine spätere zu formulierende Restriktion) einen Namen für den zugehörigen Parameter: 

                                                 
1
 Zur Analyse der Matrix-Arbeitsdatei wurde folgende Syntax verwendet: 

REGRESSION 

  MATRIX=IN(*) 

  /DEPENDENT schullst 

  /METHOD=ENTER bldngvat intellnz. 
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Durch eine von Null verschiedene Residuenkorrelation entsteht ein nonrekursives Modell. Aus dem zu 

Beginn von Abschnitt 3 formulierten Pfadmodell ist ein allgemeines Strukturgleichungsmodell geworden, 

und dessen Parameter können mit einer Regressionsprozedur nicht korrekt geschätzt werden. 

Im Unterschied zum Regressionsmodell in Abschnitt 3.6 ist das jetzt betrachtete Strukturgleichungsmo-

dell nicht saturiert, enthält also potentiell fehlerhafte Restriktionen. Es wird z.B. behauptet, dass INTEL-

LNZ und BLDNGVAT keinen direkten Effekt auf AMBITION haben. Stattdessen wird ein vom Media-

tor SCHULLST vermittelter indirekter Effekt angenommen. Zwar können auch im Rahmen von Regres-

sionsanalysen Nullhypothesen über die Abwesenheit direkter Effekte geprüft werden (einzeln oder auch 

blockweise), doch erlaubt die Strukturgleichungsanalyse mit Amos eine simultane Berücksichtigung bei-

der Gleichungen. 

Wir erhalten in der Textausgabe einen Modellgültigkeitstest mit zwei Freiheitsgraden, der das Pfadmodell 

(mit frei schätzbarer Kovarianz der beiden Residuen) freundlich beurteilt (p = 0,273): 

Result (Default model) 

Minimum was achieved 

Chi-square = 2,596 

Degrees of freedom = 2 

Probability level = ,273 

Damit steht einer Interpretation des approximativen Signifikanztests zur Fehlerkovarianz nichts mehr im 

Weg: 

Covariances: (Group number 1 - Default model) 

   Estimate S.E. C.R. P Label 

intellnz <--> bldngvat ,277 ,037 7,388 ***  

bldngvat <--> berufvat ,610 ,042 14,430 ***  

intellnz <--> berufvat ,250 ,037 6,713 ***  

ra <--> rs -,081 ,045 -1,824 ,068 rc 
 

Zwar liegt die empirische Überschreitungswahrscheinlichkeit mit p = 0,068 nur knapp über der Signifi-

kanzgrenze, doch kommt dieses Ergebnis bei geringer Effektstärke (Korrelation(RA, RS) = -0,118) 

hauptsächlich aufgrund der enormen Stichprobengröße (N = 767) zustande. Außerdem müsste für die ne-

gative Fehlerkorrelation eine inhaltliche Begründung gefunden werden. Daher kann die Nullhypothese 

unkorrelierter Residuen guten Gewissens beibehalten werden. 

Für das nach obigen Überlegungen gültige und seiner Einfachheit wegen zu bevorzugende Pfadmodell 

ermittelt Amos die folgenden standardisierten Schätzwerte: 
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Zu den beiden Kriteriumsvariablen erhalten wir Determinationskoeffizienten (quadrierte multiple Korre-

lationen) in Höhe von 0,35 bzw. 0,27. 

Die Regressionsprozedur von SPSS 18 kommt erwartungsgemäß bei der separaten Schätzung der beiden 

Regressionsgleichungen zu praktisch identischen Ergebnissen. Nachdem die SPSS-Ausgabe für die Krite-

riumsvariable SCHULLST schon in Abschnitt 3.6 zu sehen war, folgt hier noch die Ausgabe für die Kri-

teriumsvariable AMBITION: 

 

 

Amos liefert den folgenden Gültigkeitstest für das komplette Modell, der mit p = 0,112 seine Nullhypo-

these beibehält: 

Result (Default model) 

Minimum was achieved 

Chi-square = 5,995 

Degrees of freedom = 3 

Probability level = ,112 

Einen solchen Test kann eine Regressionsprozedur ebenso wenig liefern wie eine Prüfung der Annahme 

unkorrelierter Residuen. 
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In Amos steht zur Prüfung der Fehlerkovarianz neben dem CR-Test noch ein alternativer Test über eine 


2
-Differenz zu zwei geschachtelten Modellen zur Verfügung (siehe Abschnitte 2.10 und 5.5), der im 

Allgemeinen eine höhere Präzision besitzt. Im konkreten Fall erhalten wir eine 
2
-Differenz von 

5,995 - 2,596 = 3,399 

Unter der Nullhypothese folgt die Prüfgröße approximativ einer 
2
-Verteilung mit einem Freiheitsgrad, so 

dass wir eine Überschreitungswahrscheinlichkeit von p = 0,065 erhalten. Damit kommt der 
2
-Differenz 

zum selben Ergebnis wie der oben vorgestellte CR-Test. 

 

3.8 Kausalitätstheoretische Annahmen bei Strukturgleichungsmodellen 

Da für ein Strukturgleichungsmodell meist die kausale Interpretierbarkeit seiner Parameter beansprucht 

wird, müssen wir auf das methodologisch und wissenschaftstheoretisch anspruchsvolle Thema der kausa-

len Interpretierbarkeit statistischer Ergebnisse eingehen. Für eine gründliche Behandlung der Thematik 

wird auf Bollen (1989, Kap. 3) und Steyer (1988, 1992) verwiesen. 

Um die Strukturkoeffizienten der exogenen Variablen einer Modellgleichung kausal interpretieren zu 

können, wird meist für diese Variablen Unkorreliertheit mit dem Residuum angenommen.
1
 Bollen 

(1989, S. 43) spricht in diesem Zusammenhang von der Pseudo-Isolation. Das Residuum enthält neben 

Messfehlern auch die Einflüsse von nicht einbezogenen Variablen, die oft als potentielle Störvariablen 

bezeichnet werden. Die Unkorreliertheit sorgt unter gewissen Zusatzannahmen für die Invarianz der ge-

schätzten Strukturkoeffizienten bei einer Erweiterung der Modellgleichung um zusätzliche Einflussgrö-

ßen, die vorher Bestandteil des Residuums waren. Diese Invarianz ist das zentrale Kriterium moderner 

Kausalitätsbegriffe. 

In der Experimentalmethodologie wird die Unkorreliertheitsvoraussetzung und damit die Invarianzbedin-

gung durch Randomisierung, d.h. durch zufällige Auswahl der bei einem Fall zu realisierenden experi-

mentellen Bedingung sichergestellt. In den Wirtschafts- und Sozialwissenschaften ist die Experimental-

technologie häufig aus ethischen und/oder pragmatischen Gründen nicht einsetzbar. Bei der ersatzweise 

gewählten Strukturgleichungsanalyse von beobachteten Variablen muss dann die Unkorreliertheit der 

exogenen Variablen mit den potentiellen Störvariablen direkt angenommen werden. Geschieht dies zu 

Unrecht, so können verzerrte Schätzer für kausale Effekte resultieren. Dies wird nun an einem sehr einfa-

chen Strukturgleichungsmodell demonstriert, dessen einzige Gleichung die Abhängigkeit einer endogenen 

Variablen Y von einer exogenen Variable X beschreibt: Ein nicht sehr aufgeklärter Forscher hat die Hypo-

these aufgestellt, dass die Geburtenrate (Anzahl der jährlichen Geburten pro 10000 Einwohner, Abk.: Y) 

von der Anzahl der Klapperstörche (Abk.: X) abhängt und möchte anhand der Daten aus schwedischen 

Landkreisen die Stärke des kausalen Effekts von X auf Y schätzen. Sein Modell lautet: 

RXY  

Unter der kritischen Annahme, dass die exogene Variable X nicht mit der Residualvariablen R korreliert, 

schätzt der Forscher aus einer Stichprobenkovarianzmatrix mit den beobachteten Variablen X und Y den 

Effekt ̂  = 0,6. Er folgert, dass die Zunahme der Storchenpopulation um ein Exemplar eine Steigerung der 

Geburtenrate um ca. 0,6 bewirkt. Die Residualvariable R enthält in unserem Beispiel u.a. als bedeutende 

Einflussgröße den Industrialisierungsgrad, welcher die Geburtenrate negativ beeinflusst. Seine Nichtbe-

rücksichtigung allein gefährdet die Interpretierbarkeit von ̂  noch nicht. Allerdings ist der Industrialisie-

rungsgrad ebenfalls negativ mit der Anzahl der Störche korreliert. Die Unkorreliertheitsbedingung ist also 

verletzt, und damit darf ̂  nicht als kausaler Effekt von X auf Y interpretiert werden. In der Tat ist ̂  eine 

drastisch verzerrte Schätzung für den wahren Effekt, der vermutlich exakt Null beträgt. Offenbar führt der 

                                                 
1
 Mit endogenen Variablen in explanatorischer Position werden wir uns gleich beschäftigen 
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negative Effekt des Industrialisierungsgrades auf Y und X zu einer positiven Korrelation zwischen diesen 

Variablen. Daraus resultiert bei einer Analyse unter der falschen Annahme der Unkorreliertheit von X und 

R die unsinnige Effektschätzung ̂ . Ihre Nichtigkeit erweist sich z.B. bei Erweiterung obiger Strukturglei-

chung um die unabhängige Variable Industrialisierungsgrad. Dann wird vermutlich für   eine Schätzung 

nahe Null resultieren, d.h. die Invarianzbedingung gilt nicht. 

Fehlt in einer Modellgleichung eine relevante Einflussgröße, die mit vorhandenen exogenen Variablen 

korreliert ist, dann liegt ein gravierender Spezifiktionsfehler vor. 

Unter bestimmten Voraussetzungen (siehe Kenny 1979, S. 93ff) können nicht gemessene Störvariablen in 

einem Strukturgleichungsmodell über eine Kovarianz zwischen dem Residuum und exogenen Variablen 

berücksichtigt werden. Hier wird die zu Beginn des Abschnitts genannte Generalvoraussetzung für die 

kausale Interpretierbarkeit der Strukturkoeffizienten von exogenen Variablen also nicht benötigt. Zur Lö-

sung der dabei auftretenden Identifikationsprobleme werden aber im Modell zusätzliche exogene Variab-

len ohne direkten Einfluss auf das Kriterium benötigt (so genannte Instrumentalvariablen). Im Ambiti-

onsmodell von Kerchoff (1974, siehe z.B. Abschnitt 3.7) könnte eine nicht gemessene Störvariablen Z mit 

Einfluss auf das Kriterium AMBITION und die ursprünglich exogene Variable BERUFVAT 

 

über eine Kovarianz zwischen der Variablen BERUFVAT dem Residuum zum Kriterium AMBITION 

berücksichtigt werden: 
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Hier sorgen die Instrumentalvariablen INTELLNZ und BILDNGVAT für eine Identifikation aller Mo-

dellparameter. Bei Simulationsstudien mit künstlichen Daten habe ich den Eindruck gewonnen, dass die 

kritischen Parameter g21 und cer nur in großen Stichproben (> 1000 Fälle) präzise geschätzt werden kön-

nen. Offenbar erschwert die Berücksichtigung einer Korrelation zwischen Regressor und Residuum das 

Schätzproblem, wobei das Ignorieren einer vorhandenen Korrelation keine Alternative darstellt. 

Bei einer endogenen Variablen (z.B. SCHULLST), die in einer Modellgleichung in explanatorischer Po-

sition auftritt (im Beispiel: mit dem Kriterium AMBITION), kann ohne große Probleme für die Identifi-

kation und Schätzbarkeit eine von Null verschiedene Korrelation mit dem Residuum (im Beispiel: RA) 

zugelassen und in das Modell einbezogen werden, damit die kausale Interpretierbarkeit des Strukturkoef-

fizienten nicht durch ausgelassene Variablen gefährdet ist. Unter der üblicherweise akzeptierten Voraus-

setzung, dass alle exogenen Variablen des Modells mit allen Residuen des Modells unkorreliert sind, 

muss lediglich eine Korrelation zwischen dem Ambitions-Residuum RA und dem Residuum RS in der 

Gleichung zur endogenen Variablen SCHULLST zugelassen werden. Die praktische Umsetzung dieser 

Modellierungstechnik kennen Sie schon aus Abschnitt 3.7. Nun wird ihre Begründung erweitert und ein 

Zusammenhang mit der Kausalitätsdebatte aufgezeigt. 

SCHULLST ist modellgemäß die Summe aus einer Linearkombination von exogenen Variablen und der 

Residualvariablen RS: 

SCHULLST  =  γ11 INTELLNZ  +  γ12 BLDNGVAT  +  RS 

Weil die exogenen Variablen voraussetzungsgemäß mit RA unkorreliert sind, ist SCHULLST genau 

dann mit dem Ambitions-Residuum RA korreliert, wenn die beiden Störvariablen RS und RA korreliert 

sind. Diese Aussagen folgen aus Theoremen über Varianzen, Kovarianzen und Korrelationen (siehe Ab-

schnitt 5.1). 

Wie Sie aus Abschnitt 3.7 wissen, kann die Kovarianz von RS und RA problemlos in ein Strukturglei-

chungsmodell als frei schätzbarer Parameter integriert und auf Signifikanz getestet werden. In der (sehr 

großen) Kerchoff-Stichprobe wurde die Nullhypothese zur Fehlerkovarianz nicht verworfen, so dass wir 

auf den Parameter verzichtet haben. 
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Der Versuch, im Ambitionsbeispiel simultan für den exogenen Regressor BERUFVAT und für den endo-

genen Regressor SCHULLST eine Kovarianz mit dem Residuum zu AMBITION einzubeziehen, scheitert 

an einem Identifikationsproblem: 

 

Bei einer Regressionsanalyse mit OLS-Schätzung (Ordinary Least Squares) ist zur Gewährleistung der 

kausalen Interpretierbarkeit der Koeffizienten zu fordern, dass alle unabhängigen Variablen einer Glei-

chung (gleichgültig ob exogen oder endogen in Bezug auf das Gesamtmodell) mit dem zugehörigen Resi-

duum unkorreliert sind. Die im aktuellen Abschnitt diskutierten Modellerweiterungen (Kovarianz von 

BERUFVAT und RA bzw. Kovarianz von RS und RA) führen zu nonrekursiven Gleichungssystemen, so 

dass die OLS-Regressionsmethoden nicht anwendbar sind. 
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4 Konfirmatorische Faktorenanalyse 

In einer Studie von Steyer (1988, S. 312) wurden bei 179 Studierenden im Abstand von zwei Monaten 

jeweils zwei Tests für die Zustandsangst erhoben. Zu jedem Zeitpunkt sind also zwei Indikatoren für die 

latente Variable Zustandsangst vorhanden. Diese wird als zeitlich variabel angenommen, so dass für die 

beiden Zeitpunkte unterschiedliche, gleichwohl korrelierte latente Variablen vorliegen. Insgesamt sind 

folgende Variablen zu modellieren: 

X1 Erster Indikator, erhoben zum ersten Zeitpunkt 

X2 Zweiter Indikator, erhoben zum ersten Zeitpunkt 

X3 Erster Indikator, erhoben zum zweiten Zeitpunkt 

X4 Zweiter Indikator, erhoben zum zweiten Zeitpunkt 

1 Latente Zustandsangst zum ersten Zeitpunkt (sprich: Ksi1) 

2 Latente Zustandsangst zum zweiten Zeitpunkt 

1, 2, 3, 4 Residuen der Indikatorvariablen (sprich: Delta1 etc.) 

Hier werden die zusammen mit dem Computerprogramm LISREL eingeführten Variablennamen verwen-

det (siehe z.B. Jöreskog & Sörbom 1989), um bei späteren Analysen des Beispiels kompakte Formeln zu 

erhalten. 

Die Kovarianzmatrix der manifesten Variablen finden Sie in der SPSS-Matrix-Datendatei Steyer.sav 

(Bezugsquelle: siehe Vorwort): 

 

Eine Besonderheit dieser Datei besteht darin, dass sie Stichprobenkovarianzen enthält (ermittelt mit 

Stichprobengröße N als Nenner), also keine erwartungstreuen Schätzer der Populationsvarianzen (ermit-

telt mit dem Nenner N-1). Amos verwendet für Maximum Likelihood – Schätzungen per Voreinstellung 

genau solche Stichprobenkovarianzen, interpretiert die Einträge in einer SPSS-Matrix-Datendatei aber als 

erwartungstreue Schätzer und konvertiert diese per Voreinstellung automatisch. In unserem Fall ist diese 

Automatik natürlich unerwünscht. Daher informieren wir Amos nach 

View > Analysis Properties > Bias 

darüber, dass die von uns angelieferten Covariances supplied as input ohne Vorbehandlung für eine 

Maximum Likelihood - Schätzung geeignet sind: 
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Das zu prüfende Modell gehört zum Bereich der konfirmatorischen Faktorenanalyse, weil … 

 latente Variablen auftreten, die über Ladungspfade zur Erklärung von manifesten Indikatoren bei-

tragen und auf diese Weise empirisch verankert werden, 

 wobei die Beziehungen zwischen den latenten Variablen über eine frei schätzbare Kovarianz-

matrix repräsentiert sind. 

Das Modell 

 

enthält zahlreiche Restriktionen: 
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 Es fehlen etliche potentiell mögliche Ladungspfade, und die Residuen sind unkorreliert. 

In der Terminologie von Kline (2005, S. 166f) liegt eine Standard CFA (Confirmatory Factor 

Analysis) vor: 

­ Jeder Indikator wird nur von einem Faktor beeinflusst. 

­ Die Residuen zu den Indikatoren sind unkorreliert. 

 Die verbliebenen Ladungen sind alle auf den Wert Eins fixiert. 

Hier sind zwei Aussagen mit sehr verschiedenem Bedeutungsgehalt involviert: 

­ In einer empirisch falsifizierbaren Behauptung werden alle Ladungen gleich gesetzt. 

­ Durch die Wahl der Konstanten Eins (an Stelle eines Parameternamens) erhalten die latenten 

Variablen eine Maßeinheit. Hier wird keine empirisch falsifizierbare Behauptung aufgestellt, 

sondern ein technisches Identifikationsproblem gelöst (siehe Abschnitte 3.4 und 5.3). 

 Von einer weiteren Gleichheitsrestriktion sind die vier Fehlervarianzen betroffen. 

In Gleichungsform lautet das Modell: 

X1 = 1  + 1 

X2 = 1  + 2 

X3 =  2  + 3 

X4 =  2  + 4 

Var(1) = Var(2) = Var(3) = Var(4) 

Das Modell enthält vier frei schätzbare Parameter: 

Var(1), Var(2), Cov(1, 2), Var(1) 

Seine Aufgabe besteht darin, die zehn (Ko)varianzen zwischen den vier beobachteten Variablen (X1, …, X4) 

zu erklären durch deren Abhängigkeit von zwei latenten Variablen und durch die (Ko)varianzen der latenten 

Variablen. Hier wird klar, warum die im Manuskript behandelte Methodologie auch als Kovarianzstruktur-

analyse bezeichnet wird: Ein als empirische Gesetzmäßigkeit aufzufassende Kovarianzmatrix wird durch die 

Modellgleichungen erklärt, wobei die Anzahl der verwendeten Parameter möglichst klein sein sollte und 

nach oben durch die Anzahl der beobachteten (Ko)varianzen beschränkt ist. 

Weil eine Standard-CFA - Modell mit zwei Faktoren und mit mindestens zwei Indikatoren pro Faktor 

vorliegt, sind alle Modellparameter identifiziert, können also eindeutig aus den Daten geschätzt werden 

(vgl. Abschnitt 5.3). 

Wir fordern Amos über den Schalter  zur Berechnung der Schätzungen an und erhalten das folgende 

Ausgabe-Pfaddiagramm (unstandardisiert): 
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Der (bei N = 179 relativ vertrauenswürdige) 
2
-Test akzeptiert das Modell (p = 0,274), so dass es als em-

pirisch bewährt gelten kann. 

Mit dem Ziel eines möglichst einfachen Modells könnte man die Varianzen der Faktoren gleich setzen: 

Var(1) = Var(2) 

Das nochmals vereinfachte Modell wird ebenfalls akzeptiert: 
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Nach dem in Abschnitt 5.5 vorzustellenden Prinzip der Testkonstruktion durch Vergleich von geschach-

telten Modellen kann die Nullhypothese identischer Faktorvarianzen geprüft werden. Die 
2
-Differenz aus 

beiden Modellen folgt unter der Nullhypothese einer 
2
-Verteilung mit einem Freiheitsgrad (= df-

Differenz). Das empirische Ergebnis 

8,460 – 7,534 = 0,926 

liegt deutlich unter dem kritischen Wert ( 4 bei α = 0,05), so dass die Nullhypothese akzeptiert werden 

kann. 

Wie ein Blick auf die standardisierte Lösung zeigt, ist die Korrelation der beiden Zustandsangstfaktoren 

theoriekonform mit 0,48 nur moderat, so das die Annahme eines einzigen, situationsunabhängigen bzw. 

zeitstabilen Faktors kaum plausibel ist. Nach einem Vorschlag von Kline (2005, S. 182f) lässt sich das 

Einfaktormodell als vereinfachte (geschachtelte) Variante des Zweifaktormodells betrachten, was einen 

Test der Einfaktor-Nullhypothese über die 
2
-Differenz aus zwei geschachtelten Modellen erlaubt. Aus 

der Identität 

1  2 

folgen die Parameterrestriktionen (vgl. Abschnitt 5.1): 

Cov(1, 2) = Cov(1, 1) = Var(1) = Var(2) 

Umgekehrt implizieren diese Restriktionen eine Korrelation von Eins zwischen den beiden Faktoren (sie-

he Abschnitt 5.1.5 wegen der Korrelationsdefinition): 

1
)Var(

)Var(

)Var()Var(

),Cov(
),Cor(

1

1

21

21
21 









  

Man kann also durch geschickte Parameterrestriktionen im Zweifaktormodell 

 

ein Einfaktormodell als eingeschachtelte Variante formulieren. 

Erwartungsgemäß wird im Beispiel das Einfaktormodell vom 
2
-Test verworfen: 
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Im Angstbeispiel akzeptiert der 
2
-Test das Zweifaktormodell und verwirft das Einfaktormodell, so dass 

die Frage nach der Faktorenzahl beantwortet ist. In der Praxis lehnt der 
2
-Modellgültigkeitstest oft aber 

auch das Ausgangsmodell (hier: mit zwei Faktoren) ab, obwohl es eine sinnvolle Approximation der Em-

pirie darstellt und von alternativen Modellgütekriterien (vgl. Abschnitt 5.6) günstig bewertet wird. Dann 

kann die Einfaktor-Nullhypothese über einen Vergleich geschachtelter Modelle gemäß Abschnitt 5.5 ge-

prüft werden. Im Angstbeispiel erhalten wir bei einer df-Differenz von Eins eine extreme 
2
-Differenz 

weit oberhalb des kritischen Werts ( 4 bei α = 0,05), so dass die Einfaktor-Nullhypothese abzulehnen ist: 

327,647 - 8,460  = 319,187 
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5 Grundlagen und Vertiefungen zur Strukturgleichungsanalyse 

Bisher wurden die methodischen Grundlagen der Strukturgleichungsanalyse nur sehr zurückhaltend ange-

sprochen, weil die Leser zunächst mit dem Programm Amos und mit typischen Anwendungsbeispielen 

vertraut werden sollten. In diesem Abschnitt wird unter Bezug auf die vorgestellten Beispiele ein vertief-

tes Verständnis für Theorie und Praxis der Strukturgleichungsanalyse vermittelt. 

 

5.1 Einige Grundlagen aus der Wahrscheinlichkeitstheorie 

Eine elementare Annahme der Strukturgleichungsanalyse lautet, dass die Verteilung der beobachteten Vari-

ablen hinreichend gut durch die Momente erster und zweiter Ordnung (d.h. durch Erwartungswerte, 

Varianzen und Kovarianzen) beschrieben werden kann. Diese Annahme ist im Fall multivariater Normal-

verteilung der manifesten Variablen perfekt erfüllt. Vermutlich erinnern Sie sich noch an die Bedeutung des 

Programmnamens Amos: 

Analysis of MOment Structures 

Zur Wiederholung sollen die Definitionen dieser Momente und ihre wichtigsten Eigenschaften notiert 

werden, wobei auf mathematische Exaktheit verzichtet wird. 

 

5.1.1 Erwartungswert 

Der Erwartungswert einer Zufallsvariablen wird in diesem Manuskript selten explizit betrachtet, weil 

durchweg für alle Variablen Zentriertheit (d.h. ein Erwartungswert von Null) angenommen wird. Jedoch 

basieren viele später einzuführende Definitionen auf dem Erwartungswert, so dass unser kleiner Exkurs in 

die mathematische Statistik mit diesem elementaren Begriff beginnen soll. 

Für eine diskrete Zufallsvariable X mit der Verteilung {xi, P(X=xi)}i=1,2,... ist der Erwartungswert definiert 

durch: 

 
i

ii xXxX )P(:)E(  

Für eine stetige (kontinuierliche) Zufallsvariable X mit der Dichte f ist der Erwartungswert definiert durch: 






 dxxfxX )(:)E(  

Offenbar ist die Integralformel die natürliche Verallgemeinerung der Summenformel für den Fall überab-

zählbar unendlich vieler Variablenausprägungen. Mathematisch weniger interessierte Leser brauchen sich 

aber keine Sorgen zu machen: Die Integralrechnung ist für das Verständnis dieses Kurses irrelevant. 

 

5.1.2 Varianz 

Die Varianz einer Zufallsvariablen X ist definiert durch: 

]) E(X)- [(X  E:= Var(X)
2

 

Aus der Definition folgt durch Ausmultiplizieren und wegen der Linearität des Erwartungswertes (d.h.: 

E(aX) = aE(X), a  R; E(X+Y) = E(X) + E(Y)) die so genannte Verschiebungsformel: 

 Var(X) = E(X
2
) - E(X)

2
 

Bei E(X) = 0 gilt also: 

Var(X) = E(X
2
) 
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5.1.3 Kovarianz 

Die Kovarianz der beiden Zufallsvariablen X und Y ist definiert durch: 

 E(Y))]- (Y  E(X))- [(X  E:= Y)Cov(X,  

Aus der Definition folgt (mit denselben Argumenten wie bei der Varianz): 

 Cov(X,Y) = E(XY) - E(X)E(Y), 

so dass bei E(X) = E(Y) = 0 gilt: 

Cov(X,Y) = E(XY). 

Durch Einsetzen von X für Y sieht man außerdem sofort, dass die Varianz der Zufallsvariablen X gerade die 

Kovarianz von X mit sich selber ist. 

 

5.1.4 Kovarianzmatrix eines Zufallsvektors 

Ist X := (X1,X2,..,Xq)
T
, q  N ein Spaltenvektor aus Zufallsvariablen, so wird die Kovarianzmatrix Cov(X) 

von X wie folgt definiert: 

























)Var(.),Cov(),Cov(),Cov(

....

)Var(),Cov(),Cov(

)Var(),Cov(

)Var(

:)Cov(

321

32313

212

1

qqqq XXXXXXX

XXXXX

XXX

X

X  

Die obere Dreiecksmatrix ist dabei aus Symmetriegründen weggelassen. 

 

5.1.5 Korrelation 

Die Korrelation der beiden Zufallsvariablen X und Y ist definiert durch: 

Var(Y) Var(X)

Y)Cov(X,
 := Y)Cor(X,  

Bei standardisierten Variablen (d.h. Var(X) = Var(Y) = 1) gilt also: 

Cor(X,Y) = Cov(X,Y) 

Die Korrelationsmatrix eines Zufallsvektors ist analog zur Kovarianzmatrix definiert. 

 

5.1.6 Kovarianzen von Linearkombinationen aus Zufallsvariablen 

Die Beispiele in den Abschnitten 3 und 4 haben gezeigt, dass in einer Modellgleichung eine abhängige Vari-

able als Linearkombination von unabhängigen Variablen dargestellt wird. Bei der Analyse von Struktur-

gleichungsmodellen (mit oder ohne latente Variablen) spielt die Berechnung der Varianzen und Kovarianzen 

von Linearkombinationen aus den Varianzen und Kovarianzen der Ausgangsvariablen eine zentrale Rolle. 

Für die Kovarianz von X := a1X1 + a2X2 und Y := b1Y1 + b2Y2 gilt: 

 ),Cov(),Cov(),Cov(),Cov(),Cov( 2222121221211111 YXbaYXbaYXbaYXbaYX   (5.1) 

Damit gilt speziell für die Varianz von X: 

)Var(),Cov(2)Var()Var( 2

2

221211

2

1 XaXXaaXaX   
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Für unkorrelierte Ausgangsvariablen X1 und X2 folgt: 

)Var()Var()Var( 2

2

21

2

1 XaXaX   

Eine ausführliche Behandlung der Regeln für das Rechnen mit Kovarianzen findet sich z.B. in Kenny (1979, 

Kap. 2). 

 

5.1.7 Stichprobenschätzer 

Wir haben im aktuellen Abschnitt 5.1 bislang über Populationsparameter gesprochen. In einer konkreten 

Forschungssituation sind natürlich nur Stichprobenschätzer für die Parameter der manifesten Variablen ver-

fügbar. Als Schätzer für den Erwartungswert der Variablen X verwendet man das Stichprobenmittel aus den 

Beobachtungswerten x1, x2,…, xN: 





N

i

ix
N

x
1

1
:  

Die Kovarianz der Variablen X und Y kann erwartungstreu geschätzt werden durch: 








N

i

iiXY yyxx
N

s
1

))((
1

1
:  

Die bei einer Strukturgleichungsanalyse in der Regel bevorzugten Kovarianzschätzer nach dem Maximum 

Likelihood - Prinzip sind allerdings nicht erwartungstreu: 





N

i

iiXY yyxx
N

s
1

))((
1

:  

Alle oben vorgestellten Rechenregeln für Kovarianzen gelten erfreulicherweise uneingeschränkt auch für 

die Stichprobenschätzer. 

Abschließend sollen noch zwei Bezeichnungen eingeführt werden. Für die Kovarianzmatrix des Zufalls-

vektors aus allen manifesten Variablen schreiben wir 

Σ 

Das Ziel einer Kovarianzstrukturanalyse besteht darin, eine möglichst gute Erklärung für diese Matrix Σ 

zu liefern. Bei der Suche nach einem guten Modell spielt die allein verfügbare Matrix mit den Stichpro-

benschätzern für die Varianzen und Kovarianzen der manifesten Variablen eine entscheidende Rolle. Von 

dieser zufallsabhängigen Matrix, die mit 

S 

bezeichnet wird, hängen alle Parameterschätzungen und alle Hypothesentests ab. Daher sollte diese Mat-

rix vor Beginn der Analyse sehr sorgfältig auf mögliche Artefakte, z.B. durch Ausreißer, geprüft werden 

(siehe Abschnitt 2.7.3; vgl. Bollen 1989, S. 24ff). 

 

5.2 Erklärung einer Kovarianzmatrix durch ein Strukturgleichungsmodell 

Mit Hilfe der Rechenregeln für (Ko)varianzen aus Abschnitt 5.1 und der kausalitätstheoretisch begründeten 

Annahmen aus Abschnitt 3.8 kann die Formulierung aus Abschnitt 4, dass bei einer konfirmatorischen Fak-

torenanalyse die (Ko)varianzen zwischen den beobachteten Variablen durch deren Abhängigkeit von den 

latenten Variablen und durch die (Ko)varianzen der latenten Variablen erklärt würden, vollständig nachvoll-

zogen werden. 
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Für die Varianzen und Kovarianzen der manifesten Variablen im Latent-State - Modell für vier Angst-

Indikatoren lässt sich leicht herleiten: 

)Var( + )Var( =

)Var( + ) ,Cov( 2 + )Var( =)Var(

11

11111



X
 

)Var( + )Var( = )Var( 212 X  

)Var( + )Var( = )Var( 323 X  

)Var( + )Var( = )Var( 424 X  

 )Var( =

) ,Cov(  + ) ,Cov( + ) ,Cov( + )Var(  = 

) +  , + Cov( = ),Cov(
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2111211
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), Cov(),Cov( =),Cov( = ),Cov(
21423241 XXXXXX  

)Var( = ),Cov(
243 XX  

Nach einer Gleichheitsrestriktion des betrachteten faktorenanalytischen Modells (vgl. Abschnitt 4) sind 

die Residualvarianzen identisch, und wir schreiben ab jetzt stellvertretend jeweils Var(δ1). Insgesamt im-

pliziert das Modell die folgende Kovarianzmatrix der manifesten Variablen: 



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
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Man kann die Kovarianzmatrix der manifesten Variablen als empirische Gesetzmäßigkeit auffassen, die 

durch die Entwicklung eines faktorenanalytischen Modells erklärt werden soll. Dieses Vorgehen ent-

spricht dem Grundschema des wissenschaftlichen Erklärens, wobei nach Überzeugung der Wissenschafts-

philosophie eine Erklärung mit Hilfe theoretischer Begriffe (latenter Variablen) besonders erfolgverspre-

chend ist. 

Die Darstellung der Kovarianzmatrix Σ der manifesten Variablen als Funktion der Modellparameter ist 

ein wesentliches Merkmal der Kovarianzstrukturanalyse. Neben den Pfad- bzw. Strukturkoeffizienten 

werden für diese Darstellung auch alle Varianzen und Kovarianzen der Quellvariablen (exogenen Variab-

len und Residualvariablen) benötigt. Der Vektor aller Modellparameter in diesem Sinn wird meist mit θ 

bezeichnet (sprich: Theta). Im faktorenanalytischen Beispiel haben wir nach Auswertung der Modellglei-

chungen, Restriktionen und Identifikationsüberlegungen folgenden Vektor erhalten: 

 θ = (Var(1), Var(2), Cov(1, 2), Var(1)) 

Er enthält alle freien Parameter sowie einen Repräsentanten für die Gruppe gleich gesetzter Parameter. 

Die Darstellung der Kovarianzmatrix Σ als Funktion dieses Parametervektors ist von der allgemeinen 

Gestalt: 
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 Σ = f(θ) (5.2) 

Eine solche Darstellung werden wir später gelegentlich als die Fundamentalhypothese des jeweiligen 

Modells bezeichnen. 

Weil die Elemente in der Kovarianzmatrix der latenten Variablen anschließend noch mehrmals in Formel 

auftauchen, verwenden wir die folgende, zusammen mit dem Computerprogramm LISREL (siehe z.B. 

Jöreskog & Sörbom 1989) eingeführte Symbolik: 
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Wird außerdem für Var(1) das Symbol 2

  verwendet, lässt sich der Parametervektor sehr kompakt schrei-

ben 

θ = ),,,( 2

212211   

 

5.3 Identifikation der Parameter 

Wir haben im letzten Abschnitt gesehen, wie die Kovarianzmatrix Σ der manifesten Variablen als Funktion 

des Parametervektors θ ausgedrückt werden kann. Nun sind allerdings die Parameter unbekannt und wir 

möchten Informationen über sie aus den Daten gewinnen. Andererseits können wir die Varianzen und Kova-

rianzen der manifesten Variablen immerhin anhand der Stichprobe schätzen. Wenn es gelingt, die Gleichung  

Σ = f(θ) 

nach den unbekannten Parametern aufzulösen, kann man Σ durch die Matrix S der Stichprobenstatistiken 

ersetzten und Schätzer für die gesuchten Parameter berechnen. 

Ein Parameter θv heißt identifiziert, wenn für ihn das Auflösen gelingt, d.h. wenn er auf mindestens eine 

Weise als Funktion gv der Elemente von Σ dargestellt werden kann: 

 θv = gv(Σ) 

Ein Modell heißt identifiziert, wenn alle Parameter des Modells identifiziert sind. 

Es gibt leider keine notwendige und hinreichende Bedingung für die Identifikation eines beliebigen 

Strukturgleichungsmodells. Allerdings sind für einige spezielle Modelle nützliche Identifikationsregeln 

bekannt: 

 Rekursive Modelle für manifeste Variablen sind stets identifiziert (Kline 2005, S. 107). 

 Bei einer Standard-CFA (vgl. Abschnitt 4) gelten für die Identifikation die folgenden hinreichen-

den Bedingungen (Kline 2005, S. 172): 

o Ein Modell der Standard CFA ist identifiziert, wenn jedem Faktor mindestens drei Indika-

toren zugeordnet sind. 

o Bei einem Modell mit zwei oder mehr Faktoren genügen zwei Indikatoren pro Faktor. 

Nach diesen Regeln ist das aktuell betrachtete Latent-State - Modell für vier Angst-Indikatoren identifi-

ziert. Bei diesem Modell kann es allerdings zu einem so genannten empirischen Identifikationsproblem 

kommen, wenn die Korrelation zwischen den Faktoren gleich Null wird. Dann liegen nämlich zwei sepa-

rate Teilmodelle vor, die jeweils einen Faktor und zwei Indikatoren enthalten, also nach obigen Regeln 

nicht identifiziert sind. 

Prinzipiell muss zum Nachweis der Identifikation eines konkreten Modells für jeden Parameter seine Dar-

stellbarkeit durch die Varianzen und Kovarianzen der manifesten Variablen gezeigt werden. Wichtige 
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Hilfsmittel bei diesem Nachweis sind die in Abschnitt 5.1 eingeführten Rechenregeln für Kovarianzen. 

Die Vorgehensweise soll beim aktuellen Beispiel vorgeführt werden, obwohl seine Identifikation bereits 

sichergestellt ist. Wir setzen die Kovarianzmatrix Cov(X) gleich der Modellimplikation f(θ): 
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Es sind zehn Gleichungen nach den vier Unbekannten in 

θ = ),,,( 2

212211   

aufzulösen. Wir erhalten mühelos: 
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Damit steht also einer Schätzung der Parameter prinzipiell nichts mehr im Weg. 

Bei genauerem Hinsehen fällt auf, dass unser System sogar noch sechs weitere Bestimmungsgleichungen 

für Parameter liefert: 
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Für 21  und 2

  haben wir jeweils mehrere Bestimmungsgleichungen zur Verfügung. Parameter mit dieser 

Eigenschaft werden als überidentifiziert oder überbestimmt bezeichnet. Ein Modell wird so genannt, 

wenn es identifiziert ist und mindestens einen überidentifizierten Parameter enthält. 

Bei einem überidentifizierten Modell ist die Anzahl t der Parameter kleiner als die Anzahl nicht-redun-

danter Elemente in der zu erklärenden Kovarianzmatrix und damit genügen diese Modelle dem wissen-

schaftstheoretischen Gebot der Sparsamkeit. Die Überbestimmtheit hat zwei Konsequenzen, die in späte-

ren Abschnitten noch genauer beleuchtet werden: 

 Verschiedene Bestimmungsgleichungen für einen Parameter liefern zufallsbedingt im Allgemeinen 

auch dann unterschiedliche Ergebnisse, wenn das Strukturgleichungsmodell stimmt. Zu eindeutigen 

Schätzern gelangt man durch folgendes Minimierungsprinzip: Man wählt den Vektor θ̂  der geschätz-

ten Parameter so, dass der „Abstand“ zwischen der Stichprobenkovarianzmatrix S und der durch das 

Modell postulierten Kovarianzmatrix )ˆ(θf möglichst klein wird. Der Abstandsbegriff wird in Ab-

schnitt 5.4 über Parameterschätzung präzisiert. 

 Das Strukturgleichungsmodell impliziert für die Kovarianzmatrix der manifesten Variablen Restriktio-

nen, die empirisch falsch sein können. Unter der Annahme multivariater Normalverteilung der mani-

festen Variablen erlaubt dies eine inferenzstatistische Beurteilung des Modells. Damit genügen über-

bestimmte Modelle der wissenschaftsphilosophischen Forderung nach Falsifizierbarkeit. 
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Ein Strukturgleichungsmodell heißt genau identifiziert oder saturiert, wenn alle Parameter identifiziert 

sind und kein Parameter überidentifiziert ist, d.h. wenn genau ein Lösungsvektor θ̂  für die Gleichung 

(5.2) existiert. Für den Schätzer gilt dann: 

 S = f ( θ̂ ), 

d.h. die Stichprobenkovarianzmatrix S kann exakt reproduziert werden. Dies ist häufig der Fall, wenn die 

Anzahl t der Parameter in θ identisch ist mit der Anzahl nicht-redundanter Elemente in S. Letztere Anzahl 

beträgt bei k manifesten Variablen ½k(k+1). Genau identifizierte Modelle sind nicht prüfbar. Sofern sie 

stimmen, können sie aber trotzdem sinnvoll sein, weil sie immerhin die Schätzung und (bei multivariater 

Normalverteilung der manifesten Variablen) die Testung der einzelnen Parameter erlauben. 

Eine notwendige (aber nicht hinreichende!) Bedingung für die Identifikation eines Modells lautet 

 t  ½k(k+1)  (5.3) 

Bei einem nicht-identifizierten (unterbestimmten) Modell existieren unendlich viele verschiedene Vek-

toren θ
*
  IR

t
, welche dieselbe Kovarianzmatrix f(θ

*
) liefern und damit natürlich auch denselben Abstand 

zu einer Stichprobenkovarianzmatrix S. Bei der Parameterschätzung nach der oben erwähnten Abstand-

Minimierungsmethode muss daher die iterative Suche nach dem globalen Minimum scheitern. 

Wie Sie bereits wissen, wird auch bei der obligatorischen Definition einer Maßeinheit für jede latente 

Variable eines Strukturgleichungsmodells ein Identifikationsproblem gelöst (siehe Abschnitt 3.4). Dies 

soll im Zusammenhang mit dem Latent-State - Modell der Angst noch einmal erläutert werden. Nimmt 

man hier einen freien Parameter λ für die (als gleich angenommenen) Ladungen auf an Stelle der Fixie-

rung auf Eins, so sind λ, 11, 21 und 22 nicht identifiziert, obwohl fünf Parametern zehn Varianzen bzw. 

Kovarianzen gegenüberstehen, denn die Parametervektoren 
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22  

liefern dieselbe Kovarianzmatrix. Der Parameter 2

  ist hingegen nach wie vor überbestimmt. Dieses Bei-

spiel zeigt, dass ein Modell sowohl identifizierte als auch nicht-identifizierte Parameter enthalten kann und 

dass eine erfüllte Ungleichung (5.3) keine Gewähr für die Identifikation bietet. 

Amos entdeckt in vielen Fällen Identifikationsprobleme und gibt entsprechende Warnungen aus. Es ist 

jedoch anzustreben, die Identifikation eines Modells vor dem Einsatz von Amos abzuklären. 

Kline (2005, S. 213) empfiehlt in Anlehnung an Bollen (19989), bei einem beliebigen Modell mit latenten 

Variablen die Identifikation separat für das Strukturmodell und das Messmodell (mit freien Beziehungen 

zwischen den latenten Variablen) zu prüfen. Sind beide Partialmodelle separat identifiziert, so ist die 

Identifikation auch für das Gesamtmodell gegeben. Gerade wurde eine hinreichende Bedingung genannt, 

die aber nicht notwendig ist. Ein Gesamtmodell kann also durchaus identifiziert sein, obwohl nicht beide 

Partialmodelle identifiziert sind. 

In vielen Fällen kann man eine der Identifikationsregeln aus Bollen (1989) verwenden (siehe oben). Ist 

dies nicht möglich, so kontrolliere man zunächst die notwendige Bedingung (5.3). Ist sie erfüllt, versuche 

man, mit Hilfe der Rechenregeln für Kovarianzen das Gleichungssystem (5.2) nach den Parametern auf-

zulösen. Bei komplexen Modellen ist diese Aufgabe allerdings kaum zu bewältigen. Etwas leichter zu 

analysieren sind (siehe Kline 2005, S. 240): 

 die notwendige Ordnungsbedingung 

 die hinreichende Rangbedingung 

Oft bleibt nichts anderes übrig, als eine Lösung empirisch auf Eindeutigkeit zu prüfen (Kline 2005, 

S.173).  
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5.4 Schätzung der Parameter durch Minimierung einer Fit-Funktion 

Das Schätzen der Parameter setzt die Identifikation des Modells voraus. Dann gilt für je zwei verschiedene 

Parametervektoren θ und θ, dass sie verschiedene Kovarianzmatrizen implizieren, d.h. f(θ)  f(θ). Daher 

kann ein Schätzer θ̂  nach folgendem Prinzip ermittelt werden: 

 Bestimme θ̂  so, dass der Abstand zwischen der Stichprobenkovarianzmatrix S und der von θ̂  im-

plizierten Kovarianzmatrix f( θ̂ ) minimal wird.  

Weil bei den folgenden Darstellungen mehrere Thetas auftreten, soll deren Bedeutung vorab klargestellt 

werden: 

 θ Der gesuchte Vektor der wahren Parameter. Dies ist ein festes Element aus dem IR
t
. 

 θ̂  Stichproben-Schätzer für θ 

 θ
*
 Beliebiges Element aus der Menge aller potentiellen Parametervektoren. (Dies ist eine geeignet ein-

geschränkte Teilmenge des IR
t
.) θ

*
 ist also ein Platzhalter, der beliebige Werte aus einer sehr großen 

Menge von Vektoren annehmen kann, während θ ein Vektor aus festen (aber unbekannten) Zahlen 

ist. 

Für ein beliebiges θ
*
 soll f(θ

*
) im Folgenden durch Σ

*
 abgekürzt werden. 

Aus dem dargestellten Grundprinzip wurden durch Definition einer speziellen Fit-Funktion 

F(S, Σ
*
) 

zur Messung des Abstands zwischen S und Σ
*
 mehrere konkrete Schätzverfahren entwickelt. F ist dabei 

eine nicht-negative Funktion der Komponenten von θ
*
, die nur bei perfektem Fit (Σ

*
 = S) den Wert Null 

annimmt. Sie ist im Allgemeinen nicht linear und so kompliziert, dass ihre Minimierung ein iteratives 

Verfahren erfordert. Dabei müht sich der Computer schrittweise durch einen oft sehr hochdimensionalen 

Parameterraum und sucht nach dem tiefsten Tal in der Funktionsoberfläche. Anschließend werden exemp-

larisch zwei Schätzverfahren betrachtet: 

 Unweighted Least Squares (ULS) 

Es eignet sich aufgrund seiner Einfachheit zur Veranschaulichung der grundsätzlichen Arbeitsweise, 

ist aber in der Forschungspraxis selten die beste Wahl. 

 Maximum Likelihood (ML) 

Dieses Verfahren dominiert in der Praxis der Strukturgleichungsanalyse und ist in Amos voreinge-

stellt. 

 

5.4.1 Unweighted Least Squares (ULS) 

Bei der Parameterschätzung nach dem ULS-Verfahren wird die folgende Fit-Funktion minimiert: 

FULS(S, Σ
*
) := ½ tr[(S - Σ

*
)
T
(S - Σ

*
)] 

Mit tr wird dabei eine Funktion bezeichnet, die für eine quadratische Matrix die Summe ihrer Hauptdia-

gonalelemente liefert. FULS(S, Σ
*
) ist nichts anderes als die Summe aller quadrierten Differenzen zwischen 

korrespondierenden Elementen aus S und Σ
*
. FULS(S, Σ

*
) wird offensichtlich umso kleiner, je ähnlicher sich 

S und Σ
*
 werden. 

Beispiel: Bei 
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ergibt sich 

FULS(S, Σ
*
) = ½ (0.1

2
 + 0.1

2
 + 0.1

2
 + 0.2

2
) = 0.035. 

Für die bei Minimierung von FULS(S,Σ
*
) resultierenden Schätzer spricht, dass sie ohne Voraussetzungen 

über die Verteilung der manifesten Variablen konsistent sind, d.h. (N = Stichprobenumfang): 

  00ˆP
lim

 >     =  > -  
  N

N 


 

Die Parameter im Vektor  werden also asymptotisch richtig geschätzt. Die Konsistenz-Eigenschaft besitzen 

auch alle anderen von Amos berechneten Schätzer. 

Nachteile der ULS-Schätzmethode: 

i) Unter der klassischen Annahme multivariater Normalität der gemeinsamen Verteilung aller manifesten 

Variablen ist die ULS-Schätzmethode der GLS- und der ML-Schätzmethode unterlegen. 

ii) Die Fit-Funktion FULS ist nicht skaleninvariant. 

Zur Erläuterung dieser Aussage sind einige Definitionen erforderlich (vgl. Jöreskog & Sörbom 1989, Ab-

schnitt 1.20): 

 Ein Strukturgleichungsmodell mit der Fundamental-Hypothese Σ = f() heißt skaleninvariant, wenn 

für jede Diagonalmatrix D mit positiven Einträgen und für jeden Parametervektor  ein anderer Pa-

rametervektor Dθ existiert mit: 

DfDf D )()( θθ   

Die Matrix D enthält Skalenfaktoren für die manifesten Variablen. Sie bewirkt also Wechsel der 

Maßeinheiten (z.B. Gewichtsmessung in Gramm statt Kilogramm). Trägt man in die Hauptdiagonale 

von D die Kehrwerte der Standardabweichungen der manifesten Variablen ein, so ist D S D eine 

Korrelationsmatrix. 

 Eine Fit-Funktion F(S, Σ
*
) heißt skaleninvariant, wenn für jede Diagonalmatrix D mit positiven Ein-

trägen gilt: 

) ,() ,( **
ΣSDΣDDSD FF   

 Eine Schätzmethode heißt skaleninvariant, wenn sie auf einer skaleninvarianten Fit-Funktion basiert.  

Eine skaleninvariante Schätzmethode verhält sich „vernünftig“, wenn bei der Analyse eines skalen-

invarianten Modells Maßeinheiten für manifeste Variablen verändert werden, d.h. wenn statt S die 

Matrix D S D verwendet wird. In diesem Fall implizieren die neuen Parameterschätzungen in Dθ̂  die 

Kovarianzmatrix DfD )ˆ(θ . Die neuen Schätzungen in Dθ̂  ergeben sich also durch Berück-

sichtigung der Maßstabsänderungen unmittelbar aus den alten Schätzungen in θ̂  (Jöreskog & Sör-

bom 1989). 

Die Fit-Funktion FULS ist nicht skaleninvariant, und daher können durch Skalenfaktoren bei den ULS-

Schätzungen Veränderungen auftreten, die nicht verträglich sind mit den Maßstabsänderungen. Weil der 

Maßstab sozialwissenschaftlicher Indikatoren meist willkürlich ist, wird daher oft empfohlen, ULS-Schätzer 

aus der Korrelationsmatrix statt aus der Kovarianzmatrix zu bestimmen (vgl. Long, 1983). 
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5.4.2 Maximum Likelihood (ML) 

Die ML-Methode setzt voraus, dass die k manifesten Variablen multivariat normalverteilt sind. Unter dieser 

Voraussetzung hat Wishart (1928) die Wahrscheinlichkeitsdichte W(S; Σ, N-1) für eine Stichproben-

kovarianzmatrix S bei unabhängiger Ziehung von N Fällen aus einer Population mit Kovarianzmatrix Σ her-

geleitet. Das Maß für die Ähnlichkeit von S und Σ
*
 bzw. für den Fit eines potentiellen Parametervektors 

*
 

basiert auf dem Quotienten aus der Wahrscheinlichkeitsdichte von S bei Annahme von Σ = Σ
*
 und der 

Wahrscheinlichkeitsdichte von S bei Annahme von Σ = S: 

    | - k|| - | +  N- - = 
1-N

1-N
*
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SS
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Dabei wird vorausgesetzt, dass die Determinanten │S│ und │Σ
*
│ positiv sind. Der Likelihood-Quotient 

zeigt an, inwiefern die Likelihood von S unter Annahme von Σ
*
 schlechter ist als die maximal mögliche 

Likelihood und kann folglich zwischen 0 und 1 variieren. Der logarithmierte Quotient nimmt daher Werte 

von - bis 0 an und erreicht seinen maximalen Wert 0 genau dann, wenn Σ
*
 = S. Statt diesen Ausdruck zu 

maximieren kann man wegen des negativen Vorzeichens auch den Ausdruck in eckigen Klammern minimie-

ren. So ergibt sich die folgende Fit-Funktion: 

  | - k|| - | + F SΣSΣΣS * loglog tr= ),( 1**
ML

  

FML(S, Σ
*
) wird genau dann minimal, wenn der Zähler des Likelihood-Quotienten die maximale Likelihood 

der beobachteten Kovarianzmatrix S bei Gültigkeit des behaupteten Strukturgleichungsmodells, d.h. unter 

den Restriktionen, die das Modell für die Kovarianzmatrix der manifesten Variablen impliziert, annimmt. 

Dadurch ist der Name Maximum-Likelihood - Schätzer begründet. 

Im Nenner des Likelihood-Quotienten steht die maximale Likelihood von S in einem Normalver-

teilungsmodell mit beliebiger, d.h. unrestringierter, Kovarianzmatrix. Er bleibt während der Minimie-

rungsprozedur konstant und ist daher für die Schätzung irrelevant. Zur Testung des Modells ist jedoch der 

komplette Likelihood-Quotient wesentlich (siehe unten). 

Der ML-Schätzer hat bei multivariater Normalverteilung der manifesten Variablen und Gültigkeit 

des Modells über die auch beim ULS-Schätzer vorhandene Konsistenz (siehe Abschnitt 5.4.1) hinaus 

zahlreiche günstige Eigenschaften: 

i) Er ist asymptotisch erwartungstreu, d.h.: 

  θθ  =  
  N

N
ˆE

lim


 

ii) Er ist asymptotisch effizient, d.h. mit wachsendem N wird seine Varianz, also sein Fehler, kleiner 

oder gleich der Varianz jedes beliebigen anderen Schätzers. 

iii) Seine Verteilung konvergiert mit wachsendem N gegen eine Normalverteilung, d.h. die Stich-

probenschätzer i̂ sind asymptotisch normalverteilt um den Erwartungswert θi. Man kann ferner eine 

Schätzung für den asymptotischen Standardfehler SE( i̂ ) des Schätzers i̂  berechnen. Das erlaubt die 

Konstruktion von Vertrauensintervallen und über die folgende, von Amos als CR (Critical Ratio) be-

zeichnete Prüfgröße 

)ˆ(SE

ˆ
 := )ˆCR(

i

i
i




  
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einen (zweiseitigen) Test der Nullhypothese: 

 0:H0 i

i  

Der Test zum Niveau α = 0,05 verwirft seine Nullhypothese, wenn )ˆCR( i  größer ist als das 97.5% - Frak-

til der Standardnormalverteilung ( 2). Man kann auch allgemeiner die Hypothese: 

ci

i :H0  

prüfen, wobei c eine geeignete Konstante ist. Diese Nullhypothese ist in einem Test zum Niveau α = 0,05 zu 

verwerfen, wenn das 95% - Vertrauensinervall zu i̂  den Punkt c nicht enthält. 

iv) Die zur ML-Schätzung verwendete Fit-Funktion FML erlaubt einen globalen Modelltest, d.h. eine 

Prüfung der Nullhypothese, dass die Populationskovarianzmatrix von der Form ist, die das Modell impli-

ziert, gegen die Alternativhypothese, dass sie den vom Modell auferlegten Restriktionen nicht genügt. 

Wie eben zu sehen war, ist die Fit-Funktion FML(S, Σ
*
) bis auf den Vorfaktor ½(N-1) mit dem logarith-

mierten Likelihood-Quotienten: 








 

1)-NS,(S;

1)-N,(S;
 2-

W

W
log

*

 

identisch. Nach einer allgemeinen Theorie der mathematischen Statistik ist das Minimum dieses logarith-

mierten Likelihood-Quotienten bei Gültigkeit des Modells asymptotisch (d.h. für N  ) χ
2
-verteilt mit 

 df = ½k(k+1) - t 

Freiheitsgraden, wobei wiederum k die Anzahl der manifesten Variablen und t die Anzahl der freien Parame-

ter im Modell bedeutet. Damit erlaubt also die folgende Prüfgröße ( Σ̂  sei die vom geschätzten Parameter-

vektor implizierte Kovarianzmatrix): 

 χ
2
 := (N-1)FML(S, Σ̂ ) 

eine Prüfung der Nullhypothese, dass die Populationskovarianzmatrix von der Form ist, die das Modell im-

pliziert, gegen die Alternativhypothese, dass sie den vom Modell auferlegten Restriktionen nicht genügt. 

Amos berechnet die χ
2
-Statistik und gibt die approximative Wahrscheinlichkeit für das Auftreten eines 

gleich großen oder größeren χ
2
-Wertes bei Gültigkeit des Modells an. 

Es soll an dieser Stelle daran erinnert werden, dass ein χ
2
-Modelltest basierend auf der ML-Fitfunktion 

nur unter folgenden Voraussetzungen gültig ist (vgl. Abschnitt 2.7): 

 Die manifesten Variablen sind multivariat normalverteilt. 

Bei manifesten exogenen Variablen kann auf diese Voraussetzung verzichtet werden. 

 Die Stichprobe ist hinreichend groß. 

Auch die Schätzmethoden GLS und ADF ermöglichen einen globalen Modellgültigkeitstest. Bei Verwen-

dung der ADF-Schätzmethode kann auf die Normalitätsvoraussetzung verzichtet werden. Allerdings ist ein 

erheblich größerer Stichprobenumfang erforderlich. 

v) Die ML-Fitfunktion ist skaleninvariant.  

Sofern das untersuchte Modell seinerseits skaleninvariant ist, bleiben die ML-Schätzergebnisse im wesentli-

chen invariant bei Veränderung der Maßeinheiten von manifesten Variablen (vgl. Abschnitt 5.4.1). Während 

der globale Modelltest, die CR-Werte (siehe oben) und die Modifikationsindikatoren (vgl. Abschnitt 7.1) 

unverändert bleiben, werden die Parameterschätzer an die veränderten Maßeinheiten der manifesten Variab-

len angepasst (siehe Jöreskog & Sörbom 1989). 
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Der entscheidende Nachteil des ML-Schätzers ist die starke Voraussetzung der multivariaten Normalver-

teilung der manifesten Variablen. Allerdings wurde inzwischen gezeigt, dass diese Voraussetzung libera-

lisiert werden kann (vgl. Bollen 1989, S. 114), und in Simulationsstudien hat sich der ML-Schätzer als 

robust gegen mäßige Verletzungen der Normalität erwiesen. Die ML-Schätzmethode sollte jedoch in fol-

genden Fällen nicht verwendet werden: 

 Die Verteilung der manifesten Variablen weicht erheblich von der Normalverteilung ab. 

 Einige der manifesten Variablen sind ordinalskaliert, d.h. sie können nur wenige verschiedene, mo-

noton geordnete Werte annehmen. 

Eine besondere Attraktion der in Amos realisierten Schätzmethode Full Information Maximum Like-

lihood (FIML) besteht darin, dass bei Datensätzen mit fehlender Werten alle vorhandenen Informationen 

genutzt werden, ohne fehlende Werte durch Imputationen ersetzen zu müssen. Man erhält konsistente 

Schätzung und korrekte Standardfehler unter der relativ liberalen MAR-Bedingung (Missing At Random) 

(siehe z.B. Baltes-Götz 2008a). 

 

5.4.3 Hinweise zur praktischen Anwendung der Schätzverfahren 

Für alle iterativen Schätzverfahren gelten folgende Anmerkungen zu möglichen Anwendungsproblemen: 

i) Wenn das Iterationsverfahren nicht konvergiert oder ein Minimum außerhalb des zulässigen Parame-

terraumes auftritt (z.B. negativer Varianzschätzer, so genannte Heywood-Cases) kommen vor allem fol-

gende Ursachen in Frage: 

 Das Modell ist nicht identifiziert. 

 Bei einer konfirmatorischen Faktorenanalyse neigen Modelle mit lediglich zwei Indikatoren pro Fak-

tor trotz Identifikation (vgl. Abschnitt 5.3) zu Schätzproblemen (Kline 2005, S. 178). 

 Das Modell passt sehr schlecht zu den Daten. 

Ein schlechter Fit kann auch durch zu geringe Stichprobengröße entstehen (siehe Abschnitt 2.7). 

 Die Daten sind schlecht konditioniert, z.B. bei einer Kovarianzmatrix mit stark mit stark unterschied-

lichen Varianzen (vgl. Kline 2005, S.113). 

ii) Es kann passieren, dass der Algorithmus in einem lokalen Minimum landet, das kein globales Mini-

mum ist. Dies wird in folgender Abbildung für den einfachen Spezialfall eines einparametrischen Modells 

demonstriert. 

 

Globales Minimum 

Lokales Minimum 
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Gegen diese Gefahr, die sich in Simulationsstudien allerdings als relativ gering erwiesen hat, kann man sich 

durch mehrfache Schätzversuche ausgehend von verschiedenen Startwerten absichern. Um mit der graphi-

schen Benutzerschnittstelle von Amos für einen Parameter einen expliziten Startwert als Alternative zur 

automatischen Wahl durch Amos zu vereinbaren, benennt man den Parameter und setzt hinter den Namen 

durch Doppelpunkt abgetrennt den gewünschten Startwert, z.B. 

 

 

5.5 Flexible Hypothesentests durch den Vergleich von geschachtelten Modellen 

Mu sei ein gültiges Strukturgleichungsmodell mit dem Parametervektor θu und dfu Freiheitsgraden. Im Am-

bitionsmodell mit Fehlerkovarianz (vgl. Abschnitt 3.7) enthält θu die Elemente 

θu = (γ11, γ12, γ21, γ22, Var(RS), Var(RA), Cov(RS, RA)) 

Eine prüfbare Nullhypothese H0 kann aus konjunktiv verknüpften Teilhypothesen i

0H  bestehen, die jeweils 

eine von der beiden folgenden Behauptungen aufstellen: 

 Gewisse Komponenten von θu sind gleich bestimmten Zahlen (Fixierung). 

 Gewisse Komponenten von θu sind untereinander gleich (Gleichheitsrestriktion). 

H0 führt zu einem Modell Me mit dfe > dfu Freiheitsgraden. Wesentlich ist, dass Me (eingeschränktes Modell) 

durch zusätzliche Forderungen aus Mu (uneingeschränktes Modell) entsteht. Man sagt auch, Me sei in Mu ge-

schachtelt. Ist 2

u  die χ
2
-Fitstatistik für Mu und 2

e  die χ
2
-Fitstatistik für Me, dann ist: 

D
2
 := 2

e  - 2

u  

unter der Nullhypothese H0 approximativ χ
2
-verteilt mit 

d := dfe - dfu 

Freiheitsgraden. Folglich ist die H0 bei einem Test zum Niveau α genau dann abzulehnen, wenn D
2
 größer 

als das (1-α) - Fraktil der χ
2
-Verteilung mit d Freiheitsgraden ist. 

Die Voraussetzungen für den D
2
-Test bei Verwendung der ML- oder GLS-Schätzmethode: 
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 Die manifesten Variablen sind multivariat normalverteilt (siehe Abschnitt 2.7.2). 

 Das Modell Mu ist gültig. 

 Die Stichprobe ist hinreichend groß (siehe Abschnitt 2.7.1). 

Wie man leicht einsehen wird, ist z.B. auch der normale χ
2
-Modelltest ein Spezialfall für das D

2
-Prinzip. 

Das uneingeschränkte Modell erlaubt in diesem Fall für jede empirische Kovarianz einen eigenen Parameter 

und hat daher Null Freiheitsgrade. 

Für einen D
2
-Test zwei Modelle spezifizieren und ihre Ergebnisse vergleichen zu müssen, ist auf Dauer 

etwas mühsam. Erfreulicherweise unterstützt Amos den Anwender beim Vergleich von Modellen samt 

D
2
-Test. Nach 

Analyze > Manage Models 

erscheint die Dialogbox Manage Models: 

 

Hier legen wir mit New ein zusätzliches, eingeschränktes Modell (Me) an, das sich durch Parameterrest-

riktionen aus dem Standardmodell (Mu) ergeben muss. In unserem Ambitionsbeispiel setzen wir die Feh-

lerkovarianz auf Null, wobei endlich die in Abschnitt 3.7 vereinbarte Bezeichnung rc zum Einsatz 

kommt: 

 

Die von Amos vorgegebene Modellbezeichnung kann beliebig geändert werden. 

Nach der nächsten Schätzung mit  können wir per Mausklick auf die Modellbezeichnung zwischen 

zwei Ausgabe-Pfaddiagrammen wählen und die jeweiligen Parameterschätzungen vergleichen: 

 

Hier ist das Pfadmodell (mit unkorrelierten Residuen) zu sehen: 
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Die Textausgabe beschreibt beide Modelle und liefert den D
2
-Test (siehe Abschnitt Model Compari-

son): 

Nested Model Comparisons 

Assuming model Default model to be correct: 

Model DF CMIN P 
NFI 

Delta-1 

 

IFI 

Delta-2 

 

RFI 

rho-1 

 

TLI 

rho2 

 Unabhäng. Residuen 1 3,399 ,065 ,003 ,003 ,007 ,007 
 

Im unserem Beispiel setzt der D
2
-Test die Gültigkeit des Modells mit frei schätzbarer Fehlerkovarianz 

voraus und prüft, ob das restringierte Modell (mit der auf Null fixierten Fehlerkovarianz) beibehalten 

werden kann. Er endet wie der verwandte CR-Test (siehe Abschnitt 3.7) mit einer knappen Entscheidung 

für die Nullhypothese (p = 0,065). 

Die mit CMIN überschriebene Tabelle im Abschnitt Model Fit 

CMIN 

Model NPAR CMIN DF P CMIN/DF 

Default model 13 2,596 2 ,273 1,298 

Unabhäng. Residuen 12 5,995 3 ,112 1,998 

Saturated model 15 ,000 0   

Independence model 5 1008,354 10 ,000 100,835 
 

liefert auch für Me den 
2
-Gültigkeitstest, der mit p = 0,112 das sparsame und damit zu bevorzugende 

Modell akzeptiert. 

 

5.6 Gütekriterien zur Modellbeurteilung 

In diesem Abschnitt werden einige Gütekriterien vorgestellt, welche die bisher ausschließlich betrachtete 

Prüfgröße des 
2
-Gültigkeitstests (samt Überschreitungswahrscheinlichkeit) bei der Modellbeurteilung 

wesentlich ergänzen können. 

Bei den folgenden Ausführungen verwenden wir einige Bezeichnungen aus der Amos-Ausgabe: 
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 CMIN, P 

Prüfgröße des 
2
-Modellgültigkeitstests mit der zugehörigen Überschreitungswahrscheinlichkeit P 

 NPAR 

Anzahl der frei schätzbaren Parameter 

 N 

Stichprobengröße 

 DF 

Anzahl der Freiheitsgrade ( = Anzahl der Stichprobenmomente – NPAR) 

Praktisch alle Kriterien sind als Abweichungsindikatoren konzipiert, fallen also mit zunehmender Mo-

dellgüte kleiner aus. 

 

5.6.1 CMIN und die zugehörige Überschreitungswahrscheinlichkeit P 

In die Prüfgröße CMIN des 
2
-Modellgültigkeitstests gehen ein: 

 Die minimale Diskrepanz FMIN zwischen der Stichproben-Momentenmatrix und der vom ge-

schätzten Modell implizierten Momentenmatrix, wobei die Diskrepanzdefinition von der Schätz-

methode abhängt 

 Die um Eins verminderte Stichprobengröße N 

Speziell die starke Abhängigkeit von N beeinträchtigt die Nützlichkeit der Prüfgröße CMIN (und der zu-

gehörigen Überschreitungswahrscheinlichkeit P) zur Modellbeurteilung bei größeren Stichproben: 

CMIN := (N – 1)  FMIN 

Bei gleicher Stichproben-Momentenmatrix und gleichem Modell führt ein doppelt so großes N zu einer un-

gefähr doppelt so großen CMIN-Statistik. Bei Gültigkeit des Modells ist dies eine sinnvolle Normierung, 

weil bei wachsendem N eine immer besserer Fit von Modell und Daten zu erwarten ist. Ist das Modell je-

doch streng genommen falsch, was in den Sozial- und Wirtschaftswissenschaften als sicher angenommen 

werden kann, so konvergiert die Diskrepanz FMIN bei wachsendem N nicht gegen Null, und CMIN steigt 

drastisch an. Die Power des χ
2
-Tests zur Aufdeckung der als sicher anzunehmenden Modelldefekte steigt 

mit dem Stichprobenumfang. Damit geht auch für ein „gut passendes“ Modell die Wahrscheinlichkeit gegen 

Eins, dass es verworfen wird. 

 

5.6.2 Relation aus CMIN und DF 

Bei den Schätzmethoden mit approximativer 2

df -Verteilung der CMIN-Statistik (ML, GLS, ADF) ist für 

gültige Modelle ein Quotient 

DF

CMIN
 

nahe Eins zu erwarten. Empfehlungen zur Obergrenze für akzeptable Modelle schwanken zwischen 2 und 

5 (Kline 2005, S. 137). 

 

5.6.3 Root Mean Square Error of Approximation (RMSEA) 

Als F0 bezeichnet Amos die folgende Schätzung der Diskrepanz zwischen der Populations-Momenten-

matrix und der Modellimplikation: 
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











 0,

1
max:

N

DFCMIN
F0  

Während das F0-Kriterium keine Belohnung für sparsame Modelle (mit vielen Freiheitsgraden) enthält, 

ist diese im RMSEA-Maß (Root Mean Square Error of Approximation) enthalten: 

DF

F0
RMSEA :  

Amos liefert unter der Bezeichnung LO90 bzw. HI90 auch eine untere bzw. obere Schranke für das 90% 

- Vertrauensintervall zum RMSEA-Wert. 

Browne & Cudeck (1993, S. 136ff) geben zum RMSEA-Maß folgende Bewertungshinweise: 

RMSEA  0,05 gut 

0,05 < RMSEA  0,08 akzeptabel 

RMSEA > 0,08 inakzeptabel 

Andere Autoren sehen die Grenze für akzeptable Modelle bei 0,10 (siehe Loehlin 2004, S. 69). 

Amos liefert unter der Bezeichnung PCLOSE eine Größe, die tendenziell als Überschreitungswahr-

scheinlichkeit zur folgenden Close-Fit - Nullhypothese interpretiert werden kann: 

c

0H : RMSEA  0,05 

Diese Nullhypothese geringfügiger Anpassungsfehler ist zur Modellbeurteilung erheblich relevanter als 

die Nullhypothese der perfekten Modellgültigkeit, die im klassischen 
2
-Anpassungstest begutachtet wird. 

Kann diese Close-Fit - Nullhypothese nicht verworfen ist, ist sie aber keinesfalls bewiesen. Speziell bei 

Modellen mit wenigen Freiheitsgraden hat der Test zur Close-Fit – Nullhypothese oft eine geringe Power 

(Kline 2005, S. 158). Von großer Relevanz für die Modellbeurteilung ist daher ein Test zur folgendem 

Poor-Fit - Nullhypothese, die ein inakzeptables Modell behauptet: 

p

0H : RMSEA  0,10 

Nach Loehlin (2004, S. 69) kann diese Hypothese verworfen werden, wenn die obere Grenze das 90-

prozentigen RMSEA-Vertrauensintervalls unter dem Kriterium für akzeptable Modell (0,10) liegt. Aus 

der Wahl des 90-prozentigen Vertrauensintervalls resultiert ein gerichteter (einseitiger) Test zum Niveau 

α = 0,05. 

Im Ambitionsbeispiel erreichen das nonrekursive Modell (mit korrelierten Residuen) und das Pfadmodell 

(mit unkorrelierten Residuen) eine gute RMSEA-Beurteilung (mit einem Schätzwert unter 0,05): 

RMSEA 

Model RMSEA LO 90 HI 90 PCLOSE 

Default model ,020 ,000 ,077 ,741 

Unabhäng. Residuen ,036 ,000 ,078 ,646 

Independence model ,361 ,342 ,380 ,000 

Die Close-Fit - Nullhypothese kann jeweils beibehalten werden (p = 0,741 bzw. 0,646), und die Poor-Fit - 

Nullhypothese kann verworfen werden. 

Wie eine von Loehlin (2004, S. 264) berichtete Teststärketabelle zeigt, steigt die Wahrscheinlichkeit, bei 

einem wahren RMSEA-Populationswert von 0,05 die Poor-Fit - Nullhypothese bei einem -Niveau von 
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0,05 verwerfen zu können, mit der Anzahl der Freiheitsgrade eines Modells an. Für eine gewünschte Test-

stärke von 0,80 werden in Abhängigkeit vom df-Wert folgende Stichprobenumfänge benötigt: 

df benötigtes N 

1 2475 

5 569 

10 320 

50 99 

Weil ein großer df-Wert am ehesten in komplexen Modellen zu realisieren ist, haben diese wohl insge-

samt eine erheblich bessere Chance, den RMSEA-basierten Poor-Fit - Test zu bestehen. 

 

5.6.4 SRMR 

Der ursprünglich im Computer-Programm LISREL (siehe Jöreskog & Sörbom 1989) vorgestellte RMR-

Index (Root Mean Square Residual) gibt das mittlere betragsmäßige Kovarianz-Residuum an. Im Eingrup-

penfall ist der RMR-Index folgendermaßen definiert: 

)ˆ(
)1(

1
 := RMR

2

112
1

 ijij

i

j = 

k

i = 

 - s 
k +  k

 

In der Formel steht sij bzw. ̂ij  für das Element (i, j) der empirischen bzw. modellimplizierten Kovarianz-

matrix der k manifesten Variablen. 

Der RMR-Index ist nur dann sinnvoll interpretierbar, wenn alle manifesten Variablen dieselbe Maßeinheit 

besitzen, z.B. standardisiert sind. Im standardisierten RMR-Index (SRMR), der die beobachtete mit der 

modellimplizierten Korrelationsmatrix vergleicht, ist das Problem behoben. SRMR-Werte bis zur Grenze 

0,10 gelten als akzeptabel (Kline 2005, S. 141). 

Während Amos den RMR in der Textausgabe routinemäßig liefert, ist für den SRMR ein Plugin zustän-

dig: 

 Nach dem Menübefehl  

 Plugins > Standardized RMR 
erscheint ein leeres Fenster. 

 Läst man anschließend das Modell schätzen, wird dort der SRMR angezeigt. 

Für das in Abschnitt 4 vorgestellte CFA-Modell der Zustandsangst 

 

liefert die Textausgabe im Abschnitt Model Fit den wenig informativen RMR-Wert 0,668: 
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RMR, GFI 

Model RMR GFI AGFI PGFI 

Default model ,668 ,980 ,966 ,588 

Saturated model ,000 1,000   

Independence model 12,779 ,462 ,104 ,277 
 

Den aussagekräftigen und im Beispiel sehr günstigen SRMR-Wert von 0,02 erhält man im Plugin-Fenster: 

 

 

5.6.5 Informationskriterien zum Vergleich von nicht-geschachtelten Modellen 

Die folgenden Gütemaße 

 Akaike Information Criterion (AIC) 

 Browne-Cudeck Criterion (BCC) 

 Bayes Information Criterion (BIC) 

 Consistent AIC (CAIC) 

sind informationstheoretisch begründet und bestrafen komplexe Modelle (mit zahlreichen Parametern). 

Man verwendet sie oft zum Vergleich von nicht-geschachtelten Modellen, weil hier kein D
2
-Test (vgl. 

Abschnitt 5.5) möglich ist. 

Wir betrachten nur beim Akaike Information Criterion, welches die historische Vorreiterrolle gespielt hat, 

die hier angenehm einfache Definition: 

AIC := CMIN + 2 NPAR 

Hinsichtlich der Tendenz zur Bevorzugung sparsamer Modelle bilden die Gütemaße folgende Rangreihe: 

AIC < BCC < CAIC < BIC 

Um den Modellvergleich zu vereinfachen, wird gelegentlich vom jeweiligen Gütemaß das Minimum der 

zum Vergleich anstehenden Modelle subtrahiert, so dass beim besten Modell der Wert Null resultiert. 

Amos präsentiert die entsprechenden Varianten der Informationsmaße unter den Bezeichnungen AIC0, 

BCC0 und BIC0. 

Im Ambitionsbeispiel (siehe Abschnitt 3.7) entscheiden sich die beiden Kriterien mit der stärksten Kom-

plexitätsstrafe (BIC, CAIC) für das sparsamere Modell mit unabhängigen Residuen. Die Amos-

Textausgabe liefert im Abschnitt Model Fit die folgende Tabelle: 
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AIC 

Model AIC BCC BIC CAIC 

Default model 28,596 28,801 88,948 101,948 

Unabhäng. Residuen 29,995 30,184 85,705 97,705 

Saturated model 30,000 30,237 99,637 114,637 

Independence model 1018,354 1018,433 1041,567 1046,567 
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6 Ein nonrekursives Modell mit latenten Variablen 

6.1 Messfehler und methodologische Gegenmaßnahmen 

Bisher haben wir ein Strukturmodell für manifeste Variablen zur Beschreibung von Wirkungsbeziehun-

gen (Ambitionsbeispiel, siehe Abschnitt 3.7) und ein Messmodell zur Verankerung von latenten Variab-

len in der Beobachtungsbasis behandelt (konfirmatorische Faktorenanalyse mit zwei Faktoren der Zu-

standsangst, siehe Abschnitt 4). Im nächsten Beispiel, dessen Pfaddiagramm schon in der Einleitung zu 

sehen war, kommen die beiden Partialmodelle zusammen zu einem Strukturmodell für latente (endogene 

und exogene) Variablen samt Messmodell. Damit lassen sich die folgenden, durch messfehlerbehaftete 

manifeste Variablen bedingten Probleme zu vermeiden (siehe Arbuckle 2009a, S. 81 und S. 145): 

 Fehler in den endogenen Variablen führen zu geminderten Determinationskoeffizienten und zu 

vergrößerten Standardfehlern der Strukturkoeffizienten. 

 Fehler in den exogenen Variablen mindern die Determinationskoeffizienten und verzerren die 

Schätzungen der Strukturkoeffizienten. 

Um Effekte und Kovarianzen auf der Ebene von latenten, messfehlerfreien Variablen schätzen zu können, 

benötigt man im Allgemeinen für jede latente Variable mindestens zwei manifeste Indikatoren. Erst bei 

drei Indikatoren ist unter relativ allgemeinen Bedingungen garantiert, dass die Identifikation und erfolg-

reiche Schätzung des Modells nicht an der mangelhaften empirischen Verankerung der latenten Variablen 

scheitert (siehe Abschnitte 5.3 und 5.4.3). Grundsätzlich kann man aber auch einfach verankerte latente 

Variablen modellieren, sofern die Reliabilität des Einzelindikators bekannt ist (siehe z.B. Kline 2005, 

S.229 ff). 

Beim dem bereits in der Einleitung gezeigte Modell
1
 sind die latenten Variablen jeweils doppelt empi-

risch verankert: 

 

Zur Identifikation der Varianzen der latenten Variablen, zu denen auch die Residuen gehören, wird in die-

sem Modell der üblichen Praxis folgend jeweils eine Ladung auf Eins fixiert (Unit Loading Identification, 

ULI). Bei den exogenen latenten Variablen könnte man alternativ auch die Varianzen auf Eins fixieren (Unit 

                                                 
1
 Das Pfaddiagramm in der Einleitung enthält die standardisierten Schätzergebnisse. 
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Variance Identification, UVI). Beide Techniken sind in der Regel äquivalent, wobei aber bestimmte Kons-

tellationen von Identifikationsrestriktionen einerseits und Gleichheitsrestriktionen für Varianzen oder La-

dungen andererseits für Ausnahmen sorgen können (so genannte constraint interactions, siehe Kline 2005, 

S. 190). 

Zur empirischen Verankerung der latenten Variablen in einem Strukturgleichungsmodell werden meist 

(wie in unseren Beispielen) reflektive Indikatoren verwendet, die Effekte von latenten Variablen erhal-

ten. Gelegentlich werden so genannte formative Indikatoren diskutiert, die in umgekehrter Richtung 

Effekte auf latente Variablen ausüben und deren Bedeutung somit prägen. Ein so genanntes MIMIC-

Modell (Multiple Indicators Multiple Causes) enthält latente Variablen, die einerseits Effekte auf reflek-

tive Indikatoren ausüben und andererseits von manifesten Variablen beeinflusst werden. 

 

6.2 Ein nonrekursives Strukturmodell 

Im Unterschied zum faktorenanalytischen Beispiel aus Abschnitt 4 wird im aktuellen Beispiel das Mess-

modell mit den Beziehungen zwischen den latenten und manifesten Variablen ergänzt durch ein restrikti-

ves (empirisch gehaltvolles, falsifizierbares) Strukturmodell zu den Beziehungen zwischen den latenten 

Variablen: 

 

Aus einer künstlichen Population mit der in obigem Pfaddiagramm beschriebenen Struktur wurde mit 

einem SPSS-Programm eine Zufallsstichprobe der Größe N = 384 gezogen.
1
 Neben stetigen und normal-

verteilten Indikatoren wurden auch vergröberte (ordinale) Varianten mit ca. 25 Stufen erstellt, um die üb-

liche Messpraxis nachzuempfinden. 

Das obige Pfaddiagramm formuliert eine pädagogische „Theorie“ über Leistungsmotivation (MOTIVAT) 

und Schulerfolg (ERFOLG), die in der künstlichen Population perfekt gilt. Zur Erklärung werden folgen-

de exogene Variablen herangezogen: 

 Anspruchsniveau der Eltern (ANE) 

 genetische Ausstattung (ANLAGE) 

 Förderungspotential der Lernumgebung (UMWELT) 

Weil es sich um ein nonrekursives Model mit wechselseitiger Abhängigkeit von Leistungsmotivation und 

Erfolg handelt, sorgt das erzeugende SPSS-Programm in einer „Zeitschleife“ dafür, dass ein stabiler Zu-

                                                 
1
 Sie finden das erzeugende SPSS-Programm mc.sps und die Datendatei mc.sav mit den resultierenden Zufallsdaten an der 

im Vorwort vereinbarten Stelle. 
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stand ausagierter Effekte eingekehrt ist, bevor die „Datenerhebung“ stattfindet. Jede Erforschung eines 

dynamischen Systems durch querschnittlich erhobene Daten setzt einen Gleichgewichtszustand ausagier-

ter Effekte voraus (siehe z.B. Kline 2005, S. 239). 

Wir „forschen“ mit dem korrekten Modell, machen also keine Spezifikationsfehler. Die in obigem Pfad-

diagramm enthaltenen Fixierungen von Pfadkoeffizienten auf den Wert Eins stellen keine empirischen 

Behauptungen dar, sondern legen die Maßeinheiten der latenten Variablen fest (vgl. Abschnitt 3.4). 

 

6.3 Weitere Werkzeuge für die Erstellung von Pfaddiagrammen 

Die zur Erstellung eines Pfaddiagramms mit latenten Variablen im Amos-Grafikmodus erforderlichen 

Werkzeuge haben wir im Zusammenhang mit der Residualvariablen bereits kennen gelernt. Amos bietet 

darüber hinaus noch einige Arbeitserleichterungen, die beim Erstellen des obigen Pfaddiagramms sehr 

nützlich sind: 

 Stellen Sie über 

View > Interface Properties > Page Layout 

eine querformatige Zeichenfläche ein. 

 Zeichen Sie eine Ellipse für das latente Konstrukt ANE. 

 Wählen Sie das Messmodell-Werkzeug mit 

  oder  Diagram > Draw Indicator Variable 

 Klicken Sie dann zweimal auf die Ellipse, um zwei Indikatoren einzeichnen zu lassen: 

 

Amos hat die zur Definition der Maßeinheiten der latenten Variablen erforderlichen Parameterfixie-

rungen automatisch vorgenommen. 

 Wählen Sie mit 

  oder   Edit > Rotate 

das Rotationswerkzeug, und klicken Sie so lange auf die ANE-Ellipse, bis sich die Indikatoren auf der 

linken Seite befinden: 

 

 Gehen Sie folgendermaßen vor, wenn Teile des Pfaddiagramms außerhalb der Zeichenfläche liegen: 

o Alles markieren mit dem -Werkzeug 

o Verschieben mit dem -Werkzeug 

 Verfeinern Sie das Messmodell mit dem -Werkzeug. 
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 Ordnen Sie den fünf vorhandenen Variablen ihre Namen zu, um bei Platzproblemen frühzeitig die 

Rechtecke und Ellipsen vergrößern zu können, bevor Sie in die Serienproduktion einsteigen. Statt eine 

Form zu vergrößern kann auch die Beschriftung verkleinert werden, z.B.: 

   

Die Namen für die latenten Variablen sind frei wählbar, soweit keine Namenskonflikte auftreten. Um 

die Namen der manifesten Variablen aus einer Liste übernehmen zu können, sollten Sie spätestens jetzt 

über File > Data Files > File Name die Eingabedatei festlegen. In der Datei mc.sav finden Sie die 

Indikatoren in stetiger (z.B. ANE1S) und in „vergröberter“ Form (z.B. ANE1), wobei in diesem Manu-

skript die vergröberten Varianten eingesetzt werden. 

 Erzeugen Sie mit  für die beiden anderen exogenen latenten Variablen Kopien des (vollständig 

markierten) ANE-Messmodells. Halten Sie beim Verschieben der Kopien die  -Taste fest, so dass 

die Messmodelle ihre horizontale Position behalten. 

 Erzeugen Sie eine weitere Kopie für die erste endogene Variable, vorläufig möglichst weit vom rech-

ten Rand der Zeichnungsfläche entfernt. 

 Reflektieren Sie die Indikatoren der endogenen Variablen mit dem -Werkzeug, und bringen Sie 

das Messmodell in die gewünschte Position. 

 Erzeugen Sie mit  eine Kopie für die zweite endogene Variable. 

 Zeichnen Sie mit  je einen Fehlerterm für die endogenen latenten Variablen. 

 Tragen Sie mit  bzw.  die Effekte bzw. Kovarianzen ein. 

Beim Optimieren der Pfeile leistet der Zauberstab  gute Dienste. 

 Sorgen Sie für korrekte Variablennamen. 

Nun sollte Ihr Pfaddiagramm dem oben wiedergegebenen Vorschlag ähneln. 
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6.4 Methodenstudie zum Nutzen von latenten Variablen 

Lassen Sie Amos nun die Berechnungen zum fertig spezifizierten Modell ausführen. Es resultieren die 

folgenden (unstandardisierten) ML-Schätzergebnisse: 

 

Wie es bei der Überprüfung eines korrekten Modells zu erwarten ist, kommt der 
2
-Gültigkeitstest zu 

einem günstigen Ergebnis (p-Level = 0,64): 

Notes for Model (Default model) 

Computation of degrees of freedom (Default model) 

Number of distinct sample moments: 55 

Number of distinct parameters to be estimated: 29 

Degrees of freedom (55 - 29): 26 

Result (Default model) 

Minimum was achieved  

Chi-square = 22,867  

Degrees of freedom = 26  

Probability level = ,640 

Auch die RMSEA-Ergebnisse sind ideal, was bei einem realen Modell kaum jemals passieren wird: 

Model RMSEA LO 90 HI 90 PCLOSE 

Default model ,000 ,000 ,034 ,997 

Independence model ,343 ,331 ,356 ,000 

Bei einem nonrekursiven Modell interessiert auch der Stabilitätsindex, der betragsmäßig kleiner als Eins 

sein muss und sich in unserem Beispiel als Produkt der beiden reziproken (unstandardisierten) Pfadkoef-

fizienten ergibt: 
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Notes for Group/Model (Group number 1 - Default model) 

Stability index for the following variables is ,200 

           ERFOLG 

           MOTIVAT 

Wie ein Vergleich mit dem datengenerierenden SPSS-Programm zeigt, entsprechen die geschätzten Mo-

dellparameter recht gut den wahren Populationswerten. Dies gilt auch für die Reliabilitäten, die im Pfad-

diagramm mit den standardisierten Schätzergebnissen (siehe Einleitung) über den Indikatoren eingetra-

gen sind. 

Zu Vergleichszwecken sollen auch die Ergebnisse einer rein manifesten Forschungsmethodologie betrach-

tet werden. Verwendet man an Stelle der latenten Variablen jeweils den ersten Indikator, ergibt sich das 

folgende Ausgabe-Pfaddiagramm mit unstandardisierten Schätzergebnissen: 

 

Wir erhalten zwar ein vergleichbares Ergebnismuster, doch sind viele Schätzungen deutlich verzerrt. 

Es ist allerdings unfair, Schätzungen auf der Basis von jeweils zwei Indikatoren pro Konstrukt mit Schät-

zungen auf der Basis der „halben“ Information zu vergleichen. Verwendet man an Stelle des ersten Indi-

kators jeweils die Summe aus beiden Indikatoren, resultieren folgende Ergebnisse: 

 

Durch die Testverlängerung und die damit verbundene Reliabilitätssteigerung gewinnt die manifeste 

Schätzmethodologie erheblich an Präzision, bleibt aber der latenten Methodologie unterlegen, wie die 

folgende Tabelle (mit unstandardisierten Schätzergebnissen) zeigt: 
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Parameter 
Wahrer 

Wert 

Schätzer für 

latente Variablen 

Schätzer für mani-

feste Variablen 

(Summe der Ind.) 

Schätzer für mani-

feste Variablen 

(erster Indikator) 

MOTIVAT  ANE 0,3 0,37 0,24 0,17 

MOTIVAT  ERFOLG 0,4 0,42 0,48 0,54 

ERFOLG  ANLAGE 0,3 0,25 0,21 0,19 

ERFOLG  UMWELT 0,4 0,48 0,30 0,22 

ERFOLG  MOTIVAT 0,5 0,47 0,66 0,83 

Vermutlich resultiert die Überlegenheit der latenten Methodologie aus der Möglichkeit, die unterschiedli-

chen Reliabilitäten der Indikatoren zu berücksichtigen. 

Bei den Vergleichen ist zu beachten, dass sie auf Ergebnissen einer einzigen Zufallsstichprobe basieren. 

Zum Abschluss noch ein Hinweis zur Gestaltung der Pfaddiagramme: Wenn sich die von Amos eingetra-

genen Parameterschätzer zu nahe kommen, können Sie mit dem -Werkzeug deren Positionen verän-

dern (bei aktivem Modellspezifikations-Pfaddiagramm). 
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7 Explorative Techniken 

Trotz aller Argumente für eine primär konfirmatorische (hypothesenprüfende) Forschungsstrategie ist es 

legitim, aus der Empirie zu lernen, d.h. Daten explorativ (hypothesenbildend) zu analysieren. Beim Arbeiten 

mit Amos konfrontiert man ein Modell mit einer empirischen Kovarianzmatrix und erhält dabei eine Fülle 

diagnostischer Informationen, darunter u.a. auch Hinweise zu möglichen Ansatzpunkten für eine Verbesse-

rung des Modells. Vor einer Diskussion von Techniken zur Verbesserung der Fit-Beurteilung muss jedoch 

nachdrücklich daran erinnert werden, dass ein mit Hilfe diagnostischer Informationen aus einer bestimmten 

Stichprobe optimiertes Modell nur an einer unabhängigen Stichprobe geprüft werden kann! 

Als Strategie zur Überprüfung bzw. Modifikation eines Strukturgleichungsmodells empfiehlt Kline (2005, 

S. 216), zunächst das Messmodell (mit freien Beziehungen zwischen den latenten Variablen) zu analysie-

ren. Hinter diesem Vorschlag steckt die Idee, Messung (Begriffsbildung) und Theorienbildung voneinan-

der zu trennen, was wohl nicht regelmäßig gelingen kann und daher nicht unbedingt versucht werden soll-

te. 

Beim Strukturmodell ist auch die begriffliche Eigenständigkeit der latenten Variablen zu beurteilen, wo-

bei z.B. eine Korrelation von ca. 0,9 zwischen zwei latenten Variablen auf eine mangelhafte divergente 

Validität hindeutet (Kline 2005, S. 224). 

Eine Verbesserung der Fit-Beurteilung kann auf zwei Wegen erreicht werden: 

 Aufhebung von Parameterfixierungen - bzw. Restriktionen 

Die in Abschnitt 7.1 behandelten Modifikationsindikatoren geben Hinweise dazu, welche Parame-

terfixierungen - bzw. Restriktionen besonders stark zum Fehlermaß des 
2
-Gültigkeitstest beitra-

gen. 

 Fixieren bzw. Restringieren von bislang freien Parametern 

Während durch eine solche Maßnahme die χ
2
-Statistik (hoffentlich nur wenig) ansteigt, wird je-

weils ein Freiheitsgrad gewonnen, so dass diverse Gütekriterien (z.B. RMSEA, Überschreitungs-

wahrscheinlichkeit des χ
2
-Tests) profitieren können. 

Bei der Modifikation eines Modells sollte man keinesfalls blind empirischen Indizes folgen (und z.B. Zu-

fälligkeiten der Stichprobe kapitalisieren), sondern unbedingt auf die theoretische Begründung achten. 

Kline (2005, S. 149) berichtet von Methodenstudien, die bei datenbasierten Verbesserungsvorschlägen 

kaum Fortschritte in Richtung auf das korrekte Modell fanden, und resümiert treffend: 

Learn from your data, but your data should not be your teacher. 

 

7.1 Modifikationsindikatoren 

In den bisherigen Beispielen haben alle Modelle so gut gepasst, dass wir uns nicht für Hilfsmittel zur Di-

agnose von Spezifikationsfehlern interessieren mussten. Im aktuellen Abschnitt beschäftigen wir uns da-

mit, wie lokale Modellschwächen mit Hilfe der so genannten Modifikationsindikatoren aufgespürt werden 

können. Diese Statistiken geben für einen fixierten oder restringierten Parameter an, welche Reduktion der 


2
-Statistik zum Modellgültigkeitstest zu erwarten ist, wenn der Parameter freigesetzt und anschließend das 

(erweiterte) Modell neu geschätzt wird. 

Da ein Modifikationsindikator annähernd der Differenz der 
2
-Prüfgrößen zu den Modellen mit und ohne 

die fragliche Fixierung bzw. Gleichheitsrestriktion entspricht, und weil beim Aufheben der Fixierung 

bzw. Restriktion gerade ein Freiheitsgrad verloren geht, liegt unter Annahme der Gültigkeit des liberali-

sierten Modells ein Spezialfall für den in Abschnitt 5.5 vorgestellten D
2
-Test mit df = 1 vor. 
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Daher kann ein Modifikationsindikator bei Verwendung der ML-, GLS- oder ADF-Schätzmethode an-

hand der 
2
-Verteilung mit einem Freiheitsgrad beurteilt werden. Je nach bevorzugter Regel wird man 

Werte größer 4 ( 95% - Quantil) oder 7 ( 99% - Quantil) als Kritik der Empirie an der zugrunde liegen-

den Fixierung oder Restriktion interpretieren. Amos schätzt außerdem für jeden fixierten bzw. restringier-

ten Parameter seine erwartete Veränderung bei Freisetzung (Bezeichnung im Ergebnisprotokoll: Par 

Change). 

Es ist praktisch, dass Amos auf Anorderung Modifikationsindikatoren zu allen fixierten bzw. restringier-

ten Parametern liefert, was die explizite Spezifikation von entsprechend vielen Vergleichsmodellen er-

spart. 

Zur Demonstration der Modifikationsindikatoren greifen wir das in Abschnitt 4 vorgestellte faktorenana-

lytische Modell zur Zustandsangst auf, obwohl es den 
2
-Modellgültigkeits gut bestanden hat (p = 0,274). 

Allerdings lassen die zahlreichen Restriktionen des Modells lokale Anpassungsschwächen erwarten, die 

eventuell im globalen Test nicht zum Ausdruck kommen. Im Sinn des wissenschaftstheoretischen Spar-

samkeitsgebots sollte man im konkreten Fall (beim relativ simplen Modell der Zustandsangst) wohl auf 

eine Fit-Optimierung verzichten. Bei einem komplexeren Modell geht aber eventuell ein gutes Ergebnis 

im globalen Modellgültigkeitstest auf exzellente Anpassung in nebensächlichen Modellregionen zurück, 

so dass man trotzdem auf Anpassungsschwächen an essentiellen Stellen achten sollte. 

Wir verlangen nach 

View > Analysis Properties > Output 

die Ausgabe von Modifikationsindikatoren: 

 

Amos protokolliert nur Modifikationsindikatoren oberhalb der im Feld Threshold for modification 

indices angegebenen kritischen Grenze. Wir entscheiden uns für „Tests“ auf dem 5%-Niveau (siehe 

oben). 

Leider kann Amos die Modifikationsindikatoren nicht berechnen, wenn wegen fehlender Werte die 

FIML-Schätzmethode (Full Information Maximum Likelihood) zum Einsatz kommt. 
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Wir fordern Amos über den Schalter  zur Berechnung der Schätzungen an und erhalten in der Text-

ausgabe tatsächlich Hinweise auf lokale Schwächen des Modells durch Modifikationsindikatoren ober-

halb der (bei α = 0,05) kritischen Grenze von 4: 

Modification Indices (Group number 1 - Default model) 

Covariances: (Group number 1 - Default model) 

   M.I. Par Change 

Delta2 <--> Delta4 4,527 ,849 

Regression Weights: (Group number 1 - Default model) 

   M.I. Par Change 

X3 <--- X2 4,600 -,075 

X4 <--- X2 4,925 ,077 
 

Die Wahl der zuerst zu beseitigenden Restriktion sollte sich nicht strikt an der Modifikationsindikatoren-

Rangreihe orientieren, sondern theoretisch begründbar sein. Im Beispiel ist der Modifikationsindex für die 

Kovarianz von 2 und 4 (im Modell auf Null fixiert) mit einem Wert von 4,53 signifikant und stellt eine 

durchaus nachvollziehbare Kritik an unserem Modell dar: Die beiden Messungen des zweiten Indikators 

haben vermutlich über den Einfluss der latenten Variablen hinaus eine gemeinsame Wurzel. 

Durch Freisetzen der Kovarianz von 2 und 4 reduziert sich die 
2
-Statistik zum Modellgültigkeitstest 

um 4,59 (etwas stärker als vom Modifikationsindikator prognostiziert) von 7,53 auf 2,94: 
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Für 2 und 4 wird eine nicht unerhebliche Korrelation von 0,3 geschätzt. Dass die bereits zuvor sehr 

günstige Beurteilung im 
2
-Modellgültigkeitstest (p = 0,274) noch zugelegt hat (p = 0,709), ist nicht un-

bedingt entscheidungsrelevant. Beim RMSEA-Ergebnis zeigt sich jedoch eine argumentativ verwertbare 

Verbesserung, weil die Nullhypothese eines schlechten Fits (RMSEA  0,10, siehe Abschnitt 5.6.3) vor 

der Modifikation nicht zurückgewiesen werden konnte (HO 90 = 0,11 > 0,10): 

RMSEA 

Model RMSEA LO 90 HI 90 PCLOSE 

Default model ,038 ,000 ,110 ,528 

Independence model ,754 ,704 ,805 ,000 
 

Nach der Modifikation liegt die obere Grenze des Vertrauensintervalls sogar unter 0,08, der etwas stren-

geren Grenze für akzeptable Modelle: 

RMSEA 

Model RMSEA LO 90 HI 90 PCLOSE 

Default model ,000 ,000 ,078 ,857 

Independence model ,754 ,704 ,805 ,000 
 

In der Textausgabe zum erweiterten Modell finden sich keine signifikanten Modifikationsindikatoren 

mehr.  

 

7.2 Spezifikationssuche 

Amos kann einen durch optionale Parameter aufgespannten Raum von potentiellen Modellen nach einer 

„optimalen Lösung“ durchsuchen. Bei dieser Spezifikationssuche werden alle potentiellen Modelle ge-

schätzt und nach diversen Kriterien beurteilt. 

Wir greifen auf die in Abschnitt 6 beschriebenen Simulationsdaten und das dort vorgestellte Pfaddia-

gramm zurück und starten mit  

   oder   Analyze > Specification Search 

das folgende Fenster: 

 

Bei eingerastetem  - Schalter deklarieren wir im Pfaddiagramm per Mauklick drei Parameter als optio-

nal (erkennbar an einer alternativen Linienfarbe): 
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Bei eingerastetem  - Schalter kann man einen Parameter per Mausklick wieder in den Normalzustand 

zurückversetzen. 

Die optionalen Parameter legen fest, welche Modelle bei der Spezifikationssuche zu berücksichtigen sind, 

wobei jeder einzelne optionale Parameter einen Faktor mit den folgenden Zuständen beisteuert: 

 Parameter ist auf Null fixiert 

 Parameter ist frei schätzbar 

Gemeinsam ergeben k optionale Parameter also 2
k
 Kombinationen bzw. Kandidatenmodelle, so dass im 

Beispiel acht Modelle zur Konkurrenz zugelassen sind. 

Mit einem Mausklick auf den Schalter  der Spezifikations-Symbolleiste lässt man alle Modelle schät-

zen: 

 

Anschließend erscheinen im Fenster der Spezifikationssuche die Ergebnisse aller Modelle, z.B.: 
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In den vergleichsrelevanten Spalten ist der Wert des günstigsten Modells unterstrichen. 

Bei Verwendung mehrerer Kriterien ist kaum damit zu rechnen, dass ein Modell alle Kriterien für sich 

entscheidet. Im Beispiel kommen zwei Modelle in die engere Wahl: 

 Modell 8 

Dies ist das wahre Modell der Simulationsstudie (siehe Abschnitt 6). Es entscheidet die CMIN – 

abhängigen Disziplinen für sich. 

 Modell 5 

Modell 5 gewinnt die informationstheoretischen Disziplinen. Hier ist im Vergleich zum Modell 8 

die Kovarianz der Residuen zu den endogenen Variablen auf Null fixiert. 

Per Doppelklick auf seine Zeile im Spezifikationsfenster erhält man zu einem Modell sein Pfaddiagramm, 

z.B. bei Modell 5: 

 

Über den Schalter  des Spezifikationsfensters ist eine Dialogbox zugänglich, die zahlreiche grafische 

Hilfen zur Modellauswahl bietet. Im Scatter-Plot 
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sind die (CMIN, NPAR) – Wertepaare aller Modelle zu sehen, wobei man per Mausklick auf einen Punkt 

die Nummer und den CMIN-Wert des zugehörigen Modells erhält. Eine verschiebbare Gerade kenn-

zeichnet für ein Fit measure alle Modell mit konstantem Wert für dieses Kriterium. So zeigt sich in 

unserem Beispiel, dass die Modelle 5 und 8 praktisch denselben BCC-Wert besitzen. 

In folgendem Best fit - Plot ist der beste CMIN/DF – Wert für ein Modell mit 26, 27, 28 oder 29 Para-

metern zu sehen: 

 

Offenbar empfiehlt es sich nicht, weniger als 27 Parameter zu verwenden. 

Der folgende Scree-Plot dokumentiert für das beste Modell mit 27 Parametern eine deutliche Überlegen-

heit beim CMIN/DF – Kriterium gegenüber dem besten Modell mit 26 Parametern (Reduktion um 

3,643), während bei einer weiteren Steigerung der Parameterzahl nur noch geringfügige Verbesserungen 

erreicht werden (0,301 bzw. 0,011): 
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Mit dem Schalter  erreicht man einen Optionsdialog: 

 

Hier kann man z.B. über das Kontrollkästchen Keep on top festlegen, ob das Fenster der Spezifikati-

onssuche ständig im Vordergrund bleiben soll. 
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8 Die simultane Analyse mehrerer Gruppen 

Arbuckle (2009a, S. 159) nennt zwei wesentliche Vorteile der simultanen Analyse mehrerer Gruppen im 

Vergleich zu Einzelanalysen pro Gruppe: 

 Es können Signifikanztests zu Gruppenunterschieden hinsichtlich diverser Verteilungseigenschaften 

durchgeführt werden (z.B. Vergleich von Kovarianzmatrizen, Ladungsmustern, Pfadkoeffizienten, 

Erwartungswerten). Dies ermöglicht insbesondere die Überprüfung von Interaktionshypothesen, al-

lerdings mit der Einschränkung auf kategoriale Moderatoren (siehe Baltes-Götz 2008b). Man kann 

z.B. untersuchen, ob die Gruppenzugehörigkeit den Effekt einer latenten exogenen Variablen auf 

eine latente endogene Variable moderiert. 

 Sind die Gruppen hinsichtlich wesentlicher Verteilungseigenschaften äquivalent, erlaubt die simul-

tane Analyse präzisere Parameterschätzungen. 

Im Demonstrationsbeispiel greifen wir wieder auf die Daten aus Attig (1983) zurück (vgl. Abschnitt 2), 

betrachten aber neben den jungen Probanden eine zusätzliche Stichprobe mit alten Teilnehmern. Dabei 

interessieren wir uns nur für die einfache und die unterstützte Erinnerungsleistung vor dem Gedächtnis-

training (Variablen: RECALL1, CUED1). 

Bei der Datenorganisation unterstützt Amos zwei Optionen: 

 Die Daten jeder Gruppe befinden sich in einer eigenen Datei. In unserem Beispiel stehen die 

SPSS-Datendateien Attg_yng.sav und Attg_old.sav zur Verfügung, die sich im Examples-

Unterverzeichnis zum Amos – Programmordner befinden. 

 Eine einzelne Datei enthält die Daten aller Gruppen, und eine Variable definiert die Gruppenzuge-

hörigkeit. Um diese Datenorganisation demonstrieren zu können, wurde die Datei Attg.sav mit 

den Daten beider Gruppen erstellt.
1
 Die Variable GROUP hat folgende Werte: 

o 1 für die jungen Probanden 

o 2 für die alten Probanden 

Weiterhin gelten folgende Regeln: 

 Per Voreinstellung sind die Pfaddiagramme der einzelnen Gruppen identisch. Wenn es dabei bleibt, 

muss also nur ein Pfaddiagramm gezeichnet werden. 

 Für unbenannte Parameter schätzt Amos in jeder Gruppe einen eigenen Wert. 

Die beiden ersten Regeln kann man also so zusammenfassen: Per Voreinstellung besitzen die Grup-

pen eine identische Modellstruktur, aber individuelle Parameterwerte. 

 Parameter aus verschiedenen Gruppen können durch identische Benennung gleich gesetzt werden. 

Derartige Restriktionen erlauben sehr flexible Hypothesenprüfungen. 

Öffnen Sie in einem neuen Amos-Projekt über File > Data Files > File Name die Datei Attg.sav: 

                                                 
1
 Sie finden die Datei an der im Vorwort vereinbarten Stelle. 
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Wählen Sie nach einem Klick auf den Schalter Grouping Variable die Gruppierungsvariable GROUP: 

 

Klicken Sie im Dialog Data Files auf den Schalter Group Value, um die Gruppe der jungen Probanden 

(Wert 1) auszuwählen: 
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Quittieren Sie den Dialog Data Files: 

 

Erstellen Sie das folgende Pfaddiagramm: 

 

In der Diagrammbeschriftung (zu erstellen mit dem -Werkzeug
 

) sorgt das Testmakro \group dafür, 

dass die aktuell dargestellte Gruppe stets erkennbar ist: 

 

Nun wollen wir noch eine zweite Gruppe in die Analyse aufnehmen und außerdem für beide Gruppen 

eine informative Bezeichnung vereinbaren. Dazu starten wir den Gruppenmanager mit 

Analyze > Manage Groups 

Alternativ kann der Gruppenmanager auch per Doppelklick auf einen Eintrag im Gruppenauswahlbereich 

des Amos-Fensters gestartet werden: 
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Zunächst ersetzen wir die automatisch vergebene Gruppenbezeichnung Group number 1 durch Junge 

Probenden: 

 

Dann legen wir mit New eine weitere Gruppe an und benennen diese gleich passend. 

Schließlich muss über File > Data Files noch die Datenquelle zur zweiten, im Gruppenfenster aktuell 

markierten Gruppe vereinbart werden: 

 

Nach Wahl der Datei Attg.sav entscheidet sich Amos spontan für die Fälle mit dem GROUP-Wert 2: 

 

Nach unseren bisherigen Modellspezifikationen hat Amos in jeder Gruppe zwei Varianzen und eine 

Kovarianz zu schätzen. Es sind keine Restriktion und damit auch keine Freiheitsgrade für einen Modell-

test vorhanden, wie die Textausgabe bestätigt: 
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Computation of degrees of freedom (Default model) 

Number of distinct sample moments: 6 

Number of distinct parameters to be estimated: 6 

Degrees of freedom (6 - 6): 0 
 

Result (Default model) 

Minimum was achieved  

Chi-square = ,000  

Degrees of freedom = 0  

Probability level cannot be computed 

Die Schätzergebnisse für die jungen Probanden: 

Scalar Estimates (Junge Probanden - Default model) 

Maximum Likelihood Estimates 

Covariances: (Junge Probanden - Default model) 

   Estimate S.E. C.R. P Label 

RECALL1 <--> CUED1 3,225 ,944 3,416 ***  

Variances: (Junge Probanden - Default model) 

   Estimate S.E. C.R. P Label 

RECALL1   5,788 1,311 4,416 ***  

CUED1   4,210 ,953 4,416 ***  
 

Mit dem folgenden Werkzeug der Textausgabe 

 

kann man zu den Schätzergebnissen für die alten Probanden wechseln: 

Scalar Estimates (Alte Probanden - Default model) 

Maximum Likelihood Estimates 

Covariances: (Alte Probanden - Default model) 

   Estimate S.E. C.R. P Label 

RECALL1 <--> CUED1 4,887 1,252 3,902 ***  

Variances: (Alte Probanden - Default model) 

   Estimate S.E. C.R. P Label 

RECALL1   5,569 1,261 4,416 ***  

CUED1   6,694 1,516 4,416 ***  
 

Das Ausgabe-Pfaddiagramm zeigt jeweils die Schätzergebnisse der im Gruppenauswahlbereich des A-

mos-Fensters markierten Gruppe, z.B.: 
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Nun soll die Hypothese identischer Kovarianzmatrizen in beiden Gruppen geprüft werden. Dazu geben 

wir korrespondierenden Parametern in beiden Gruppen identische Namen: 

 

Auch bei offener Object Properties – Dialogbox sind Gruppenwechsel per Mausklick auf die Einträge 

im Gruppenauswahlbereich möglich. Soll für einen Parameter in allen Gruppen derselbe Wert oder Name 

festgelegt werden, kann man sich mit dem Kontrollkästchen All groups einigen Aufwand sparen: 

 

Der 
2
-Modelltest hat keine Einwände gegen die Gleichheitsrestriktionen, also gegen die Nullhypothese 

homogener Varianz-Kovarianzmatrizen: 
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Notes for Model (Default model) 

Computation of degrees of freedom (Default model) 

Number of distinct sample moments: 6 

Number of distinct parameters to be estimated: 3 

Degrees of freedom (6 - 3): 3 
 

Result (Default model) 

Minimum was achieved  

Chi-square = 4,588  

Degrees of freedom = 3  

Probability level = ,205 

Neben den Schätzern sind nun auch die Standardfehler in beiden Gruppen gleich und dabei kleiner als im 

unrestringierten Modell: 

Scalar Estimates (Junge Probanden - Default model) 

Maximum Likelihood Estimates 

Covariances: (Junge Probanden - Default model) 

   Estimate S.E. C.R. P Label 

RECALL1 <--> CUED1 4,056 ,780 5,202 *** cov_rc1 

Variances: (Junge Probanden - Default model) 

   Estimate S.E. C.R. P Label 

RECALL1   5,678 ,909 6,245 *** var_rec1 

CUED1   5,452 ,873 6,245 *** var_cue1 
 

Der eingangs erwähnte Präzisionsgewinn bei der simultanen Analyse mehrerer Gruppen stellt sich also 

genau dann ein, wenn durch Gleichheitsrestriktionen gemeinsame Parameterschätzungen möglich werden. 
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9 Bootstrapping 

In der amerikanischen Variante der Münchhausen-Geschichte schafft es der Held, sich an den eigenen 

Stiefelriemen aus dem Sumpf zu ziehen, und dieses Verfahren liefert den Namen für eine prominente sta-

tistische Schätz- und Testmethodologie, die erstmals von Efron (1982) ausformuliert worden ist. 

 

9.1 Prinzip und Nutzen 

Man behandelt die Stichprobe als Population, ermittelt durch Ziehen mit Zurücklegen zahlreiche Sekun-

därstichproben (meist 500 – 1000) mit derselben Größe wie die Original- bzw. Primärstichprobe, wobei in 

der Regel etliche Fälle mehrfach in einer Sekundärstichprobe vertreten sind. Aus jeder Sekundärstichpro-

be wird mit den üblichen Methoden (z.B. ML) ein Schätzer für den interessierenden Parameter gewonnen, 

so dass man eine empirische Stichprobenkennwerteverteilung erhält. Diese ersetzt die theoretische Stich-

probenkennwerteverteilung, die auf der Normalverteilungsannahme (vgl. Abschnitt 2.7.2) und Asympto-

tik basiert. Aus der empirischen Stichprobenkennwerteverteilung lassen sich Vertrauensintervalle und 

Testentscheidungen konstruieren, die nicht von der Normalverteilungsannahme abhängen. 

Lange war die benötigte Rechenleistung ein Hindernis für die Weiterentwicklung und Anwendung der 

Bootstrap-Technologie, doch mittlerweile suchen die CPU-Hersteller nach relevanten Anwendungen für 

ihre Gigahertz- und Multicore-Boliden. 

In folgenden Situationen ist die verteilungsvoraussetzungsfreie und sehr generell einsetzbare Ermittlung 

von Vertrauensintervallen zu Parameterschätzungen durch Bootstrap-Methoden von Interesse: 

 Bei grob verletzter Normalverteilungsannahme sind die daraus abgeleiteten Standardfehler in der 

Regel zu klein und die zugehörigen Tests zu liberal. Mit Hilfe der Bootstrap-Technik gelangt man 

in vielen Fällen zu realistischeren Standardfehlern und vermeidet überhöhte -Fehlerraten. 

 Für manche Statistiken (z.B. Determinationskoeffizienten, spezielle Modellgültigkeitskriterien, 

indirekte Effekte) lassen sich aus der Normalverteilungsannahme keine Standardfehler herleiten. 

Damit eine Stichprobe als Pseudo-Population taugt, muss sie repräsentativ und hinreichend groß sein. 

Leider sind präzise Angaben zur erforderlichen Minimalgröße kaum zu finden. In einer von Kline (2005, 

S. 197) berichteten Studie wurden Bootstrap-Schätzer mit konventionellen ML-Schätzern bei einer kon-

firmatorischen Faktorenanalyse bei verletzter Normalitätsannahme verglichen. Während die Bootstrap-

Methode bei Stichprobengrößen mit N  200 generell geringere Schätzfehler lieferte als die ML-Methode, 

waren die Ergebnisse bei N = 100 weniger überzeugend: relativ große Standardfehler, viele indefinite 

(nicht analysierbare) Kovarianzmatrizen. 

Bei sehr großen Stichproben (N > 1000) kann man darauf setzen, dass sich Verletzungen der Normalver-

teilungsannahme nur geringfügig auf die letztlich relevanten Stichprobenkennwerteverteilungen auswir-

ken (zentraler Grenzwertsatz). Hier sind Bootstrap-Methoden also wenig relevant als Remedium für eine 

verletzte Normalverteilungsannahme. Die Konstruktion von empirischen Prüfverteilungen für komplexe 

Statistiken sollte aber in dieser Situation besonders gut gelingen. 

Die Standardabweichung der Parameterschätzungen aus den Sekundärstichproben liefert den Bootstrap-

Standardfehler. Über das 2,5- und das 97,5 - Perzentil erhält man ein 95% - Bootstrap-Vertrauens-

intervall. Allerdings hat Efron (1987) eine verbesserte Variante vorgeschlagen, die Amos als bias-

corrected bootstrap confidence interval anbietet. 
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9.2 Einsatz bei verletzter Normalitätsannahme 

Als Beispiel betrachten wir eine künstliche Population mit der folgenden faktoriellen Struktur von mani-

festen Variablen M1, …, M6:
1
 

 

und den Ladungen: 

Indikator 
Faktor 

F1 F2 

M1 1 0 

M2 0,5 0 

M3 0 0 

M4 0 1 

M5 0 0,5 

M6 0 0 

Wie die beiden latenten Variablen sind auch alle manifesten Variablen (positiv) schief verteilt, z.B.: 

                                                 
1
 Sie finden das erzeugende SPSS-Programm mcb.sps und die Datendatei mcb.sav mit den resultierenden Zufallsdaten an der 

in Abschnitt Fehler! Verweisquelle konnte nicht gefunden werden. vereinbarten Stelle. 
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Die ML-Schätzergebnisse aus einer Stichprobe mit 200 Fällen zeigen trotz verletzter Normalitätsannahme 

einen guten Fit (vgl. Abschnitt 9.4): 

Result (Default model) 

Minimum was achieved  

Chi-square = 9,743  

Degrees of freedom = 8  

Probability level = ,284 

Allerdings wird die Ladung von M6 auf dem Faktor F2 irrtümlich als signifikant beurteilt: 

Regression Weights: (Group number 1 - Default model) 

   Estimate S.E. C.R. P Label 

m1 <--- F1 1,000     

m2 <--- F1 ,419 ,105 3,979 ***  

m3 <--- F1 -,066 ,058 -1,137 ,255  

m4 <--- F2 1,000     

m5 <--- F2 ,635 ,150 4,240 ***  

m6 <--- F2 ,220 ,096 2,299 ,021  
 

Wir fordern Amos nach 

View > Analysis Properties > Bootstrap 

auf, 1000 Bootstrap-Sekundärstichproben zu ziehen und die korrigierten Vertrauensintervalle nach Efron 

(1987) zu berechnen: 
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In der Textausgabe fällt der Bootstrap-Standardfehler für die Ladung von M6 auf dem Faktor F2 erheb-

lich größer aus (0,217) als der ML-Standardfehler (0,10): 

 

Vom Bootstrap-Sinifikanztest wird die korrekte Nullhypothese zum betroffenen Parameter beibehalten: 
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Im konstruierten Beispiel zeigen die von Amos berechneten Normalitätskriterien ein bedenkliches Bild: 

Assessment of normality (Group number 1) 

Variable min max skew c.r. kurtosis c.r. 

m6 -1,000 13,172 3,632 20,970 19,658 56,748 

m5 -1,978 5,550 1,152 6,653 1,173 3,387 

m4 -2,969 9,202 ,898 5,186 ,544 1,571 

m3 -1,000 10,016 2,948 17,022 12,817 36,999 

m2 -1,897 4,905 1,097 6,334 ,758 2,187 

m1 -2,935 12,464 1,586 9,155 3,299 9,522 

Multivariate      48,778 35,203 
 

Die im Abschnitt 2.7.3 angegebenen Grenzwerte für univariate Verteilungen (Betrag 3 für die Schiefe und 

Betrag 7 für die Wölbung) sind bei mehreren Variablen überschritten, und auch der multivariate Wöl-

bungstest lehnt seine Nullhypothese ab.  

Bei allen Bootstrap-Methoden und anderen Techniken mit Zufallsbeteiligung hängen die Ergebnisse auch 

vom Startwert des Pseudozufallszahlengenerators ab, den man auf den Registerkarte Random # der Dia-

logbox Analysis Properties wählen kann: 
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9.3 Bootstrap-Signifikanztests für indirekte Effekte 

Wo die Maximum Likelihood - Theorie bei der Ableitung von Prüfverteilungen an ihre Grenzen stößt, 

kann die Bootstrap-Technik gelegentlich aushelfen. Zur Demonstration greifen wir das nonrekursive Mo-

dell mit latenten Variablen aus Abschnitt 6 auf und betrachten den indirekten Effekt der latenten Variab-

len ANE (Anspruchsniveau der Eltern) auf die Variable ERFOLG (vermittelt durch die Variable MO-

TIVAT). Ohne Bootstrap-Technik liefert Amos keine Signifikanzbeurteilung. Mit den folgenden, schon 

oben verwendeten Einstellungen im Dialog Analysis Properties 

 

liefert Amos in der Textausgabe Bootstrap-Signifikanztests: 

 

Der per Mausklick auf die per Bootstrap ermittelte Überschreitungswahrscheinlichkeit (p = 0,034) ange-

forderte Infotext enthält klärende Erläuterungen und einen kleinen Fehler („0,001 level“). 

 

9.4 Modellgültigkeitstest nach Bollen & Stine 

Bei verletzter Normalverteilungsannahme sind nicht nur die Standardfehler zu den Parameterschätzungen 

betroffen, so dass Nullhypothesen zu den Parametern zu oft abgelehnt werden. Ein analoges Problem tritt 

auch beim Modellgültigkeitstest auf, so dass gültige Modell einer Wahrscheinlichkeit größer als 0,05 

verworfen werden, weil die χ
2
-Prüfgröße tendenziell zu groß ausfällt (Kline 2005, S. 157). Als Korrektiv 

haben Bollen & Stine (1993) einen Bootstrap-basierten Modelltest entwickelt, den Amos in der Dialog-

box Analysis Properties auf der Bootstrap-Registerkarte anbietet: 
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Unser Modell hatte schon den unkorrigierten Gültigkeitstest überstanden (p = 0,28) und schneidet jetzt 

noch besser ab: 

Bollen-Stine Bootstrap (Default model) 

The model fit better in 588 bootstrap samples.  

It fit about equally well in 0 bootstrap samples.  

It fit worse or failed to fit in 412 bootstrap samples.  

Testing the null hypothesis that the model is correct, Bollen-Stine bootstrap p = ,413 

Auch der korrigierte Test von Bollen & Stine (1993) tendiert dazu, in großen Stichproben Modelle „mit 

minimalen Fehlern“ zu verwerfen, so dass wir auf alternative Beurteilungsmethoden angewiesen bleiben. 

Ist der Bollen-Stine Bootstrap-Modellgültigkeitstest gewählt, gibt Amos die oben beschriebenen Boot-

strap-Konfidenzintervalle und -Tests nicht aus. 

 

9.5 Parametrisches Bootstrapping 

Das bisher in Abschnitt 9 beschriebene Bootstrapping nennt man auch nonparametrisch, weil keine Nor-

malverteilungsannahme im Spiel ist. Bei seiner Anwendung werden Rohdaten benötigt. Das so genannte 

parametrische Bootstrapping ist auch mit Momentenmatrizen (z.B. Kovarianzmatrizen) durchführbar. 

Um aus Momentenmatrizen eine Sekundärstichprobe zu erzeugen, muss allerdings ein Verteilungsmodell 

unterstellt werden. Man verwendet man die Momente der Primärstichprobe meist dazu, die Parameter 

einer Normalverteilung festzulegen, und zieht die Sekundärstichproben aus der so definierten Population. 

Damit eignet sich das parametrische Bootstrapping nicht bei fraglicher Normalitätsvoraussetzung. Es 

kann aber dazu verwendet werden, empirische Prüfverteilungen für komplexe Statistiken zu konstruieren. 

Die im Vergleich zum nonparametrischen Bootstrapping stärkeren Voraussetzungen sollten, sofern sie 

berechtigt sind, mit einer höheren Präzision (z.B. einer besseren Teststärke) belohnt werden. 

Amos bietet das (fraglos als Monte Carlo - Technik zu beschreibende) parametrische Bootstrapping in der 

Dialogbox Analysis Properties auf der Bootstrap-Registerkarte an: 
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